You can find the most up-to-date technical documentation on the VMware website at: https://docs.vmware.com/

If you have comments about this documentation, submit your feedback to docfeedback@vmware.com
Contents

Horizon 7 Installation  6

1 System Requirements for Server Components   7
   Horizon Connection Server Requirements   7
   Horizon Administrator Requirements   9
   View Composer Requirements   10

2 System Requirements for Guest Operating Systems   13
   Supported Operating Systems for Horizon Agent   13
   Supported Operating Systems for Standalone Horizon Persona Management   14
   Remote Display Protocol and Software Support   14

3 Installing Horizon 7 in an IPv6 Environment   21
   Setting Up Horizon 7 in an IPv6 Environment   21
   Supported vSphere, Database, and Active Directory Versions in an IPv6 Environment   22
   Supported Operating Systems for Horizon 7 Servers in an IPv6 Environment   23
   Supported Windows Operating Systems for Desktops and RDS Hosts in an IPv6 Environment   23
   Supported Clients in an IPv6 Environment   23
   Supported Remoting Protocols in an IPv6 Environment   24
   Supported Authentication Types in an IPv6 Environment   24
   Other Supported Features in an IPv6 Environment   24

4 Installing Horizon 7 in FIPS Mode   27
   Overview of Setting Up Horizon 7 in FIPS Mode   27
   System Requirements for FIPS Mode   28

5 Preparing Active Directory   29
   Configuring Domains and Trust Relationships   29
   Creating an OU for Remote Desktops   31
   Creating OUs and Groups for Kiosk Mode Client Accounts   31
   Creating Groups for Users   31
   Creating a User Account for vCenter Server   31
   Creating a User Account for a Standalone View Composer Server   32
   Create a User Account for View Composer AD Operations   32
   Create a User Account for Instant-Clone Operations   33
   Configure the Restricted Groups Policy   34
   Using Horizon 7 Group Policy Administrative Template Files   35
   Prepare Active Directory for Smart Card Authentication   35
6 Installing View Composer  40
   Prepare a View Composer Database  40
   Configuring an SSL Certificate for View Composer  49
   Install the View Composer Service  49
   Enable TLSv1.0 on vCenter and ESXi Connections from View Composer  52
   Configuring Your Infrastructure for View Composer  53

7 Installing Horizon Connection Server  54
   Installing the Horizon Connection Server Software  54
   Installation Prerequisites for Horizon Connection Server  55
   Install Horizon Connection Server with a New Configuration  56
   Install a Replicated Instance of Horizon Connection Server  64
   Configure a Security Server Pairing Password  71
   Install a Security Server  72
   Unified Access Gateway Appliance Advantages over VPN  80
   Firewall Rules for Horizon Connection Server  82
   Reinstall Horizon Connection Server with a Backup Configuration  84
   Microsoft Windows Installer Command-Line Options  85
   Uninstalling Horizon 7 Components Silently by Using MSI Command-Line Options  87

8 Configuring TLS Certificates for Horizon 7 Servers  90
   Understanding TLS Certificates for Horizon 7 Servers  90
   Overview of Tasks for Setting Up TLS Certificates  92
   Obtaining a Signed TLS Certificate from a CA  93
   Configure Horizon Connection Server, Security Server, or View Composer to Use a New TLS Certificate  95
   Configure Client Endpoints to Trust Root and Intermediate Certificates  101
   Configuring Certificate Revocation Checking on Server Certificates  104
   Configure the PCoIP Secure Gateway to Use a New TLS Certificate  105
   Setting Horizon Administrator to Trust a vCenter Server or View Composer Certificate  110
   Benefits of Using TLS Certificates Signed by a CA  110
   Troubleshooting Certificate Issues on Horizon Connection Server and Security Server  111

9 Enabling Horizon 7 for Subscription Licenses  112
   VMware Horizon 7 Cloud Connector  112
   Deploy the Horizon 7 Cloud Connector Virtual Appliance with Horizon 7  113
   Configure a CA-Signed Certificate for the Horizon 7 Cloud Connector Virtual Appliance  115

10 Configuring Horizon 7 for the First Time  117
   Configuring User Accounts for vCenter Server, View Composer, and Instant Clones  117
11 Configuring Event Reporting  154
  Add a Database and Database User for Horizon 7 Events  154
  Prepare an SQL Server Database for Event Reporting  155
  Configure the Event Database  156
  Configure Event Logging for Syslog Servers  157
Horizon 7 Installation

*Horizon 7 Installation* explains how to install the VMware Horizon® 7 server and client components.

**Intended Audience**

This information is intended for anyone who wants to install VMware Horizon 7. The information is written for experienced Windows or Linux system administrators who are familiar with virtual machine technology and datacenter operations.
System Requirements for Server Components

Hosts that run Horizon 7 server components must meet specific hardware and software requirements.

This chapter includes the following topics:

- Horizon Connection Server Requirements
- Horizon Administrator Requirements
- View Composer Requirements

Horizon Connection Server Requirements

Horizon Connection Server acts as a broker for client connections by authenticating and then directing incoming user requests to the appropriate remote desktops and applications. Horizon Connection Server has specific hardware, operating system, installation, and supporting software requirements.

- Hardware Requirements for Horizon Connection Server
  You must install all Horizon Connection Server installation types, including standard, replica, security server, and enrollment server installations, on a dedicated physical or virtual machine that meets specific hardware requirements.

- Supported Operating Systems for Horizon Connection Server
  You must install Horizon Connection Server on a supported Windows Server operating system.

- Virtualization Software Requirements for Horizon Connection Server
  Horizon Connection Server requires certain versions of VMware virtualization software.

- Network Requirements for Replicated Horizon Connection Server Instances
  When installing replicated Horizon Connection Server instances, you must usually configure the instances in the same physical location and connect them over a high-performance LAN. Otherwise, latency issues could cause the View LDAP configurations on Horizon Connection Server instances to become inconsistent. A user could be denied access when connecting to a Horizon Connection Server instance with an out-of-date configuration.

Hardware Requirements for Horizon Connection Server

You must install all Horizon Connection Server installation types, including standard, replica, security server, and enrollment server installations, on a dedicated physical or virtual machine that meets specific hardware requirements.
Table 1-1. Horizon Connection Server Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware Component</th>
<th>Required</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>Pentium IV 2.0GHz processor or higher</td>
<td>4 CPUs</td>
</tr>
<tr>
<td>Network Adapter</td>
<td>100Mpbs NIC</td>
<td>1Gbps NICs</td>
</tr>
<tr>
<td>Memory</td>
<td>4GB RAM or higher</td>
<td>At least 10GB RAM for deployments of 50 or more remote desktops</td>
</tr>
<tr>
<td>Windows Server 2008 R2 64-bit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td>4GB RAM or higher</td>
<td>At least 10GB RAM for deployments of 50 or more remote desktops</td>
</tr>
<tr>
<td>Windows Server 2012 R2 64-bit</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

These requirements also apply to replica and security server Horizon Connection Server instances that you install for high availability or external access.

**Important** The physical or virtual machine that hosts Horizon Connection Server must have an IP address that does not change. In an IPv4 environment, configure a static IP address. In an IPv6 environment, machines automatically get IP addresses that do not change.

**Supported Operating Systems for Horizon Connection Server**

You must install Horizon Connection Server on a supported Windows Server operating system.

The following operating systems support all Horizon Connection Server installation types, including standard, replica, and security server installations.

Table 1-2. Operating System Support for Horizon Connection Server

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 SP1</td>
<td>64-bit</td>
<td>Standard Enterprise Datacenter</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>64-bit</td>
<td>Standard Datacenter</td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>64-bit</td>
<td>Standard Datacenter</td>
</tr>
</tbody>
</table>

**Note** Windows Server 2008 R2 with no service pack is no longer supported.

**Virtualization Software Requirements for Horizon Connection Server**

Horizon Connection Server requires certain versions of VMware virtualization software.

If you are using vSphere, you must use a supported version of vSphere ESX/ESXi hosts and vCenter Server.
For details about which versions of Horizon are compatible with which versions of vCenter Server and ESXi, see the VMware Product Interoperability Matrix at http://www.vmware.com/resources/compatibility/sim/interop_matrix.php.

Network Requirements for Replicated Horizon Connection Server Instances

When installing replicated Horizon Connection Server instances, you must usually configure the instances in the same physical location and connect them over a high-performance LAN. Otherwise, latency issues could cause the View LDAP configurations on Horizon Connection Server instances to become inconsistent. A user could be denied access when connecting to a Horizon Connection Server instance with an out-of-date configuration.

**Important** To use a group of replicated Connection Server instances across a WAN, MAN (metropolitan area network), or other non-LAN, in scenarios where a Horizon deployment needs to span data centers, you must use the Cloud Pod Architecture feature. You can link together 25 pods to provide a single large desktop brokering and management environment for five geographically distant sites and provide desktops and applications for up to 50,000 sessions. For more information, see the Administering Cloud Pod Architecture in Horizon 7 document.

Horizon Administrator Requirements

Administrators use Horizon Administrator to configure Horizon Connection Server, deploy and manage remote desktops and applications, control user authentication, initiate and examine system events, and carry out analytical activities. Client systems that run Horizon Administrator must meet certain requirements.

Horizon Administrator is a Web-based application that is installed when you install Connection Server. You can access and use Horizon Administrator with the following Web browsers:

- Internet Explorer 9 (not recommended)
- Internet Explorer 10
- Internet Explorer 11
- Firefox (latest supported versions)
- Chrome (latest supported versions)
- Safari 6 and later releases
- Microsoft Edge (Windows 10)

To use Horizon Administrator with your Web browser, you must install Adobe Flash Player 10.1 or later. Your client system must have access to the Internet to allow Adobe Flash Player to be installed.

The computer on which you launch Horizon Administrator must trust the root and intermediate certificates of the server that hosts Connection Server. The supported browsers already contain certificates for all of the well-known certificate authorities (CAs). If your certificates come from a CA that is not well known, you must follow the instructions in Configure Client Endpoints to Trust Root and Intermediate Certificates.
To display text properly, Horizon Administrator requires Microsoft-specific fonts. If your Web browser runs on a non-Windows operating system such as Linux, UNIX, or Mac, make sure that Microsoft-specific fonts are installed on your computer.

Currently, the Microsoft Web site does not distribute Microsoft fonts, but you can download them from independent Web sites.

**View Composer Requirements**

With View Composer, you can deploy multiple linked-clone desktops from a single centralized base image. View Composer has specific installation and storage requirements.

- **Supported Operating Systems for View Composer**
  View Composer supports 64-bit operating systems with specific requirements and limitations. You can install View Composer on the same physical or virtual machine as vCenter Server or on a separate server.

- **Hardware Requirements for Standalone View Composer**
  If you install View Composer on a different physical or virtual machine from the one used for vCenter Server, you must use a dedicated machine that meets specific hardware requirements.

- **Database Requirements for View Composer and the Events Database**
  View Composer requires an SQL database to store data. The View Composer database must reside on, or be available to, the View Composer server host. You can optionally set up an Events database to record information from Horizon Connection Server about Horizon events.

**Supported Operating Systems for View Composer**

View Composer supports 64-bit operating systems with specific requirements and limitations. You can install View Composer on the same physical or virtual machine as vCenter Server or on a separate server.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2008 R2 SP1</td>
<td>64-bit</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Enterprise</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Datacenter</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>64-bit</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Datacenter</td>
</tr>
<tr>
<td>Windows Server 2016</td>
<td>64-bit</td>
<td>Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Datacenter</td>
</tr>
</tbody>
</table>

**Note**   Windows Server 2008 R2 with no service pack is no longer supported.

If you plan to install View Composer on a different physical or virtual machine than vCenter Server, see **Hardware Requirements for Standalone View Composer**.
Hardware Requirements for Standalone View Composer

If you install View Composer on a different physical or virtual machine from the one used for vCenter Server, you must use a dedicated machine that meets specific hardware requirements.

A standalone View Composer installation works with vCenter Server installed on a separate Windows Server machine or with the Linux-based vCenter Server appliance. VMware recommends having a one-to-one mapping between each View Composer service and vCenter Server instance.

Table 1-4. View Composer Hardware Requirements

<table>
<thead>
<tr>
<th>Hardware Component</th>
<th>Required</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor</td>
<td>1.4 GHz or faster Intel 64 or AMD 64 processor with 2 CPUs</td>
<td>2GHz or faster and 4 CPUs</td>
</tr>
<tr>
<td>Networking</td>
<td>One or more 10/100Mbps network interface cards (NICs)</td>
<td>1Gbps NICs</td>
</tr>
<tr>
<td>Memory</td>
<td>4GB RAM or higher</td>
<td>8GB RAM or higher for deployments of 50 or more remote desktops</td>
</tr>
<tr>
<td>Disk space</td>
<td>40GB</td>
<td>60GB</td>
</tr>
</tbody>
</table>

Important The physical or virtual machine that hosts View Composer must have an IP address that does not change. In an IPv4 environment, configure a static IP address. In an IPv6 environment, machines automatically get IP addresses that do not change.

Database Requirements for View Composer and the Events Database

View Composer requires an SQL database to store data. The View Composer database must reside on, or be available to, the View Composer server host. You can optionally set up an Events database to record information from Horizon Connection Server about Horizon events.

If a database server instance already exists for vCenter Server, View Composer can use that existing instance if it is a version listed in the VMware Product Interoperability Matrixes at http://www.vmware.com/resources/compatibility/sim/interop_matrix.php. If a database server instance does not already exist, you must install one.

View Composer supports a subset of the database servers that vCenter Server supports. If you are already using vCenter Server with a database server that is not supported by View Composer, continue to use that database server for vCenter Server and install a separate database server to use for View Composer.

Important If you create the View Composer database on the same SQL Server instance as vCenter Server, do not overwrite the vCenter Server database.
For the most up-to-date information about supported databases, see the VMware Product Interoperability Matrixes at http://www.vmware.com/resources/compatibility/sim/interop_matrix.php. For Solution/Database Interoperability, after you select the product and version, for the Add Database step, to see a list of all supported databases, select Any and click Add.
System Requirements for Guest Operating Systems

Systems running Horizon Agent or Horizon Persona Management must meet certain hardware and software requirements.

This chapter includes the following topics:

- Supported Operating Systems for Horizon Agent
- Supported Operating Systems for Standalone Horizon Persona Management
- Remote Display Protocol and Software Support

Supported Operating Systems for Horizon Agent

The Horizon Agent component (called View Agent in previous releases) assists with session management, single sign-on, device redirection, and other features. You must install Horizon Agent on all virtual machines, physical systems, and RDS hosts.

The types and editions of the supported guest operating system depend on the Windows version. For updates to the list of supported Windows 10 operating systems, see the VMware Knowledge Base (KB) article http://kb.vmware.com/kb/2149393. For Windows operating systems other than Windows 10, see the VMware Knowledge Base (KB) article http://kb.vmware.com/kb/2150295.

To see a list of specific remote experience features supported on Windows operating systems where Horizon Agent is installed, see the VMware Knowledge Base (KB) article http://kb.vmware.com/kb/2150305.

To use the Horizon Persona Management setup option with Horizon Agent, you must install Horizon Agent on Windows 10, Windows 8, Windows 8.1, Windows 7, Windows Server 2012 R2, Windows Server 2008 R2, or Windows Server 2016 virtual machines. This option does not operate on physical computers or RDS hosts.

You can install the standalone version of Horizon Persona Management on physical computers. See Supported Operating Systems for Standalone Horizon Persona Management.

Note To use the VMware Blast display protocol, you must install Horizon Agent on a single-session virtual machine or on an RDS host. The RDS host can be a physical machine or a virtual machine. The VMware Blast display protocol does not operate on a single-user physical computer, except for the enterprise edition of Windows 10 RS4 and later builds.
For enhanced security, VMware recommends configuring cipher suites to remove known vulnerabilities. For instructions on how to set up a domain policy on cipher suites for Windows machines that run View Composer or Horizon Agent, see Disable Weak Ciphers in SSL/TLS.

**Supported Operating Systems for Standalone Horizon Persona Management**

The standalone Horizon Persona Management software provides persona management for standalone physical computers and virtual machines that do not have Horizon Agent installed. When users log in, their profiles are downloaded dynamically from a remote profile repository to their standalone systems.

**Note** To configure Persona Management for Horizon desktops, install Horizon Agent with the Persona Management setup option. The standalone Persona Management software is intended for non-Horizon systems only.

To see a list of operating systems supported for the standalone Horizon Persona Management software, see the VMware Knowledge Base (KB) article [http://kb.vmware.com/kb/2150295](http://kb.vmware.com/kb/2150295).

The standalone Persona Management software is not supported on Microsoft Remote Desktop Services.

**Remote Display Protocol and Software Support**

Remote display protocols and software provide access to remote desktops and applications. The remote display protocol used depends on the type of client device, whether you are connecting to a remote desktop or a remote application, and how the administrator configures the desktop or application pool.

- **PCoIP**
  
  PCoIP (PC over IP) provides an optimized desktop experience for the delivery of a published application or an entire remote desktop environment, including applications, images, audio, and video content for a wide range of users on the LAN or across the WAN. PCoIP can compensate for an increase in latency or a reduction in bandwidth, to ensure that end users can remain productive regardless of network conditions.

- **Microsoft RDP**
  
  Remote Desktop Protocol is the same multichannel protocol many people already use to access their work computer from their home computer. Microsoft Remote Desktop Connection (RDC) uses RDP to transmit data.

- **VMware Blast Extreme**
  
  Optimized for the mobile cloud, VMware Blast Extreme supports the broadest range of client devices that are H.264 capable. Of the display protocols, VMware Blast offers the lowest CPU consumption for longer battery life on mobile devices. VMware Blast Extreme can compensate for an increase in latency or a reduction in bandwidth and can leverage both TCP and UDP network transports.
PCoIP

PCoIP (PC over IP) provides an optimized desktop experience for the delivery of a published application or an entire remote desktop environment, including applications, images, audio, and video content for a wide range of users on the LAN or across the WAN. PCoIP can compensate for an increase in latency or a reduction in bandwidth, to ensure that end users can remain productive regardless of network conditions.

The PCoIP display protocol can be used for published applications and for remote desktops that use virtual machines, physical machines that contain Teradici host cards, or shared session desktops on an RDS host.

PCoIP Features

Key features of PCoIP include the following:

- Users outside the corporate firewall can use this protocol with your company's virtual private network (VPN), or users can make secure, encrypted connections to a security server or Access Point appliance in the corporate DMZ.
- Advanced Encryption Standard (AES) 128-bit encryption is supported and is turned on by default. You can, however, change the encryption key cipher to AES-256.
- Connections to Windows desktops with the Horizon Agent operating system versions listed in Supported Operating Systems for Horizon Agent are supported.
- Connections from all types of client devices.
- Optimization controls for reducing bandwidth usage on the LAN and WAN.
- 32-bit color is supported for virtual displays.
- ClearType fonts are supported.
- Audio redirection with dynamic audio quality adjustment for LAN and WAN.
- Real-Time Audio-Video for using webcams and microphones on some client types.
- Copy and paste of text and, on some clients, images between the client operating system and a remote desktop or published application. For other client types, only copy and paste of plain text is supported. You cannot copy and paste system objects such as folders and files between systems.
- Multiple monitors are supported for some client types. On some clients, you can use up to 4 monitors with a resolution of up to 2560 x 1600 per display or up to 3 monitors with a resolution of 4K (3840 x 2160) for Windows 7 remote desktops with Aero disabled. Pivot display and autofit are also supported.
  
  When the 3D feature is enabled, up to 2 monitors are supported with a resolution of up to 1920 x 1200, or one monitor with a resolution of 4K (3840 x 2160).
- USB redirection is supported for some client types.
MMR redirection is supported for some Windows client operating systems and some remote desktop operating systems (with Horizon Agent installed).

For information about which desktop operating systems support specific PCoIP features, see the Horizon 7 Architecture Planning document.

For information about which client devices support specific PCoIP features, go to https://docs.vmware.com/en/VMware-Horizon-Client/index.html.

Recommended Guest Operating System Settings

1GB of RAM or more and a dual CPU is recommended for playing in high-definition, full screen mode, or 720p or higher formatted video. To use Virtual Dedicated Graphics Acceleration for graphics-intensive applications such as CAD applications, 4GB of RAM is required.

Video Quality Requirements

480p-formatted video You can play video at 480p or lower at native resolutions when the remote desktop has a single virtual CPU. If you want to play the video in high-definition Flash or in full screen mode, the desktop requires a dual virtual CPU. Even with a dual virtual CPU desktop, as low as 360p-formatted video played in full screen mode can lag behind audio, particularly on Windows clients.

720p-formatted video You can play video at 720p at native resolutions if the remote desktop has a dual virtual CPU. Performance might be affected if you play videos at 720p in high definition or in full screen mode.

1080p-formatted video If the remote desktop has a dual virtual CPU, you can play 1080p formatted video, although the media player might need to be adjusted to a smaller window size.

3D rendering You can configure remote desktops to use software- or hardware-accelerated graphics. The software-accelerated graphics feature enables you to run DirectX 9 and OpenGL 2.1 applications without requiring a physical graphics processing unit (GPU). The hardware-accelerated graphics features enable virtual machines to either share the physical GPUs (graphical processing unit) on a vSphere host or dedicate a physical GPU to a single virtual machine desktop.

For 3D applications, up to 2 monitors are supported, and the maximum screen resolution is 1920 x 1200. The guest operating system on the remote desktops must be Windows 7 or later.

Hardware Requirements for Client Systems

For information about processor and memory requirements, see the "Using VMware Horizon Client" document for the specific type of desktop or mobile client device. Go to https://docs.vmware.com/en/VMware-Horizon-Client/index.html.
Microsoft RDP

Remote Desktop Protocol is the same multichannel protocol many people already use to access their work computer from their home computer. Microsoft Remote Desktop Connection (RDC) uses RDP to transmit data.

Microsoft RDP is a supported display protocol for remote desktops that use virtual machines, physical machines, or shared session desktops on an RDS host. (Only the PCoIP display protocol and the VMware Blast display protocol are supported for published applications.) Microsoft RDP provides the following features:

- RDP 7 has true multiple monitor support, for up to 16 monitors.
- You can copy and paste text and system objects such as folders and files between the local system and the remote desktop.
- 32-bit color is supported for virtual displays.
- RDP supports 128-bit encryption.
- Users outside the corporate firewall can use this protocol with your company's virtual private network (VPN), or users can make secure, encrypted connections to a View security server in the corporate DMZ.

To support TLSv1.1 and TLSv1.2 connections to Windows 7 and Windows Server 2008 R2, you must apply Microsoft hotfix KB3080079.

Hardware Requirements for Client Systems

For information about processor and memory requirements, see the "Using VMware Horizon Client" document for the specific type of client system. Go to https://docs.vmware.com/en/VMware-Horizon-Client/index.html.

**Note**  Mobile client 3.x devices use only the PCoIP display protocol. Mobile client 4.x clients use only the PCoIP display protocol or the VMware Blast display protocol.

VMware Blast Extreme

Optimized for the mobile cloud, VMware Blast Extreme supports the broadest range of client devices that are H.264 capable. Of the display protocols, VMware Blast offers the lowest CPU consumption for longer battery life on mobile devices. VMware Blast Extreme can compensate for an increase in latency or a reduction in bandwidth and can leverage both TCP and UDP network transports.

The VMware Blast display protocol can be used for published applications and for remote desktops that use virtual machines or shared-session desktops on an RDS host. The RDS host can be a physical machine or a virtual machine. The VMware Blast display protocol does not operate on a single-user physical computer, except for the enterprise edition of Windows 10 RS4 and later builds.

**Note**  Movies & TV applications are not supported for physical computers running Windows 10 RS4.
VMware Blast Extreme Features

Key features of VMware Blast Extreme include the following:

- Users outside the corporate firewall can use this protocol with the corporate virtual private network (VPN), or users can make secure, encrypted connections to a security server or Access Point appliance in the corporate DMZ.

- Advanced Encryption Standard (AES) 128-bit encryption is supported and is turned on by default. You can, however, change the encryption key cipher to AES-256.

- Connections to Windows desktops with the Horizon Agent operating system versions listed in Supported Operating Systems for Horizon Agent are supported.

- Connections from all types of client devices.

- Optimization controls for reducing bandwidth usage on the LAN and WAN.

- Performance counters displayed using PerfMon on Windows agents provide an accurate representation of the current state of the system that also updates at a constant rate for the following:
  - Blast session
  - Imaging
  - Audio
  - CDR
  - USB: USB counters displayed using PerfMon on Windows agents are valid if USB traffic is configured to use VMware Virtual Channel (VVC).
  - Skype for Business: counters are for control traffic only.
  - Clipboard
  - RTAV
  - Serial port and scanner redirection features
  - Virtual printing
  - HTML5 MMR
  - Windows Media MMR: Performance counters appear only if you configured this feature to use VMware Virtual Channel (VVC).

- Network continuity during momentary network loss on Windows clients.

- 32-bit color is supported for virtual displays.

- ClearType fonts are supported.

- Audio redirection with dynamic audio quality adjustment for LAN and WAN.

- Real-Time Audio-Video for using webcams and microphones on some client types.
- Copy and paste of text and, on some clients, images between the client operating system and a remote desktop or published application. For other client types, only copy and paste of plain text is supported. You cannot copy and paste system objects such as folders and files between systems.

- Multiple monitors are supported for some client types. On some clients, you can use up to four monitors with a resolution of up to 2560 x 1600 per display or up to three monitors with a resolution of 4K (3840 x 2160) for Windows 7 remote desktops with Aero disabled. Pivot display and autofit are also supported.

When the 3D feature is enabled, up to two monitors are supported with a resolution of up to 1920 x 1200, or one monitor with a resolution of 4K (3840 x 2160).

- USB redirection is supported for some client types.

- MMR redirection is supported for some Windows client operating systems and some remote desktop operating systems (with Horizon Agent installed).

- Connections to physical machines that have no monitors attached are supported with NVIDIA graphics cards. For best performance, use a graphics card that supports H.264 encoding.

If you have an add-in discrete GPU and an embedded GPU, the operating system might default to the embedded GPU. To fix this problem, you can disable or remove the device in Device Manager. If the problem persists, you can install the WDDM graphics driver for the embedded GPU, or disable the embedded GPU in the system BIOS. Refer to your system documentation on how disable the embedded GPU.

**Caution** Disabling the embedded GPU might cause future loss of access to functionality such as console access to BIOS setup or NT Boot Loader.

For information about which client devices support specific VMware Blast Extreme features, go to [https://docs.vmware.com/en/VMware-Horizon-Client/index.html](https://docs.vmware.com/en/VMware-Horizon-Client/index.html).

**Wake-on-LAN**

Wake-on-LAN is supported for physical machines with the Enterprise edition of Windows 10 RS4 and later. With this feature, users can wake up physical machines when connecting with Horizon Connection Server. The Wake-on-LAN feature has these prerequisites:

- **Wake-on-LAN (WoL)** is only supported on IPv4 environments.

- The physical machine must be configured to wake up on receiving Wake-on-LAN packets when Wake-on-LAN is enabled in the BIOS settings as well as network card settings.

- Destination port 9 is used for WoL packets from Connection Server.

- WoL packets are IP-directed broadcast packets that must be able to reach Horizon Agent when sent from Horizon Connection Server. Wake-on-LAN functions in these scenarios:
  - Connection Server and Horizon Agent on the physical machine are on the same subnet in a LAN environment.
- All routers between Connection Server and Horizon Agent are configured to allow the IP-directed broadcast packet for the target subnet of the physical machine you want to wake up.

**Note**  The Wake-on-LAN feature does not support floating-assignment pools of a physical Windows 10 agent. The WoL packet is only sent to dedicated assignment pools entitled with a particular user.

### Recommended Guest Operating System Settings

1 GB of RAM or more and a dual CPU is recommended for playing in high-definition, full screen mode, or 720p or higher formatted video. To use Virtual Dedicated Graphics Acceleration for graphics-intensive applications such as CAD applications, 4 GB of RAM is required.

### Video Quality Requirements

- **480p-formatted video**
  You can play video at 480p or lower at native resolutions when the remote desktop has a single virtual CPU. If you want to play the video in high-definition Flash or in full screen mode, the desktop requires a dual virtual CPU. Even with a dual virtual CPU desktop, as low as 360p-formatted video played in full screen mode can lag behind audio, particularly on Windows clients.

- **720p-formatted video**
  You can play video at 720p at native resolutions if the remote desktop has a dual virtual CPU. Performance might be affected if you play videos at 720p in high definition or in full screen mode.

- **1080p-formatted video**
  If the remote desktop has a dual virtual CPU, you can play 1080p formatted video, although the media player might need to be adjusted to a smaller window size.

- **3D rendering**
  You can configure remote desktops to use software- or hardware-accelerated graphics. The software-accelerated graphics feature enables you to run DirectX 9 and OpenGL 2.1 applications without requiring a physical graphics processing unit (GPU). The hardware-accelerated graphics features enable virtual machines to either share the physical GPUs (graphical processing unit) on a vSphere host or dedicate a physical GPU to a single virtual desktop.

  For 3D applications, up to two monitors are supported, and the maximum screen resolution is 1920 x 1200. The guest operating system on the remote desktops must be Windows 7 or later.

### Hardware Requirements for Client Systems

For information about processor and memory requirements for the specific type of desktop or mobile client device, go to [https://docs.vmware.com/en/VMware-Horizon-Client/index.html](https://docs.vmware.com/en/VMware-Horizon-Client/index.html).
Installing Horizon 7 in an IPv6 Environment

Horizon 7 supports IPv6 as an alternative to IPv4. The environment must be either IPv6 only or IPv4 only. Horizon 7 does not support a mixed IPv6 and IPv4 environment.

Not all Horizon 7 features that are supported in an IPv4 environment are supported in an IPv6 environment. Horizon 7 does not support upgrading from an IPv4 environment to an IPv6 environment. Also, Horizon 7 does not support migration between IPv4 and IPv6 environments.

Important To run Horizon 7 in an IPv6 environment, you must specify IPv6 when you install all Horizon 7 components.

This chapter includes the following topics:

- Setting Up Horizon 7 in an IPv6 Environment
- Supported vSphere, Database, and Active Directory Versions in an IPv6 Environment
- Supported Operating Systems for Horizon 7 Servers in an IPv6 Environment
- Supported Windows Operating Systems for Desktops and RDS Hosts in an IPv6 Environment
- Supported Clients in an IPv6 Environment
- Supported Remoting Protocols in an IPv6 Environment
- Supported Authentication Types in an IPv6 Environment
- Other Supported Features in an IPv6 Environment

Setting Up Horizon 7 in an IPv6 Environment

To run Horizon 7 in an IPv6 environment, you must be aware of the requirements and choices that are specific to IPv6 when you perform certain administrative tasks.

Before you install Horizon 7, you must have a working IPv6 environment. The following Horizon 7 administrative tasks have options that are specific to IPv6.

- Installing Horizon Connection Server. See Install Horizon Connection Server with a New Configuration.
- Installing View Replica Server. See Install a Replicated Instance of Horizon Connection Server.
- Configuring the PCoIP External URL. See Configuring External URLs for Secure Gateway and Tunnel Connections.
- Setting the PCoIP External URL. See Set the External URLs for a Connection Server Instance.
- Modifying the PCoIP External URL. See Set the External URLs for a Connection Server Instance.
- Installing Horizon Agent. See the Horizon Agent installation topics in the Setting Up Desktop and Application Pools document.

**Note**  Horizon 7 does not require you to enter an IPv6 address in any administrative tasks. In cases where you can specify either a fully qualified domain name (FQDN) or an IPv6 address, it is highly recommended that you specify an FQDN to avoid potential errors.

### Supported vSphere, Database, and Active Directory Versions in an IPv6 Environment

In an IPv6 environment, Horizon 7 supports specific vSphere, database server, and Active Directory versions.

The following vSphere versions are supported in an IPv6 environment.

- 6.7
- 6.5 U2
- 6.5
- 6.0
- 5.5 U2

The following database servers are supported in an IPv6 environment.

<table>
<thead>
<tr>
<th>Database Server</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>SQL Server 2012 SP3</td>
<td>32/64-bit</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>SQL Server 2012 SP4</td>
<td>32/64-bit</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>SQL Server 2012 Express</td>
<td>32/64-bit</td>
<td>Free</td>
</tr>
<tr>
<td>SQL Server 2014 alwayson</td>
<td>32/64-bit</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>SQL Server 2014 SP2</td>
<td>32/64-bit</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>SQL Server 2016</td>
<td>64-bit</td>
<td>Standard, Enterprise, Express</td>
</tr>
<tr>
<td>SQL Server 2016 alwayson</td>
<td>64-bit</td>
<td>Standard, Enterprise, Express</td>
</tr>
<tr>
<td>SQL Server 2017</td>
<td>64-bit</td>
<td>Standard, Enterprise, Express, Developer</td>
</tr>
<tr>
<td>Oracle 11g R2</td>
<td>32/64-bit</td>
<td>Standard, Standard Edition One, Enterprise</td>
</tr>
<tr>
<td>Oracle 12c R2</td>
<td>32/64-bit</td>
<td>Standard, Standard Edition One, Enterprise</td>
</tr>
</tbody>
</table>
The following Active Directory versions are supported in an IPv6 environment.

- Microsoft Active Directory 2008 R2
- Microsoft Active Directory 2012 R2

**Supported Operating Systems for Horizon 7 Servers in an IPv6 Environment**

In an IPv6 environment, you must install Horizon 7 servers on specific Windows Server operating systems.

Horizon 7 servers include Connection Server instances, replica servers, security servers, and Horizon 7 Composer instances.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Server 2016</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>Windows Server 2008 R2 SP1</td>
<td>Standard, Enterprise</td>
</tr>
<tr>
<td>Windows Server 2012 R2</td>
<td>Standard</td>
</tr>
</tbody>
</table>

**Supported Windows Operating Systems for Desktops and RDS Hosts in an IPv6 Environment**

In an IPv6 environment, Horizon 7 supports specific Windows operating systems for desktop machines and RDS hosts. RDS hosts provide session-based desktops and applications to users.

The types and editions of the supported guest operating system depend on the Windows version. For updates to the list of supported Windows 10 operating systems, see the VMware Knowledge Base (KB) article [http://kb.vmware.com/kb/2149393](http://kb.vmware.com/kb/2149393). For Windows operating systems other than Windows 10, see the VMware Knowledge Base (KB) article [http://kb.vmware.com/kb/2150295](http://kb.vmware.com/kb/2150295).

To see a list of specific remote experience features supported on Windows operating systems where Horizon Agent is installed, see the VMware Knowledge Base (KB) article [http://kb.vmware.com/kb/2150305](http://kb.vmware.com/kb/2150305).

**Supported Clients in an IPv6 Environment**

In an IPv6 environment, Horizon 7 supports clients that run on specific desktop operating systems.

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Version</th>
<th>Edition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 7 and Windows 7 SP1</td>
<td>32-bit or 64-bit</td>
<td>Home, Enterprise, Professional, and Ultimate</td>
</tr>
<tr>
<td>Windows 8 and Windows 8.1</td>
<td>32-bit or 64-bit</td>
<td>Pro, Enterprise, and Industry Embedded</td>
</tr>
<tr>
<td>Windows 10</td>
<td>32-bit or 64-bit</td>
<td>Home, Pro, Pro for Workstations, Enterprise, and IoT Enterprise</td>
</tr>
</tbody>
</table>
On iOS devices, iOS 9.2 or later is supported with Horizon Client 4.1 or later.
On Android and macOS devices, Horizon Client 4.9 or later is required.
The following types of clients are not supported.
- Clients that run on Linux, Chrome OS, Windows 10 UWP, or Windows Store
- iOS 9.1 or earlier
- PCoIP Zero Client

**Supported Remoting Protocols in an IPv6 Environment**
In an IPv6 environment, Horizon 7 supports specific remoting protocols.
The following remoting protocols are supported:
- RDP
- RDP with Secure Tunnel
- PCoIP
- PCoIP through PCoIP Secure Gateway
- VMware Blast
- VMware Blast through Blast Secure Gateway
- Blast Extreme Adaptive Transport (BEAT)

**Supported Authentication Types in an IPv6 Environment**
In an IPv6 environment, Horizon 7 supports specific authentication types.
The following authentication types are supported:
- Password authentication using Active Directory
- Smart Card
- Single Sign-On
The following authentication types are not supported:
- SecurID
- RADIUS
- SAML

**Other Supported Features in an IPv6 Environment**
In an IPv6 environment, Horizon 7 supports certain features that are not covered in previous topics.
The following features are supported:
- Application pools
- Audio-out
- Automated desktop pools of full virtual machines or Horizon 7 Composer linked clones

**Note** Automated desktop pools of instant clones are not supported.

- Blast Extreme Adaptive Transport (BEAT)
- Customer Experience Improvement Program (CEIP)
- Disk space reclamation
- Events
- HTML5 Multimedia Redirection
- LDAP backup
- Manual desktop pools, including vCenter Server virtual machines, physical computers, and virtual machines not managed by vCenter Server
- Native NFS snapshots (VAAI)
- Horizon Performance Tracker
- Persona Management
- RDS desktop pools
- RDS Host 3D
- Role-based administration
- Session Collaboration
- Single Sign-on, including the Log in as current user feature
- System health dashboard
- ThinApp
- Unity touch
- USB redirection
- Horizon 7 Composer Agent
- Horizon 7 Storage Accelerator
- Horizon 7 Composer database backup
- Virtual printing
- VMware audio
- VMware video
- VMware Virtualization Pack for Skype for Business
The following features are not supported:

- Client drive redirection
- Client IP Transparency (only 64-bit)
- Cloud Pod Architecture
- Device Bridge
- File Association
- Flash URL redirection
- HTML access
- Log Insight
- Lync
- Real-time audio-video (RTAV)
- Scanner redirection
- Serial port redirection
- Syslog
- Teradici TERA host card
- TSMMR
- URL redirection
- vSAN
- Virtual Volumes
- vRealize Operations Desktop Agent
- VMware Virtualization Pack for Skype for Business in Fallback Mode
Horizon 7 can perform cryptographic operations using FIPS (Federal Information Processing Standard) 140-2 compliant algorithms. You can enable the use of these algorithms by installing Horizon 7 in FIPS mode.

Not all Horizon 7 features are supported in FIPS mode. Also, Horizon 7 does not support upgrading from a non-FIPS installation to a FIPS installation.

**Note** To ensure that Horizon 7 runs in FIPS mode, you must enable FIPS when you install all Horizon 7 components.

This chapter includes the following topics:

- Overview of Setting Up Horizon 7 in FIPS Mode
- System Requirements for FIPS Mode

### Overview of Setting Up Horizon 7 in FIPS Mode

To set up Horizon 7 in FIPS mode, you must first enable FIPS mode in the Windows environment. Then you install all the Horizon 7 components in FIPS mode.

The option to install Horizon 7 in FIPS mode is available only if FIPS mode is enabled in the Windows environment. For more information about enabling FIPS mode in Windows, see https://support.microsoft.com/en-us/kb/811833.

**Note** Horizon Administrator does not indicate whether Horizon 7 is running in FIPS mode.

To install Horizon 7 in FIPS mode, perform the following administrative tasks.

- When installing Connection Server, select the FIPS mode option. See Install Horizon Connection Server with a New Configuration.
- When installing a replica server, select the FIPS mode option. See Install a Replicated Instance of Horizon Connection Server.
- Before installing a security server, deselect the global setting Use IPSec for Security Server Connections in Horizon Administrator and configure IPsec manually. See http://kb.vmware.com/kb/2000175.
When installing a security server, select the FIPS mode option. See Install a Security Server.

When a Windows system is configured for FIPS operation and Horizon 7 is configured to communicate between a Connection Server and a security server with IPSec, the security server fails to install. In an IPv4 environment, specify the PCoIP external URL as an IP address with the port number 4172. In an IPv6 environment, you can specify an IP address or a fully qualified domain name, and the port number 4172. In either case, do not include a protocol name.

For example, in an IPv4 environment: 10.20.30.40:4172

Clients must be able to use the URL to reach the security server.

Disable weak ciphers for View Composer and Horizon Agent machines. See Disable Weak Ciphers in SSL/TLS.

When installing View Composer, select the FIPS mode option. See Chapter 6 Installing View Composer.

When installing Horizon Agent, select the FIPS mode option. See the Horizon Agent installation topics in the Setting Up Virtual Desktops in Horizon 7 or Setting Up Published Desktops and Applications in Horizon 7 document.

For Windows clients, enable FIPS mode in the client operating system and select the FIPS mode option when installing Horizon Client for Windows. See the VMware Horizon Client for Windows Installation and Setup Guide document.

For Linux clients, enable FIPS mode in the client operating system. See the VMware Horizon Client for Linux Installation and Setup Guide document.

System Requirements for FIPS Mode

To support FIPS mode, your Horizon 7 deployment must meet the following requirements.

vSphere
- vCenter Server 6.0 or later
- ESXi 6.0 or later

Remote desktop
- Any Windows platform that has a FIPS certificate. For information, see "FIPS 140 Validation" on the Microsoft TechNet website.
- View Agent 6.2 or later or Horizon Agent 7.0 or later, for Windows platforms only

Horizon Client
- Any Windows platform that has a FIPS certificate. For information, see "FIPS 140 Validation" on the Microsoft TechNet website.
- Horizon Client for Windows 3.5 or later

Cryptographic protocol
- TLSv1.2
Preparing Active Directory

Horizon 7 uses your existing Microsoft Active Directory infrastructure for user authentication and management. You must perform certain tasks to prepare Active Directory for use with Horizon 7.

Horizon 7 supports the following Active Directory Domain Services (AD DS) domain functional levels:

- Windows Server 2008
- Windows Server 2008 R2
- Windows Server 2012
- Windows Server 2012 R2
- Windows Server 2016

This chapter includes the following topics:

- Configuring Domains and Trust Relationships
- Creating an OU for Remote Desktops
- Creating OUs and Groups for Kiosk Mode Client Accounts
- Creating Groups for Users
- Creating a User Account for vCenter Server
- Creating a User Account for a Standalone View Composer Server
- Create a User Account for View Composer AD Operations
- Create a User Account for Instant-Clone Operations
- Configure the Restricted Groups Policy
- Using Horizon 7 Group Policy Administrative Template Files
- Prepare Active Directory for Smart Card Authentication
- Disable Weak Ciphers in SSL/TLS

Configuring Domains and Trust Relationships

You must join each Connection Server host to an Active Directory domain. The host must not be a domain controller.
Active Directory also manages the Horizon Agent machines, including single-user machines and RDS hosts, and the users and groups in your Horizon 7 deployment. You can entitle users and groups to remote desktops and applications, and you can select users and groups to be administrators in Horizon Administrator.

You can place Horizon Agent machines, View Composer servers, and users and groups, in the following Active Directory domains:

- The Connection Server domain
- A different domain that has a two-way trust relationship with the Connection Server domain
- A domain in a different forest than the Connection Server domain that is trusted by the Connection Server domain in a one-way external or realm trust relationship
- A domain in a different forest than the Connection Server domain that is trusted by the Connection Server domain in a one-way or two-way transitive forest trust relationship

Users are authenticated using Active Directory against the Connection Server domain and any additional user domains with which a trust agreement exists.

If your users and groups are in one-way trusted domains, you must provide secondary credentials for the administrator users in Horizon Administrator. Administrators must have secondary credentials to give them access to the one-way trusted domains. A one-way trusted domain can be an external domain or a domain in a transitive forest trust.

Secondary credentials are required only for Horizon Administrator sessions, not for end users’ desktop or application sessions. Only administrator users require secondary credentials.

You can provide secondary credentials by using the `vdmadmin -T` command.

- You configure secondary credentials for individual administrator users.
- For a forest trust, you can configure secondary credentials for the forest root domain. Connection Server can then enumerate the child domains in the forest trust.

For more information, see "Providing Secondary Credentials for Administrators Using the -T Option" in the Horizon 7 Administration document.

Smart card and SAML authentication of users is not supported in one-way trusted domains.

**Note** Because security servers do not access any authentication repositories, including Active Directory, they do not need to reside in an Active Directory domain.

**Trust Relationships and Domain Filtering**

To determine which domains it can access, a Connection Server instance traverses trust relationships beginning with its own domain.

For a small, well-connected set of domains, Connection Server can quickly determine the full list of domains, but the time that it takes increases as the number of domains increases or as the connectivity between the domains decreases. The list might also include domains that you would prefer not to offer to users when they connect to their remote desktops and applications.
You can use the `vdmadmin` command to configure domain filtering to limit the domains that a Connection Server instance searches and that it displays to users. See the *Horizon 7 Administration* document for more information.

If a forest trust is configured with name suffix exclusions, the configured exclusions are used to filter the list of forest child domains. Name suffix exclusion filtering is applied in addition to the filtering that is specified with the `vdmadmin` command.

### Creating an OU for Remote Desktops

You should create an organizational unit (OU) specifically for your remote desktops. An OU is a subdivision in Active Directory that contains users, groups, computers, or other OUs.

To prevent group policy settings from being applied to other Windows servers or workstations in the same domain as your desktops, you can create a GPO for your Horizon 7 group policies and link it to the OU that contains your remote desktops. You can also delegate control of the OU to subordinate groups, such as server operators or individual users.

If you use View Composer, you should create a separate Active Directory container for linked-clone desktops that is based on the OU for your remote desktops. Administrators that have OU administrator privileges in Active Directory can provision linked-clone desktops without domain administrator privileges. If you change administrator credentials in Active Directory, you must also update the credential information in View Composer.

### Creating OUs and Groups for Kiosk Mode Client Accounts

A client in kiosk mode is a thin client or a locked-down PC that runs the client software to connect to a Connection Server instance and launch a remote desktop session. If you configure clients in kiosk mode, you should create dedicated OUs and groups in Active Directory for kiosk mode client accounts.

Creating dedicated OUs and groups for kiosk mode client accounts partitions client systems against unwarranted intrusion and simplifies client configuration and administration.

See the *Horizon 7 Administration* document for more information.

### Creating Groups for Users

You should create groups for different types of users in Active Directory. For example, you can create a group called Horizon 7 Users for your end users and another group called Horizon 7 Administrators for users that will administer remote desktops and applications.

### Creating a User Account for vCenter Server

You must create a user account in Active Directory to use with vCenter Server. You specify this user account when you add a vCenter Server instance in Horizon Administrator.
You must give the user account privileges to perform certain operations in vCenter Server. You can create a vCenter Server role with the appropriate privileges and assign the role to the vCenter Server user. The list of privileges you add to the vCenter Server role varies, depending on whether you use Horizon 7 with or without View Composer. See Configuring User Accounts for vCenter Server, View Composer, and Instant Clones for information on configuring these privileges.

If you install View Composer on the same machine as vCenter Server, you must add the vCenter Server user to the local Administrators group on the vCenter Server machine. This requirement allows Horizon 7 to authenticate to the View Composer service.

If you install View Composer on a different machine than vCenter Server, you do not have to make the vCenter Server user a local administrator on the vCenter Server machine. However, you do have to create a standalone View Composer Server user account that must be a local administrator on the View Composer machine.

### Creating a User Account for a Standalone View Composer Server

If you install View Composer on a different machine than vCenter Server, you must create a domain user account in Active Directory that Horizon 7 can use to authenticate to the View Composer service on the standalone machine.

The user account must be in the same domain as your Connection Server host or in a trusted domain. You must add the user account to the local Administrators group on the standalone View Composer machine.

You specify this user account when you configure View Composer settings in Horizon Administrator and select Standalone View Composer Server. See Configure View Composer Settings.

### Create a User Account for View Composer AD Operations

If you use View Composer, you must create a user account in Active Directory that allows View Composer to perform certain operations in Active Directory. View Composer requires this account to join linked-clone virtual machines to your Active Directory domain.

To ensure security, you should create a separate user account to use with View Composer. By creating a separate account, you can guarantee that it does not have additional privileges that are defined for another purpose. You can give the account the minimum privileges that it needs to create and remove computer objects in a specified Active Directory container. For example, the View Composer account does not require domain administrator privileges.

#### Procedure

1. In Active Directory, create a user account in the same domain as your Connection Server host or in a trusted domain.
2. Add the **Create Computer Objects, Delete Computer Objects**, and **Write All Properties** permissions to the account in the Active Directory container in which the linked-clone computer accounts are created or to which the linked-clone computer accounts are moved.

The following list shows all the required permissions for the user account, including permissions that are assigned by default:

- List Contents
- Read All Properties
- Write All Properties
- Read Permissions
- Reset Password
- Create Computer Objects
- Delete Computer Objects

**Note** Fewer permissions are required if you select the **Allow reuse of pre-existing computer accounts** setting for a desktop pool. Make sure that the following permissions are assigned to the user account:

- List Contents
- Read All Properties
- Read Permissions
- Reset Password

3. Make sure that the user account's permissions apply to the Active Directory container and to all child objects of the container.

**What to do next**

Specify the account in Horizon Administrator when you configure View Composer domains in the Add vCenter Server wizard and when you configure and deploy linked-clone desktop pools.

**Create a User Account for Instant-Clone Operations**

Before you deploy instant clones, you must create a user account that has the permission to perform certain operations in Active Directory.

Select this account when you add an instant-clone domain administrator before deploying instant-clone desktop pools. For more information, see "Add an Instant-Clone Domain Administrator" in the *Setting Up Virtual Desktops in Horizon 7* document.

**Procedure**

1. In Active Directory, create a user account in the same domain as the Connection Server or in a trusted domain.
2 Add the **Create Computer Objects**, **Delete Computer Objects**, and **Write All Properties** permissions to the account on the container for the instant-clone computer accounts.

The following list shows the required permissions for the user account, including permissions that are assigned by default:

- List Contents
- Read All Properties
- Write All Properties
- Read Permissions
- Reset Password
- Create Computer Objects
- Delete Computer Objects

Make sure that the permissions apply to the correct container and to all child objects of the container.

**Configure the Restricted Groups Policy**

To be able to connect to a remote desktop, users must belong to the local Remote Desktop Users group of the remote desktop. You can use the Restricted Groups policy in Active Directory to add users or groups to the local Remote Desktop Users group of every remote desktop that is joined to your domain.

The Restricted Groups policy sets the local group membership of computers in the domain to match the membership list settings defined in the Restricted Groups policy. The members of your remote desktop users group are always added to the local Remote Desktop Users group of every remote desktop that is joined to your domain. When adding new users, you need only add them to your remote desktop users group.

**Prerequisites**

Create a group for remote desktop users in your domain in Active Directory.

**Procedure**

1 On the Active Directory server, navigate to the Group Policy Management plug-in.

<table>
<thead>
<tr>
<th>AD Version</th>
<th>Navigation Path</th>
</tr>
</thead>
</table>
| Windows 2003   | a Select Start > All Programs > Administrative Tools > Active Directory Users and Computers.  
|                | b Right-click your domain and click Properties.                                  
|                | c On the Group Policy tab, click Open to open the Group Policy Management plug-in.  
|                | d Right-click Default Domain Policy, and click Edit.                             |
| Windows 2008   | a Select Start > Administrative Tools > Group Policy Management.                 
|                | b Expand your domain, right-click Default Domain Policy, and click Edit.          |
2. Expand the **Computer Configuration** section and open **Windows Settings\Security Settings**.


4. Right-click the new restricted Remote Desktop Users group and add your remote desktop users group to the group membership list.

5. Click **OK** to save your changes.

### Using Horizon 7 Group Policy Administrative Template Files

Horizon 7 includes several component-specific group policy administrative (ADMX) template files.

All ADMX files that provide group policy settings for Horizon 7 are available in VMware-Horizon-Extras-Bundle-x.x.x-YYYYYY.zip, where x.x.x is the version and YYYYYY is the build number. You can download the file from the VMware Downloads site at https://my.vmware.com/web/vmware/downloads. Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes the ZIP file.

You can optimize and secure remote desktops by adding the policy settings in these files to a new or existing GPO in Active Directory and then linking that GPO to the OU that contains your desktops.

See the Horizon 7 Administration and Configuring Remote Desktop Features in Horizon 7 documents for information on using Horizon 7 group policy settings.

### Prepare Active Directory for Smart Card Authentication

You might need to perform certain tasks in Active Directory when you implement smart card authentication.

- **Add UPNs for Smart Card Users**
  
  Because smart card logins rely on user principal names (UPNs), the Active Directory accounts of users and administrators that use smart cards to authenticate in Horizon 7 must have a valid UPN.

- **Add the Root Certificate to Trusted Root Certification Authorities**
  
  If you use a certification authority (CA) to issue smart card login or domain controller certificates, you must add the root certificate to the Trusted Root Certification Authorities group policy in Active Directory. You do not need to perform this procedure if the Windows domain controller acts as the root CA.
Add an Intermediate Certificate to Intermediate Certification Authorities

If you use an intermediate certification authority (CA) to issue smart card login or domain controller certificates, you must add the intermediate certificate to the Intermediate Certification Authorities group policy in Active Directory.

Add the Root Certificate to the Enterprise NTAuth Store

If you use a CA to issue smart card login or domain controller certificates, you must add the root certificate to the Enterprise NTAuth store in Active Directory. You do not need to perform this procedure if the Windows domain controller acts as the root CA.

Add UPNs for Smart Card Users

Because smart card logins rely on user principal names (UPNs), the Active Directory accounts of users and administrators that use smart cards to authenticate in Horizon 7 must have a valid UPN.

If the domain a smart card user resides in is different from the domain that your root certificate was issued from, you must set the user’s UPN to the Subject Alternative Name (SAN) contained in the root certificate of the trusted CA. If your root certificate was issued from a server in the smart card user’s current domain, you do not need to modify the user’s UPN.

**Note**  You might need to set the UPN for built-in Active Directory accounts, even if the certificate is issued from the same domain. Built-in accounts, including Administrator, do not have a UPN set by default.

**Prerequisites**

- Obtain the SAN contained in the root certificate of the trusted CA by viewing the certificate properties.
- If the ADSI Edit utility is not present on your Active Directory server, download and install the appropriate Windows Support Tools from the Microsoft Web site.

**Procedure**

1. On your Active Directory server, start the ADSI Edit utility.
2. In the left pane, expand the domain the user is located in and double-click CN=Users.
3. In the right pane, right-click the user and then click Properties.
4. Double-click the userPrincipalName attribute and type the SAN value of the trusted CA certificate.
5. Click OK to save the attribute setting.

Add the Root Certificate to Trusted Root Certification Authorities

If you use a certification authority (CA) to issue smart card login or domain controller certificates, you must add the root certificate to the Trusted Root Certification Authorities group policy in Active Directory. You do not need to perform this procedure if the Windows domain controller acts as the root CA.
Procedure

1  On the Active Directory server, navigate to the Group Policy Management plug-in.

<table>
<thead>
<tr>
<th>AD Version</th>
<th>Navigation Path</th>
</tr>
</thead>
</table>
| Windows 2003 | a  Select Start > All Programs > Administrative Tools > Active Directory Users and Computers.  
              | b  Right-click your domain and click Properties.                                   |
|              | c  On the Group Policy tab, click Open to open the Group Policy Management plug-in. |
|              | d  Right-click Default Domain Policy, and click Edit.                              |
| Windows 2008 | a  Select Start > Administrative Tools > Group Policy Management.                  |
| Windows 2012R2 | b  Expand your domain, right-click Default Domain Policy, and click Edit.          |
| Windows 2016 | a  Select Start > Administrative Tools > Group Policy Management.                  |
|              | b  Expand your domain, right-click Default Domain Policy, and click Edit.          |

2  Expand the Computer Configuration section and open Windows Settings\Security Settings\Public Key.

3  Right-click Trusted Root Certification Authorities and select Import.

4  Follow the prompts in the wizard to import the root certificate (for example, rootCA.cer) and click OK.

5  Close the Group Policy window.

All of the systems in the domain now have a copy of the root certificate in their trusted root store.

What to do next

If an intermediate certification authority (CA) issues your smart card login or domain controller certificates, add the intermediate certificate to the Intermediate Certification Authorities group policy in Active Directory. See Add an Intermediate Certificate to Intermediate Certification Authorities.

Add an Intermediate Certificate to Intermediate Certification Authorities

If you use an intermediate certification authority (CA) to issue smart card login or domain controller certificates, you must add the intermediate certificate to the Intermediate Certification Authorities group policy in Active Directory.
Procedure

1. On the Active Directory server, navigate to the Group Policy Management plug-in.

<table>
<thead>
<tr>
<th>AD Version</th>
<th>Navigation Path</th>
</tr>
</thead>
</table>
   |                      |     b. Right-click your domain and click Properties. 
   |                      |     c. On the Group Policy tab, click Open to open the Group Policy Management plug-in. 
   |                      |     d. Right-click Default Domain Policy, and click Edit. |
   |                      |     b. Expand your domain, right-click Default Domain Policy, and click Edit. |
   |                      |     b. Expand your domain, right-click Default Domain Policy, and click Edit. |
   |                      |     b. Expand your domain, right-click Default Domain Policy, and click Edit. |

2. Expand the Computer Configuration section and open the policy for Windows Settings\Security Settings\Public Key.

3. Right-click Intermediate Certification Authorities and select Import.

4. Follow the prompts in the wizard to import the intermediate certificate (for example, intermediateCA.cer) and click OK.

5. Close the Group Policy window.

All of the systems in the domain now have a copy of the intermediate certificate in their intermediate certification authority store.

Add the Root Certificate to the Enterprise NTAuth Store

If you use a CA to issue smart card login or domain controller certificates, you must add the root certificate to the Enterprise NTAuth store in Active Directory. You do not need to perform this procedure if the Windows domain controller acts as the root CA.

Procedure

- On your Active Directory server, use the certutil command to publish the certificate to the Enterprise NTAuth store.

  For example: `certutil -dspublish -f path_to_root_CA_cert NTAuthCA`

The CA is now trusted to issue certificates of this type.
Disable Weak Ciphers in SSL/TLS

To achieve greater security, you can configure the domain policy GPO (group policy object) to ensure that View Composer and Windows-based machines running View Agent or Horizon Agent do not use weak ciphers when they communicate using the SSL/TLS protocol.

Procedure

1. On the Active Directory server, edit the GPO by selecting Start > Administrative Tools > Group Policy Management, right-clicking the GPO, and selecting Edit.

2. In the Group Policy Management Editor, navigate to the Computer Configuration > Policies > Administrative Templates > Network > SSL Configuration Settings.

3. Double-click SSL Cipher Suite Order.

4. In the SSL Cipher Suite Order window, click Enabled.

5. In the Options pane, replace the entire content of the SSL Cipher Suites text box with the following cipher list:

   TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256_P256,
   TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA256_P384,
   TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA_P256,
   TLS_ECDHE_RSA_WITH_AES_128_CBC_SHA_P384,
   TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA_P256,
   TLS_ECDHE_RSA_WITH_AES_256_CBC_SHA_P384,
   TLS_RSA_WITH_AES_128_CBC_SHA256,
   TLS_RSA_WITH_AES_128_CBC_SHA,
   TLS_RSA_WITH_AES_256_CBC_SHA256,
   TLS_RSA_WITH_AES_256_CBC_SHA

   The cipher suites are listed above on separate lines for readability. When you paste the list into the text box, the cipher suites must be on one line with no spaces after the commas.

6. Exit the Group Policy Management Editor.

7. Restart the View Composer and View Agent or Horizon Agent machines for the new group policy to take effect.
Installing View Composer

To use View Composer, you create a View Composer database, install the View Composer service, and optimize your View infrastructure to support View Composer. You can install the View Composer service on the same host as vCenter Server or on a separate host.

View Composer is an optional feature. Install View Composer if you intend to deploy linked-clone desktop pools.

You must have a license to install and use the View Composer feature.

**Note** Before installing View Composer, verify that you have prepared Active Directory.

This chapter includes the following topics:

- Prepare a View Composer Database
- Configuring an SSL Certificate for View Composer
- Install the View Composer Service
- Enable TLSv1.0 on vCenter and ESXi Connections from View Composer
- Configuring Your Infrastructure for View Composer

**Prepare a View Composer Database**

You must create a database and data source name (DSN) to store View Composer data.

The View Composer service does not include a database. If a database instance does not exist in your network environment, you must install one. After you install a database instance, you add the View Composer database to the instance.

You can add the View Composer database to the instance on which the vCenter Server database is located. You can configure the database locally, or remotely, on a network-connected Linux, UNIX, or Windows Server computer.

The View Composer database stores information about connections and components that are used by View Composer:

- vCenter Server connections
- Active Directory connections
Linked-clone desktops that are deployed by View Composer

Replicas that are created by View Composer

Each instance of the View Composer service must have its own View Composer database. Multiple View Composer services cannot share a View Composer database.

For a list of supported database versions, see Database Requirements for View Composer and the Events Database.

To add a View Composer database to an installed database instance, choose one of these procedures.

- **Create a SQL Server Database for View Composer**
  View Composer can store linked-clone desktop information in a SQL Server database. You create a View Composer database by adding it to SQL Server and configuring an ODBC data source for it.

- **Create an Oracle Database for View Composer**
  View Composer can store linked-clone desktop information in an Oracle 12c or 11g database. You create a View Composer database by adding it to an existing Oracle instance and configuring an ODBC data source for it. You can add a new View Composer database by using the Oracle Database Configuration Assistant or by running a SQL statement.

**Create a SQL Server Database for View Composer**

View Composer can store linked-clone desktop information in a SQL Server database. You create a View Composer database by adding it to SQL Server and configuring an ODBC data source for it.

**Procedure**

1. **Add a View Composer Database to SQL Server**
   You can add a new View Composer database to an existing Microsoft SQL Server instance to store linked-clone data for View Composer.

2. **(Optional) Set SQL Server Database Permissions By Manually Creating Database Roles**
   By using this recommended method, the View Composer database administrator can set permissions for View Composer administrators to be granted through Microsoft SQL Server database roles.

3. **Add an ODBC Data Source to SQL Server**
   After you add a View Composer database to SQL Server, you must configure an ODBC connection to the new database to make this data source visible to the View Composer service.

**Add a View Composer Database to SQL Server**

You can add a new View Composer database to an existing Microsoft SQL Server instance to store linked-clone data for View Composer.

If the database resides locally, on the system on which View Composer will be installed, you can use the Integrated Windows Authentication security model. If the database resides on a remote system, you cannot use this method of authentication.
Prerequisites

- Verify that a supported version of SQL Server is installed on the computer on which you will install View Composer or in your network environment. For details, see Database Requirements for View Composer and the Events Database.

- Verify that you use SQL Server Management Studio to create and administer the database. Alternatively, you can use SQL Server Management Studio Express, which you can download and install from the following Web site.
  

Procedure


2. Select SQL Server Management Studio and connect to the SQL Server instance.

3. In the Object Explorer panel, right-click the Databases entry and select New Database.

   You can use the default values for the Initial size and Autogrowth parameters for the database and log files.

4. In the New Database dialog box, type a name in the Database name text box.

   For example: ViewComposer

5. Click OK.

   SQL Server Management Studio adds your database to the Databases entry in the Object Explorer panel.


What to do next

Optionally, follow the instructions in (Optional) Set SQL Server Database Permissions By Manually Creating Database Roles

Follow the instructions in Add an ODBC Data Source to SQL Server.

(Optional) Set SQL Server Database Permissions By Manually Creating Database Roles

By using this recommended method, the View Composer database administrator can set permissions for View Composer administrators to be granted through Microsoft SQL Server database roles.

VMware recommends this method because it removes the requirement to set up the db_owner role for View Composer administrators who install and upgrade View Composer.

In this procedure, you can provide your own names for the database login name, user name, and database roles. The user [vcmpuser] and database roles, VCMP_ADMIN_ROLE and VCMP_USER_ROLE, are example names. The dbo schema is created when you create the View Composer database. You must use the dbo schema name.
Prerequisites
- Verify that a View Composer database is created. See Add a View Composer Database to SQL
  Server.

Procedure
1. Log in to a Microsoft SQL Server Management Studio session as the sysadmin (SA) or a user account with sysadmin privileges.
2. Create a user who will be granted the appropriate SQL Server database permissions.

   ```
   use ViewComposer
   go
   CREATE LOGIN [vcmpuser] WITH PASSWORD=N'vcmpuser!0', DEFAULT_DATABASE=ViewComposer,
   DEFAULT_LANGUAGE=us_english, CHECK_POLICY=OFF
   go
   CREATE USER [vcmpuser] for LOGIN [vcmpuser]
   go
   use MSDB
   go
   CREATE USER [vcmpuser] for LOGIN [vcmpuser]
   go
   ```
3. In the View Composer database, create the database role VCMP_ADMIN_ROLE.
4. In the View Composer database, grant privileges to the VCMP_ADMIN_ROLE.
   a. Grant the schema permissions ALTER, REFERENCES, and INSERT on the dbo schema.
   b. Grant the permissions CREATE TABLE, CREATE VIEW, and CREATE PROCEDURES.
5. In the View Composer database, create the VCMP_USER_ROLE.
6. In the View Composer database, grant the schema permissions SELECT, INSERT, DELETE, UPDATE, and EXECUTE on the dbo schema to the VCMP_USER_ROLE.
7. Grant the VCMP_USER_ROLE to the user [vcmpuser].
8. Grant the VCMP_ADMIN_ROLE to the user [vcmpuser].
9. In the MSDB database, create the database role VCMP_ADMIN_ROLE.
10. Grant privileges to the VCMP_ADMIN_ROLE in MSDB.
   a. On the MSDB tables syscategories, sysjobsteps, and sysjobs, grant the SELECT permission to the user [vcmpuser].
   b. On the MSDB stored procedures sp_add_job, sp_delete_job, sp_add_jobstep, sp_update_job, sp_add_jobserver, sp_add_jobschedule, and sp_add_category, grant the EXECUTE permission to the role VCMP_ADMIN_ROLE.
11. In the MSDB database, grant the VCMP_ADMIN_ROLE to the user [vcmpuser].
12. Create the ODBC DSN using the SQL Server login vcmpuser.
13. Install View Composer.
14 In the MSDB database, revoke the `VCMP_ADMIN_ROLE` from the user `[vcmpuser]`.

After you revoke the role, you can leave the role as inactive or remove the role for increased security.

For instructions for creating an ODBC DSN, see Add an ODBC Data Source to SQL Server.

For instructions for installing View Composer, see Install the View Composer Service.

**Add an ODBC Data Source to SQL Server**

After you add a View Composer database to SQL Server, you must configure an ODBC connection to the new database to make this data source visible to the View Composer service.

When you configure an ODBC DSN for View Composer, secure the underlying database connection to an appropriate level for your environment. For information about securing database connections, see the SQL Server documentation.

If the underlying database connection uses SSL encryption, we recommend that you configure your database servers with SSL certificates signed by a trusted CA. If you use self-signed certificates, your database connections might be susceptible to man-in-the-middle attacks.

**Prerequisites**

Complete the steps described in Add a View Composer Database to SQL Server.

**Procedure**

1. On the computer on which View Composer will be installed, select **Start > Administrative Tools > Data Source (ODBC).**
2. Select the **System DSN** tab.
3. Click **Add** and select **SQL Native Client** from the list.
4. Click **Finish**.
5. In the **Create a New Data Source to SQL Server setup** wizard, type a name and description of the View Composer database.
   
   For example: **ViewComposer**

6. In the **Server** text box, type the SQL Server database name.
   
   Use the form `host_name\server_name`, where `host_name` is the name of the computer and `server_name` is the SQL Server instance.
   
   For example: `VCHOST1\VIM_SQLEXP`

7. Click **Next**.
8 Make sure that the **Connect to SQL Server to obtain default settings for the additional configuration options** check box is selected and select an authentication option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integrate Windows authentication</td>
<td>Select this option if you are using a local instance of SQL Server. This option is also known as trusted authentication. Integrate Windows authentication is supported only if SQL Server is running on the local computer.</td>
</tr>
<tr>
<td>SQL Server authentication</td>
<td>Select this option if you are using a remote instance of SQL Server. Windows NT authentication is not supported on remote SQL Server. If you manually set SQL Server database permissions and assigned them to a user, authenticate with that user. For example, authenticate with the user <code>vcmpuser</code>. If not, authenticate as the sysadmin (SA) or a user account with <code>sysadmin</code> privileges.</td>
</tr>
</tbody>
</table>

9 Click **Next**.

10 Select the **Change the default database to** check box and select the name of the View Composer database from the list.

For example: **ViewComposer**

11 If the SQL Server connection is configured with SSL enabled, navigate to the Microsoft SQL Server DSN Configuration page and select **Use strong encryption for data**.

12 Finish and close the **Microsoft ODBC Data Source Administrator** wizard.

What to do next

Install the new View Composer service. See **Install the View Composer Service**.

Create an Oracle Database for View Composer

View Composer can store linked-clone desktop information in an Oracle 12c or 11g database. You create a View Composer database by adding it to an existing Oracle instance and configuring an ODBC data source for it. You can add a new View Composer database by using the Oracle Database Configuration Assistant or by running a SQL statement.

- **Add a View Composer Database to Oracle 12c or 11g**
  
  You can use the Oracle Database Configuration Assistant to add a new View Composer database to an existing Oracle 12c or 11g instance.

- **Use a SQL Statement to Add a View Composer Database to an Oracle Instance**

- **Configure an Oracle Database User for View Composer**
  
  By default, the database user that runs the View Composer database has Oracle system administrator permissions. To restrict the security permissions for the user that runs the View Composer database, you must configure an Oracle database user with specific permissions.
Add an ODBC Data Source to Oracle 12c or 11g

After you add a View Composer database to an Oracle 12c or 11g instance, you must configure an ODBC connection to the new database to make this data source visible to the View Composer service.

Add a View Composer Database to Oracle 12c or 11g

You can use the Oracle Database Configuration Assistant to add a new View Composer database to an existing Oracle 12c or 11g instance.

Prerequisites

Verify that a supported version of Oracle 12c or 11g is installed on the local or remote computer. See Database Requirements for View Composer and the Events Database.

Procedure

1. Start the Database Configuration Assistant on the computer on which you are adding the View Composer database.

<table>
<thead>
<tr>
<th>Database Version</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle 12c</td>
<td>Select Start &gt; All Programs &gt; Oracle-OraDb12c_home &gt; Configuration and Migration Tools &gt; Database Configuration Assistant.</td>
</tr>
<tr>
<td>Oracle 11g</td>
<td>Select Start &gt; All Programs &gt; Oracle-OraDb11g_home &gt; Configuration and Migration Tools &gt; Database Configuration Assistant.</td>
</tr>
</tbody>
</table>

2. On the Operations page, select Create a database.

3. On the Database Templates page, select the General Purpose or Transaction Processing template.

4. On the Database Identification page, type a Global Database Name and an Oracle System Identifier (SID) prefix.
   
   For simplicity, use the same value for both items.

5. On the Management Options page, click Next to accept the default settings.

6. On the Database Credentials page, select Use the Same Administrative Passwords for All Accounts and type a password.

7. On the remaining configuration pages, click Next to accept the default settings.

8. On the Creation Options page, verify that Create Database is selected and click Finish.

9. On the Confirmation page, review the options and click Finish.

   The configuration tool creates the database.

10. On the Database Creation Complete page, click OK.

What to do next

Follow the instructions in Add an ODBC Data Source to Oracle 12c or 11g.
Use a SQL Statement to Add a View Composer Database to an Oracle Instance

When you create the database, you can customize the location of the data and log files.

Prerequisites

The View Composer database must have certain table spaces and privileges. You can use a SQL statement to create the View Composer database in an Oracle 12c or 11g database instance.

Verify that a supported version of Oracle 12c or 11g is installed on the local or remote computer. For details, see Database Requirements for View Composer and the Events Database.

Procedure

1. Log in to a SQL*Plus session with the system account.
2. Run the following SQL statement to create the database.

```sql
CREATE SMALLFILE TABLESPACE "VCMP" DATAFILE '/u01/app/oracle/oradata/vcdb/vcmp01.dbf' SIZE 512M AUTOEXTEND ON NEXT 10M MAXSIZE UNLIMITED LOGGING EXTENT MANAGEMENT LOCAL SEGMENT SPACE MANAGEMENT AUTO;
```

In this example, VCMP is the sample name of the View Composer database and vcmp01.dbf is the name of the database file.

For a Windows installation, use Windows conventions in the directory path to the vcmp01.dbf file.

What to do next

If you want to run the View Composer database with specific security permissions, follow the instructions in Configure an Oracle Database User for View Composer.

Follow the instructions in Add an ODBC Data Source to Oracle 12c or 11g

Configure an Oracle Database User for View Composer

By default, the database user that runs the View Composer database has Oracle system administrator permissions. To restrict the security permissions for the user that runs the View Composer database, you must configure an Oracle database user with specific permissions.

Prerequisites

Verify that a View Composer database was created in an Oracle 12c or 11g instance.

Procedure

1. Log in to a SQL*Plus session with the system account.
2 Run the following SQL command to create a View Composer database user with the correct permissions.

```
CREATE USER "VCMPADMIN" PROFILE "DEFAULT" IDENTIFIED BY "oracle"
DEFAULT TABLESPACE "VCMP"
ACCOUNT UNLOCK;

grant connect to VCMPADMIN;
grant resource to VCMPADMIN;
grant create view to VCMPADMIN;
grant create sequence to VCMPADMIN;
grant create table to VCMPADMIN;
grant create materialized view to VCMPADMIN;
grant execute on dbms_lock to VCMPADMIN;
grant execute on dbms_job to VCMPADMIN;
grant unlimited tablespace to VCMPADMIN;
```

In this example, the user name is VCMPADMIN and the View Composer database name is VCMP.

By default the resource role has the create procedure, create table, and create sequence privileges assigned. If the resource role does not have these privileges, explicitly grant them to the View Composer database user.

**Add an ODBC Data Source to Oracle 12c or 11g**

After you add a View Composer database to an Oracle 12c or 11g instance, you must configure an ODBC connection to the new database to make this data source visible to the View Composer service.

When you configure an ODBC DSN for View Composer, secure the underlying database connection to an appropriate level for your environment. For information about securing database connections, see the Oracle database documentation.

If the underlying database connection uses SSL encryption, we recommend that you configure your database servers with SSL certificates signed by a trusted CA. If you use self-signed certificates, your database connections might be susceptible to man-in-the-middle attacks.

**Prerequisites**

Verify that you completed the steps described in Add a View Composer Database to Oracle 12c or 11g or Use a SQL Statement to Add a View Composer Database to an Oracle Instance.

**Procedure**

1. On the View Composer database computer, select **Start > Administrative Tools > Data Source (ODBC)**.
2. From the **Microsoft ODBC Data Source Administrator** wizard, select the **System DSN** tab.
3. Click **Add** and select the appropriate Oracle driver from the list.
   For example: **Oracle11g_home**
4. Click **Finish**.
5 In the Oracle ODBC Driver Configuration dialog box, type a DSN to use with View Composer, a description of the data source, and a user ID to connect to the database.

If you configured an Oracle database user ID with specific security permissions, specify this user ID.

**Note** You use the DSN when you install the View Composer service.

6 Specify a **TNS Service Name** by selecting the Global Database Name from the drop-down menu.

The Oracle Database Configuration Assistant specifies the Global Database Name.

7 To verify the data source, click **Test Connection** and click **OK**.

**What to do next**

Install the new View Composer service. See Install the View Composer Service.

---

### Configuring an SSL Certificate for View Composer

By default, a self-signed certificate is installed with View Composer. You can use the default certificate for testing purposes, but for production use you should replace it with a certificate that is signed by a Certificate Authority (CA).

You can configure a certificate before or after you install View Composer. In View 5.1 and later releases, you configure a certificate by importing it into the Windows local computer certificate store on the Windows Server computer where View Composer is, or will be, installed.

- If you import a CA-signed certificate before you install View Composer, you can select the signed certificate during the View Composer installation. This approach eliminates the manual task of replacing the default certificate after the installation.

- If you intend to replace an existing certificate or the default, self-signed certificate with a new certificate after you install View Composer, you must import the new certificate and run the `SviConfig ReplaceCertificate` utility to bind your new certificate to the port used by View Composer.

For details about configuring SSL certificates and using the `SviConfig ReplaceCertificate` utility, see Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

If you install vCenter Server and View Composer on the same Windows Server computer, they can use the same SSL certificate, but you must configure the certificate separately for each component.

### Install the View Composer Service

To use View Composer, you must install the View Composer service. Horizon 7 uses View Composer to create and deploy linked-clone desktops in vCenter Server.

You can install the View Composer service on the Windows Server computer on which vCenter Server is installed or on a separate Windows Server computer. A standalone View Composer installation works with vCenter Server installed on a Windows Server computer and with the Linux-based vCenter Server Appliance.
The View Composer software cannot coexist on the same virtual or physical machine with any other Horizon 7 software component, including a replica server, security server, Connection Server, Horizon Agent, or Horizon Client.

For enhanced security, we recommend configuring cipher suites to remove known vulnerabilities. For instructions on how to set up a domain policy on cipher suites for Windows machines that run View Composer or Horizon Agent, see Disable Weak Ciphers in SSL/TLS.

**Prerequisites**

- Verify that your installation satisfies the View Composer requirements described in View Composer Requirements.
- Verify that no other Horizon 7 component, including Connection Server, security server, Horizon Agent, or Horizon Client, is installed on the machine on which you intend to install View Composer.
- Verify that you have a license to install and use View Composer.
- Verify that you have the DSN, domain administrator user name, and password that you provided in the ODBC Data Source Administrator wizard. You enter this information when you install the View Composer service.
- If you plan to configure an SSL certificate signed by a CA for View Composer during the installation, verify that your certificate is imported in the Windows local computer certificate store. See Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.
- Verify that no applications that run on the View Composer computer use Windows SSL libraries that require SSL version 2 (SSLv2) provided through the Microsoft Secure Channel (Schannel) security package. The View Composer installer disables SSLv2 on the Microsoft Schannel. Applications such as Tomcat, which uses Java SSL, or Apache, which uses OpenSSL, are not affected by this constraint.
- To run the View Composer installer, you must be a user with administrator privileges on the system.

**Procedure**


   The installer filename is VMware-viewcomposer-\*\*\*\*\*.\*\*\*, where \*\*\*\*\* is the build number and \*\*\*\*\* is the version number. This installer file installs the View Composer service on 64-bit Windows Server operating systems.

2. To start the View Composer installation program, right-click the installer file and select Run as administrator.

3. Accept the VMware license terms.

4. Accept or change the destination folder.
5 Type the DSN for the View Composer database that you provided in the Microsoft or Oracle ODBC Data Source Administrator wizard.

For example: VMware View Composer

**Note** If you did not configure a DSN for the View Composer database, click ODBC DSN Setup to configure a name now.

6 Type the domain administrator user name and password that you provided in the ODBC Data Source Administrator wizard.

If you configured an Oracle database user with specific security permissions, specify this user name.

7 Type a port number or accept the default value.

View Connection Server uses this port to communicate with the View Composer service.

8 Provide an SSL certificate.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create default SSL certificate</td>
<td>Select this radio button to create a default SSL certificate for the View Composer service. After the installation, you can replace the default certificate with an SSL certificate signed by a CA.</td>
</tr>
<tr>
<td>Use an existing SSL certificate</td>
<td>Select this radio button if you installed a signed SSL certificate that you want to use for the View Composer service. Select an SSL certificate from the list.</td>
</tr>
</tbody>
</table>

9 Click Install and Finish to complete the View Composer service installation.

The VMware Horizon View Composer service starts.

View Composer uses the cryptographic cipher suites that are provided by the Windows Server operating system. You should follow your organization's guidelines for managing cipher suites on Windows Server systems. If your organization does not provide guidelines, VMware recommends that you disable weak cryptographic cipher suites on the View Composer server to enhance the security of your Horizon 7 environment. For information about managing cryptographic cipher suites, see your Microsoft documentation.

**What to do next**

If you have an older version of vCenter Server, see Enable TLSv1.0 on vCenter and ESXi Connections from View Composer.

If you manually set SQL Server database permissions and assigned them to a user, you can revoke the database administrator role from that user. For details, see the last step in the procedure in (Optional) Set SQL Server Database Permissions By Manually Creating Database Roles.
Enable TLSv1.0 on vCenter and ESXi Connections from View Composer

Horizon 7 and later components have the TLSv1.0 security protocol disabled by default. If your deployment includes an older version of vCenter Server that supports only TLSv1.0, you might need to enable TLSv1.0 for View Composer connections after installing or upgrading to View Composer 7.0 or a later release.

Some earlier maintenance releases of vCenter Server 5.0, 5.1, and 5.5 support only TLSv1.0, which is no longer enabled by default in Horizon 7 and later releases. If it is not possible to upgrade vCenter Server to a version that supports TLSv1.1 or TLSv1.2, you can enable TLSv1.0 for View Composer connections.

If your ESXi hosts are not running ESXi 6.0 U1b or later, and you cannot upgrade, you might also need to enable TLSv1.0 connections to ESXi hosts from View Composer.

Prerequisites

- Verify that you have View Composer 7.0 or a later release installed.
- Verify that you can log in to the View Composer machine as an Administrator to use the Windows Registry Editor.

Procedure

1. On the machine that hosts View Composer, open the Windows Registry Editor (regedit.exe).
2. Navigate to `HKLM\System\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS 1.0\Client`.
   
   If this key does not already exist, create this key.
3. Delete the value `Enabled` if it exists.
4. Create or edit the DWORD value `DisabledByDefault` and set it to 0.
5. Restart the VMware Horizon View Composer service.
   
   TLSv1.0 connections from View Composer to vCenter are now enabled.
6. In the Windows Registry on the View Composer machine, navigate to `HKLM\SOFTWARE\VMware, Inc.\VMware View Composer`.
7. Create or edit the String value `EnableTLS1.0` and set it to 1.
8. If the View Composer host is a 64-bit machine, navigate to `HKLM\SOFTWARE\Wow6432Node\VMware, Inc\VMware View Composer`.
9. Create or edit the String value `EnableTLS1.0` and set it to 1.
10. Restart the VMware Horizon View Composer service.

   TLSv1.0 connections from View Composer to ESXi hosts are now enabled.
Configuring Your Infrastructure for View Composer

You can take advantage of features in vSphere, vCenter Server, Active Directory, and other components of your infrastructure to optimize the performance, availability, and reliability of View Composer.

Configuring the vSphere Environment for View Composer

To support View Composer, you should follow certain best practices when you install and configure vCenter Server, ESXi, and other vSphere components.

These best practices let View Composer work efficiently in the vSphere environment.

- After you create the path and folder information for linked-clone virtual machines, do not change the information in vCenter Server. Instead, use Horizon Administrator to change the folder information. If you change this information in vCenter Server, Horizon 7 cannot successfully look up the virtual machines in vCenter Server.
- Make sure that the vSwitch settings on the ESXi host are configured with enough ports to support the total number of virtual NICs that are configured on the linked-clone virtual machines that run on the ESXi host.
- When you deploy linked-clone desktops in a resource pool, make sure that your vSphere environment has enough CPU and memory to host the number of desktops that you require. Use vSphere Client to monitor CPU and memory usage in resource pools.
- In vSphere 5.1 and later, a cluster that is used for View Composer linked clones can contain more than eight ESXi hosts if the replica disks are stored on VMFS5 or later datastores or NFS datastores. If you store replicas on a VMFS version earlier than VMFS5, a cluster can have at most eight hosts.
- Use vSphere DRS. DRS efficiently distributes linked-clone virtual machines among your hosts.

Note: Storage vMotion is not supported for linked-clone desktops.

Additional Best Practices for View Composer

To make sure that View Composer works efficiently, check that your dynamic name service (DNS) operates correctly, and run antivirus software scans at staggered times.

By making sure that DNS resolution operates correctly, you can overcome intermittent issues caused by DNS errors. The View Composer service relies on dynamic name resolution to communicate with other computers. To test DNS operation, ping the Active Directory and View Connection Server computers by name.

If you stagger the run times for your antivirus software, performance of the linked-clone desktops is not affected. If the antivirus software runs in all linked clones at the same time, excessive I/O operations per second (IOPS) occur in your storage subsystem. This excessive activity can affect performance of the linked-clone desktops.
Installing Horizon Connection Server

To use Connection Server, you install the software on supported computers, configure the required components, and, optionally, optimize the components.

This chapter includes the following topics:

- Installing the Horizon Connection Server Software
- Installation Prerequisites for Horizon Connection Server
- Install Horizon Connection Server with a New Configuration
- Install a Replicated Instance of Horizon Connection Server
- Configure a Security Server Pairing Password
- Install a Security Server
- Unified Access Gateway Appliance Advantages over VPN
- Firewall Rules for Horizon Connection Server
- Reinstall Horizon Connection Server with a Backup Configuration
- Microsoft Windows Installer Command-Line Options
- Uninstalling Horizon 7 Components Silently by Using MSI Command-Line Options

Installing the Horizon Connection Server Software

Depending on the performance, availability, and security needs of your Horizon 7 deployment, you can install a single instance of Connection Server, replicated instances of Connection Server, and security servers. You must install at least one instance of Connection Server.

When you install Connection Server, you select a type of installation.

**Standard installation**  Generates a Connection Server instance with a new View LDAP configuration.

**Replica installation**  Generates a Connection Server instance with a View LDAP configuration that is copied from an existing instance.
Security server installation
Generates a Connection Server instance that adds an additional layer of security between the Internet and your internal network.

Enrollment Server installation
Installs an enrollment server that is required for the True SSO (single sign-on) feature, so that after users log in to VMware Identity Manager, they can connect to a remote desktop or application without having to provide Active Directory credentials. The enrollment server requests the short-lived certificates that are used for authentication.

Note Because this feature requires that a certificate authority also be set up, and specific configuration performed, the installation procedure for the enrollment server is provided in the Horizon 7 Administration document, in the chapter "Authenticating Users Without Requiring Credentials," rather than in this installation document.

Installation Prerequisites for Horizon Connection Server
Before you install Connection Server, you must verify that your installation environment satisfies specific prerequisites.

- You must have a valid license key for Horizon 7.
- You must join the Connection Server host to an Active Directory domain. Connection Server supports the following Active Directory Domain Services (AD DS) domain functional levels:
  - Windows Server 2008
  - Windows Server 2008 R2
  - Windows Server 2012
  - Windows Server 2012 R2
  - Windows Server 2016
The Connection Server host must not be a domain controller.

Note Connection Server does not make, nor does it require, any schema or configuration updates to Active Directory.

- Do not install Connection Server on systems that have the Windows Terminal Server role installed. You must remove the Windows Terminal Server role from any system on which you install Connection Server.
- Do not install Connection Server on a system that performs any other functions or roles. For example, do not use the same system to host vCenter Server.
- The system on which you install Connection Server must have an IP address that does not change. In an IPv4 environment, configure a static IP address. In an IPv6 environment, machines automatically get IP addresses that do not change.
To run the Horizon Connection Server installer, you must use a domain user account with Administrator privileges on the system.

When you install Connection Server, you authorize an Administrators account. You can specify the local Administrators group or a domain user or group account. Horizon 7 assigns full administration rights, including the right to install replicated Connection Server instances, to this account only. If you specify a domain user or group, you must create the account in Active Directory before you run the installer.

Install Horizon Connection Server with a New Configuration

To install Connection Server as a single server or as the first instance in a group of replicated Connection Server instances, you use the standard installation option.

When you select the standard installation option, the installation creates a new, local View LDAP configuration. The installation loads the schema definitions, Directory Information Tree (DIT) definition, and ACLs and initializes the data.

After installation, you manage most View LDAP configuration data by using Horizon Administrator. Connection Server automatically maintains some View LDAP entries.

The Connection Server software cannot coexist on the same virtual or physical machine with any other Horizon 7 software component, including a replica server, security server, View Composer, Horizon Agent, or Horizon Client.

When you install Connection Server with a new configuration, you can participate in a customer experience improvement program. VMware collects anonymous data about your deployment in order to improve VMware's response to user requirements. No data that identifies your organization is collected. You can choose not to participate by deselecting this option during the installation. If you change your mind about participating after the installation, you can either join or withdraw from the program by editing the Product Licensing and Usage page in Horizon Administrator. To review the list of fields from which data is collected, including the fields that are made anonymous, see "Information Collected by the Customer Experience Improvement Program" in the Horizon 7 Administration document.

By default, the HTML Access component is installed on the Connection Server host when you install Connection Server. This component configures the Horizon 7 user portal page to display an HTML Access icon in addition to the Horizon Client icon. The additional icon allows users to select HTML Access when they connect to their desktops.

For an overview of setting up Connection Server for HTML Access, see the VMware Horizon HTML Access Installation and Setup Guide document, located on the Horizon Client Documentation page.

Prerequisites

- Verify that you can log in as a domain user with administrator privileges on the Windows Server computer on which you install Connection Server.

- Verify that your installation satisfies the requirements described in Horizon Connection Server Requirements.
- Prepare your environment for the installation. See Installation Prerequisites for Horizon Connection Server.
- If you intend to authorize a domain user or group as the Administrators account, verify that you created the domain account in Active Directory.
- Prepare a data recovery password. When you back up Connection Server, the View LDAP configuration is exported as encrypted LDIF data. To restore the encrypted backup Horizon 7 configuration, you must provide the data recovery password. The password must contain between 1 and 128 characters. Follow your organization's best practices for generating secure passwords.

  **Important** You will need the data recovery password to keep Horizon 7 operating and avoid downtime in a Business Continuity and Disaster Recovery (BCDR) scenario. You can provide a password reminder with the password when you install Connection Server.

- Familiarize yourself with the network ports that must be opened on the Windows Firewall for Connection Server instances. See Firewall Rules for Horizon Connection Server.
- If you plan to pair a security server with this Connection Server instance, verify that Windows Firewall with Advanced Security is set to **on** in the active profiles. It is recommended that you turn this setting to **on** for all profiles. By default, IPsec rules govern connections between security server and Connection Server and require Windows Firewall with Advanced Security to be enabled.
- If your network topology includes a back-end firewall between a security server and the Connection Server instance, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

**Procedure**


   Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.

   The installer filename is `VMware-viewconnectionserver-x86_64-y.y.y-xxxxxx.exe`, where `xxxxxx` is the build number and `y.y.y` is the version number.

2. To start the Connection Server installation program, double-click the installer file.

3. Accept the VMware license terms.

4. Accept or change the destination folder.

5. Select the **View Standard Server** installation option.

6. Select the Internet Protocol (IP) version, **IPv4** or **IPv6**.

   You must install all Horizon 7 components with the same IP version.

7. Select whether to enable or disable FIPS mode.

   This option is available only if FIPS mode is enabled in Windows.
8 Make sure that Install HTML Access is selected if you intend to allow users to connect to their desktops by using a Web browser.

If IPv4 is selected, this setting is selected by default. If IPv6 is selected, this setting is not displayed because HTML Access is not supported in an IPv6 environment.

9 Type a data recovery password and, optionally, a password reminder.

10 Choose how to configure the Windows Firewall service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Windows Firewall automatically</td>
<td>Let the installer configure Windows Firewall to allow the required network connections.</td>
</tr>
<tr>
<td>Do not configure Windows Firewall</td>
<td>Configure the Windows firewall rules manually. Select this option only if your organization uses its own predefined rules for configuring Windows Firewall.</td>
</tr>
</tbody>
</table>

11 Authorize a Horizon Administrators account.

Only members of this account can log in to Horizon Administrator, exercise full administration rights, and install replicated Connection Server instances and other Horizon 7 servers.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorize the local Administrators group</td>
<td>Allows users in the local Administrators group to administer Horizon 7.</td>
</tr>
<tr>
<td>Authorize a specific domain user or domain group</td>
<td>Allows the specified domain user or group to administer Horizon 7.</td>
</tr>
</tbody>
</table>

12 If you specified a domain Horizon Administrators account, and you are running the installer as a local administrator or another user without access to the domain account, provide credentials to log in to the domain with an authorized user name and password.

Use domain name\user name or user principal name (UPN) format. UPN format can be user@domain.com.

13 Choose whether to participate in the customer experience improvement program.

If you participate, you can optionally select the type, size, and location of your organization.

14 Complete the installation wizard to finish installing Connection Server.

15 Check for new patches on the Windows Server computer and run Windows Update as needed.

Even if you fully patched the Windows Server computer before you installed Connection Server, the installation might have enabled operating system features for the first time. Additional patches might now be required.

The Horizon 7 services are installed on the Windows Server computer:

- VMware Horizon Connection Server
- VMware Horizon View Framework Component
VMware Horizon View Message Bus Component
VMware Horizon View Security Gateway Component
VMware Horizon View Blast Secure Gateway
VMware Horizon View Web Component
VMware VDMDS, which provides View LDAP directory services

For information about these services, see the *Horizon 7 Administration* document.

If the **Install HTML Access** setting was selected during the installation, the HTML Access component is installed on the Windows Server computer. This component configures the HTML Access icon in the Horizon 7 user portal page and enables the **VMware Horizon View Connection Server (Blast-In)** rule in the Windows Firewall. This firewall rule allows Web browsers on client devices to connect to the Connection Server on TCP port 8443.

**What to do next**

Configure SSL server certificates for Connection Server. See Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

If you have an older version of vCenter Server, see Enable TLSv1.0 on vCenter Connections from Connection Server.

Perform initial configuration on Connection Server. See Chapter 10 Configuring Horizon 7 for the First Time.

If you plan to include replicated Connection Server instances and security servers in your deployment, you must install each server instance by running the Connection Server installer file.

If you are reinstalling Connection Server and you have a data collector set configured to monitor performance data, stop the data collector set and start it again.

**Install Horizon Connection Server Silently**

You can use the silent installation feature of the Microsoft Windows Installer (MSI) to perform a standard installation of Connection Server on several Windows computers. In a silent installation, you use the command line and do not have to respond to wizard prompts.

With silent installation, you can efficiently deploy Horizon 7 components in a large enterprise.

**Prerequisites**

- Verify that you can log in as a domain user with administrator privileges on the Windows Server computer on which you install Connection Server.
- Verify that your installation satisfies the requirements described in Horizon Connection Server Requirements.
- Prepare your environment for the installation. See Installation Prerequisites for Horizon Connection Server.

- If you intend to authorize a domain user or group as the Horizon Administrators account, verify that you created the domain account in Active Directory.

- If you use MIT Kerberos authentication to log in to a Windows Server 2008 R2 computer on which you are installing Connection Server, install the Microsoft hotfix that is described in KB 978116 at http://support.microsoft.com/kb/978116.

- Familiarize yourself with the network ports that must be opened on the Windows Firewall for Connection Server instances. See Firewall Rules for Horizon Connection Server.

- If you plan to pair a security server with this Connection Server instance, verify that Windows Firewall with Advanced Security is set to on in the active profiles. It is recommended that you turn this setting to on for all profiles. By default, IPsec rules govern connections between security server and Connection Server and require Windows Firewall with Advanced Security to be enabled.

- If your network topology includes a back-end firewall between a security server and the Connection Server instance, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

- Verify that the Windows computer on which you install Connection Server has version 2.0 or later of the MSI runtime engine. For details, see the Microsoft Web site.

- Familiarize yourself with the MSI installer command-line options. See Microsoft Windows Installer Command-Line Options.

- Familiarize yourself with the silent installation properties available with a standard installation of Connection Server. See Silent Installation Properties for a Horizon Connection Server Standard Installation.

Procedure


   Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.

   The installer filename is VMware-viewconnectionserver-x86_64-y.y.y-xxxxxx.exe, where xxxxxx is the build number and y.y.y is the version number.

2. Open a command prompt on the Windows Server computer.
3  Type the installation command on one line.

For example: VMware-viewconnectionserver-y.y-xxxxx.exe /s /v"/qn
VDM_SERVER_INSTANCE_TYPE=1 VDM_INITIAL_ADMIN_SID=S-1-5-32-544
VDM_SERVER_RECOVERY_PWD=mini VDM_SERVER_RECOVERY_PWD_REMINDER=""First car"

**Important** When you perform a silent installation, the full command line, including the data recovery password, is logged in the installer's vminst.log file. After the installation is complete, either delete this log file or change the data recovery password by using Horizon Administrator.

4  Check for new patches on the Windows Server computer and run Windows Update as needed.

Even if you fully patched the Windows Server computer before you installed Connection Server, the installation might have enabled operating system features for the first time. Additional patches might now be required.

The Horizon 7 services are installed on the Windows Server computer:

- VMware Horizon Connection Server
- VMware Horizon View Framework Component
- VMware Horizon View Message Bus Component
- VMware Horizon View Script Host
- VMware Horizon View Security Gateway Component
- VMware Horizon View PCoIP Secure Gateway
- VMware Horizon View Blast Secure Gateway
- VMware Horizon View Web Component
- VMware VDMDS, which provides View LDAP directory services

If the **Install HTML Access** setting was selected during the installation, the HTML Access component is installed on the Windows Server computer. This component configures the HTML Access icon in the Horizon 7 user portal page and enables the **VMware Horizon View Connection Server (Blast-In)** rule in the Windows Firewall. This firewall rule allows Web browsers on client devices to connect to the Connection Server on TCP port 8443.

For information about these services, see the *Horizon 7 Administration* document.

**What to do next**

Configure SSL server certificates for Connection Server. See Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

If you have an older version of vCenter Server, see Enable TLSv1.0 on vCenter Connections from Connection Server.

If you are configuring Horizon 7 for the first time, perform initial configuration on Connection Server. See Chapter 10 Configuring Horizon 7 for the First Time.
Silent Installation Properties for a Horizon Connection Server Standard Installation

You can include specific Connection Server properties when you perform a silent installation from the command line. You must use a $PROPERTY=value$ format so that Microsoft Windows Installer (MSI) can interpret the properties and values.

Table 7-1. MSI Properties for Silently Installing Connection Server in a Standard Installation

<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR</td>
<td>The path and folder in which the Connection Server software is installed.</td>
<td>%ProgramFiles%\VMware\VMware View\Server</td>
</tr>
<tr>
<td></td>
<td>For example: INSTALLDIR=&quot;D:\abc\my folder&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sets of two double quotes that enclose the path permit the MSI installer to interpret the space as a valid part of the path.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_INSTANCE_TYPE</td>
<td>The type of Horizon server installation:</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1. Standard installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Replica installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Security server installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5. Enrollment server installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example, to perform a standard installation, define</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VDM_SERVER_INSTANCE_TYPE=1</td>
<td></td>
</tr>
<tr>
<td>FWCHOICE</td>
<td>The MSI property that determines whether to configure a firewall for the Connection Server instance.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A value of 1 configures a firewall. A value of 2 does not configure a firewall.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: FWCHOICE=1</td>
<td></td>
</tr>
<tr>
<td>VDM_INITIAL_ADMIN_SID</td>
<td>The SID of the initial Horizon Administrators user or group that is authorized with full administration rights in Horizon.</td>
<td>5–1–5–32–544</td>
</tr>
<tr>
<td></td>
<td>The default value is the SID of the local Administrators group on the Connection Server computer. You can specify a SID of a domain user or group account.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_RECOVERY_PWD</td>
<td>The data recovery password. If a data recovery password is not set in Horizon LDAP, this property is mandatory.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>The password must contain between 1 and 128 characters. Follow your organization's best practices for generating secure passwords.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_RECOVERY_PWD_REMINDER</td>
<td>The data recovery password reminder. This property is optional.</td>
<td>None</td>
</tr>
<tr>
<td>VDM_IP_PROTOCOL_USAGE</td>
<td>Specifies the IP version that Horizon components use for communication. The possible values are IPv4 and IPv6.</td>
<td>IPv4</td>
</tr>
</tbody>
</table>
Table 7-1. MSI Properties for Silently Installing Connection Server in a Standard Installation (Continued)

<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDM_FIPS_ENABLED</td>
<td>Specifies whether to enable or disable FIPS mode. A value of 1 enables FIPS mode. A value of 0 disables FIPS mode. If this property is set to 1 and Windows is not in FIPS mode, the installer will abort.</td>
<td>0</td>
</tr>
<tr>
<td>HTMLACCESS</td>
<td>Controls the HTML Access add-on installation. Set this property to 1 to configure HTML Access or omit the property if HTML Access is not needed.</td>
<td>1</td>
</tr>
</tbody>
</table>

Enable TLSv1.0 on vCenter Connections from Connection Server

Horizon 7 and later components have the TLSv1.0 security protocol disabled by default. If your deployment includes an older version of vCenter Server that supports only TLSv1.0, you might need to enable TLSv1.0 for Connection Server connections after installing or upgrading to Connection Server 7.0 or a later release.

Some earlier maintenance releases of vCenter Server 5.1, and 5.5 support only TLSv1.0, which is no longer enabled by default in Horizon 7 and later releases. If it is not possible to upgrade vCenter Server to a version that supports TLSv1.1 or TLSv1.2, you can enable TLSv1.0 for Connection Server connections.

Prerequisites

- If you are upgrading to Horizon 7, perform this procedure before you upgrade to minimize the number of times you must restart the service. During an upgrade the Connection Server service is restarted, and a restart is required to apply the configuration changes described in this procedure. If you upgrade before you perform this procedure, you will need to restart the service a second time.
- See the Microsoft TechNet Web site for information on how to use the ADSI Edit utility on your Windows operating system version.

Procedure

1. Start the ADSI Edit utility on your Connection Server host.
2. In the console tree, select Connect to.
3. In the Select or type a Distinguished Name or Naming Context text box, type the distinguished name DC=vdi, DC=vmware, DC=int.
4. In the Computer pane, select or type localhost:389 or the fully qualified domain name (FQDN) of the Connection Server host followed by port 389.
   For example: localhost:389 or mycomputer.example.com:389
5. Expand the ADSI Edit tree, expand OU=Properties, select OU=Global, and double-click CN=Common in the right pane.
6 In the Properties dialog box, edit the `paeclientSSLSecureProtocols` attribute to add the following value:

```
\LIST:TLSv1.2,TLSv1.1,TLSv1
```

Be sure to include the back slash at the beginning of the line.

7 Click **OK**.

8 If this is a fresh installation, to apply the configuration change, restart the Connection Server service on each connection server instance.

   If you plan to perform an upgrade, you do not need to restart the service because the process of upgrading automatically restarts the service.

### Install a Replicated Instance of Horizon Connection Server

To provide high availability and load balancing, you can install one or more additional instances of Connection Server that replicate an existing Connection Server instance. After a replica installation, the existing and newly installed instances of Connection Server are identical.

When you install a replicated instance, Horizon 7 copies the View LDAP configuration data from the existing Connection Server instance.

After the installation, identical View LDAP configuration data is maintained on all Connection Server instances in the replicated group. When a change is made on one instance, the updated information is copied to the other instances.

If a replicated instance fails, the other instances in the group continue to operate. When the failed instance resumes activity, its configuration is updated with the changes that took place during the outage.

**Note** Replication functionality is provided by View LDAP, which uses the same replication technology as Active Directory.

The replica server software cannot coexist on the same virtual or physical machine with any other Horizon 7 software component, including a security server, Connection Server, View Composer, Horizon Agent, or Horizon Client.

By default, the HTML Access component is installed on the Connection Server host when you install Connection Server. This component configures the Horizon 7 user portal page to display an HTML Access icon in addition to the Horizon Client icon. The additional icon allows users to select HTML Access when they connect to their desktops.

For an overview of setting up Connection Server for HTML Access, see the [VMware Horizon HTML Access Installation and Setup Guide](#) document, located on the Horizon Client Documentation page.

### Prerequisites

- Verify that at least one Connection Server instance is installed and configured on the network.
To install the replicated instance, you must log in as a user with the Administrators role. You specify the account or group with the Administrators role when you install the first instance of Connection Server. The role can be assigned to the local Administrators group or a domain user or group. See Install Horizon Connection Server with a New Configuration.

If the existing Connection Server instance is in a different domain than the replicated instance, the domain user must also have Administrator privileges on the Windows Server computer where the existing instance is installed.

If you use MIT Kerberos authentication to log in to a Windows Server 2008 R2 computer on which you are installing Connection Server, install the Microsoft hotfix that is described in KB 978116 at http://support.microsoft.com/kb/978116.

Verify that your installation satisfies the requirements described in Horizon Connection Server Requirements.

Verify that the computers on which you install replicated Connection Server instances are connected over a high-performance LAN. See Network Requirements for Replicated Horizon Connection Server Instances.

Prepare your environment for the installation. See Installation Prerequisites for Horizon Connection Server.

If you install a replicated Connection Server instance that is Horizon 7 5.1 or later, and the existing Connection Server instance you are replicating is Horizon 7 5.0.x or earlier, prepare a data recovery password. See Install Horizon Connection Server with a New Configuration.

Familiarize yourself with the network ports that must be opened on the Windows Firewall for Connection Server instances. See Firewall Rules for Horizon Connection Server.

If you plan to pair a security server with this Connection Server instance, verify that Windows Firewall with Advanced Security is set to on in the active profiles. It is recommended that you turn this setting to on for all profiles. By default, IPsec rules govern connections between security server and Connection Server and require Windows Firewall with Advanced Security to be enabled.

If your network topology includes a back-end firewall between a security server and the Connection Server instance, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

Procedure


   Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.

   The installer filename is VMware-viewconnectionserver-x86_64-y.y.y-xxxxxx.exe, where xxxxxx is the build number and y.y.y is the version number.

2. To start the Connection Server installation program, double-click the installer file.

3. Accept the VMware license terms.
4  Accept or change the destination folder.

5  Select the View Replica Server installation option.

6  Select the Internet Protocol (IP) version, IPv4 or IPv6.

   You must install all Horizon 7 components with the same IP version.

7  Select whether to enable or disable FIPS mode.

   This option is available only if FIPS mode is enabled in Windows.

8  Make sure that Install HTML Access is selected if you intend to allow users to connect to their
desktops by using HTML Access.

   If IPv4 is selected, this setting is selected by default. If IPv6 is selected, this setting is not displayed
because HTML Access is not supported in an IPv6 environment.

9  Enter the host name or IP address of the existing Connection Server instance you are replicating.

10 Type a data recovery password and, optionally, a password reminder.

   You are prompted for a data recovery password only if the existing Connection Server instance you
are replicating is Horizon 7 5.0.x or earlier.

11 Choose how to configure the Windows Firewall service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Windows Firewall automatically</td>
<td>Let the installer configure Windows Firewall to allow the required network connections.</td>
</tr>
<tr>
<td>Do not configure Windows Firewall</td>
<td>Configure the Windows firewall rules manually. Select this option only if your organization uses its own predefined rules for configuring Windows Firewall.</td>
</tr>
</tbody>
</table>

12 Complete the installation wizard to finish installing the replicated instance.

13 Check for new patches on the Windows Server computer and run Windows Update as needed.

   Even if you fully patched the Windows Server computer before you installed Connection Server, the
installation might have enabled operating system features for the first time. Additional patches might
now be required.

The Horizon 7 services are installed on the Windows Server computer:

- VMware Horizon Connection Server
- VMware Horizon View Framework Component
- VMware Horizon View Message Bus Component
- VMware Horizon View Script Host
- VMware Horizon View Security Gateway Component
- VMware Horizon View PCoIP Secure Gateway
- VMware Horizon View Blast Secure Gateway
- VMware Horizon View Web Component
- VMware VDMDS, which provides View LDAP directory services

For information about these services, see the *Horizon 7 Administration* document.

If the **Install HTML Access** setting was selected during the installation, the HTML Access component is installed on the Windows Server computer. This component configures the HTML Access icon in the Horizon 7 user portal page and enables the **VMware Horizon View Connection Server (Blast-In)** rule in the Windows Firewall. This firewall rule allows Web browsers on client devices to connect to the Connection Server on TCP port 8443.

**What to do next**

Configure an SSL server certificate for the Connection Server instance. See *Chapter 8 Configuring TLS Certificates for Horizon 7 Servers*.

You do not have to perform an initial Horizon 7 configuration on a replicated instance of Connection Server. The replicated instance inherits its configuration from the existing Connection Server instance.

However, you might have to configure client connection settings for this Connection Server instance, and you can tune Windows Server settings to support a large deployment. See *Configuring Horizon Client Connections* and *Sizing Windows Server Settings to Support Your Deployment*.

If you are reinstalling Connection Server and you have a data collector set configured to monitor performance data, stop the data collector set and start it again.

**Install a Replicated Instance of Horizon Connection Server Silently**

You can use the silent installation feature of the Microsoft Windows Installer (MSI) to install a replicated instance of Connection Server on several Windows computers. In a silent installation, you use the command line and do not have to respond to wizard prompts.

With silent installation, you can efficiently deploy Horizon 7 components in a large enterprise.

**Prerequisites**

- Verify that at least one Connection Server instance is installed and configured on the network.

- To install the replicated instance, you must log in as a user with credentials to access the Administrators account. You specify the Administrators account when you install the first instance of Connection Server. The account can be the local Administrators group or a domain user or group account. See *Install Horizon Connection Server with a New Configuration*.

- If the existing Connection Server instance is in a different domain than the replicated instance, the domain user must also have Administrator privileges on the Windows Server computer where the existing instance is installed.

- If you use MIT Kerberos authentication to log in to a Windows Server 2008 R2 computer on which you are installing Connection Server, install the Microsoft hotfix that is described in KB 978116 at [http://support.microsoft.com/kb/978116](http://support.microsoft.com/kb/978116).
- Verify that your installation satisfies the requirements described in Horizon Connection Server Requirements.

- Verify that the computers on which you install replicated Connection Server instances are connected over a high-performance LAN. See Network Requirements for Replicated Horizon Connection Server Instances.

- Prepare your environment for the installation. See Installation Prerequisites for Horizon Connection Server.

- Familiarize yourself with the network ports that must be opened on the Windows Firewall for Connection Server instances. See Firewall Rules for Horizon Connection Server.

- If you plan to pair a security server with this Connection Server instance, verify that Windows Firewall with Advanced Security is set to on in the active profiles. It is recommended that you turn this setting to on for all profiles. By default, IPsec rules govern connections between security server and Connection Server and require Windows Firewall with Advanced Security to be enabled.

- If your network topology includes a back-end firewall between a security server and the Connection Server instance, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

- Familiarize yourself with the MSI installer command-line options. See Microsoft Windows Installer Command-Line Options.

- Familiarize yourself with the silent installation properties available with a replica installation of Connection Server. See Silent Installation Properties for a Replicated Instance of Horizon Connection Server.

**Procedure**

   Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.
   The installer filename is VMware-viewconnectionserver-x86_64-y.y.y-xxxxxx.exe, where xxxxxx is the build number and y.y.y is the version number.

2. Open a command prompt on the Windows Server computer.
3 Type the installation command on one line.

For example:
```
VMware-viewconnectionserver-y.y.-xxxxxx.exe /s /v"/qn
VDM_SERVER_INSTANCE_TYPE=2 ADAM_PRIMARY_NAME=cs1.companydomain.com
VDM_INITIAL_ADMIN_SID=S-1-5-32-544"
```

If you install a replicated Connection Server instance that is View 5.1 or later, and the existing Connection Server instance you are replicating is View 5.0.x or earlier, you must specify a data recovery password, and you can add a password reminder. For example:
```
VMware-viewconnectionserver-y.y.-xxxxxx.exe /s /v"/qn VDM_SERVER_INSTANCE_TYPE=2
ADAM_PRIMARY_NAME=cs1.companydomain.com VDM_INITIAL_ADMIN_SID=S-1-5-32-544
VDM_SERVER_RECOVERY_PWD=mini VDM_SERVER_RECOVERY_PWD_REMINDER=""First car"
```

**Important** When you perform a silent installation, the full command line, including the data recovery password, is logged in the installer's vminst.log file. After the installation is complete, either delete this log file or change the data recovery password by using Horizon Administrator.

4 Check for new patches on the Windows Server computer and run Windows Update as needed.

Even if you fully patched the Windows Server computer before you installed Connection Server, the installation might have enabled operating system features for the first time. Additional patches might now be required.

The Horizon 7 services are installed on the Windows Server computer:

- VMware Horizon Connection Server
- VMware Horizon View Framework Component
- VMware Horizon View Message Bus Component
- VMware Horizon View Script Host
- VMware Horizon View Security Gateway Component
- VMware Horizon View PCoIP Secure Gateway
- VMware Horizon View Blast Secure Gateway
- VMware Horizon View Web Component
- VMware VDMDS, which provides View LDAP directory services

For information about these services, see the *Horizon 7 Administration* document.

If the **Install HTML Access** setting was selected during the installation, the HTML Access component is installed on the Windows Server computer. This component configures the HTML Access icon in the Horizon 7 user portal page and enables the **VMware Horizon View Connection Server (Blast-In)** rule in the Windows Firewall. This firewall rule allows Web browsers on client devices to connect to the Connection Server on TCP port 8443.
What to do next

Configure an SSL server certificate for the Connection Server instance. See Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

You do not have to perform an initial Horizon 7 configuration on a replicated instance of Connection Server. The replicated instance inherits its configuration from the existing Connection Server instance.

However, you might have to configure client connection settings for this Connection Server instance, and you can tune Windows Server settings to support a large deployment. See Configuring Horizon Client Connections and Sizing Windows Server Settings to Support Your Deployment.

Silent Installation Properties for a Replicated Instance of Horizon Connection Server

You can include specific properties when you silently install a replicated Horizon Connection Server instance from the command line. You must use a `PROPERTY=value` format so that Microsoft Windows Installer (MSI) can interpret the properties and values.

Table 7-2. MSI Properties for Silently installing a Replicated Instance of Horizon Connection Server

<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR</td>
<td>The path and folder in which the Connection Server software is installed.</td>
<td>%ProgramFiles%\VMware\VMware View\Server</td>
</tr>
<tr>
<td></td>
<td>For example: INSTALLDIR=&quot;D:\abc\my folder&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sets of two double quotes that enclose the path permit the MSI installer to interpret the space as a valid part of the path.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is optional.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_INSTANCE_TYPE</td>
<td>The type of Connection Server installation:</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1. Standard installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Replica installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Security server installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To install a replicated instance, define VDM_SERVER_INSTANCE_TYPE=2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required when installing a replica.</td>
<td></td>
</tr>
<tr>
<td>ADAM_PRIMARY_NAME</td>
<td>The host name or IP address of the existing Connection Server instance you are replicating.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>For example: ADAM_PRIMARY_NAME=cs1.companydomain.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required.</td>
<td></td>
</tr>
<tr>
<td>FWCHOICE</td>
<td>The MSI property that determines whether to configure a firewall for the Connection Server instance.</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>A value of 1 configures a firewall. A value of 2 does not configure a firewall.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: FwCHOICE=1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is optional.</td>
<td></td>
</tr>
</tbody>
</table>
### Table 7-2. MSI Properties for Silently installing a Replicated Instance of Horizon Connection Server (Continued)

<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>VDM_SERVER_RECOVERY_PWD</td>
<td>The data recovery password. If a data recovery password is not set in View LDAP, this property is mandatory. The data recover password is not set in View LDAP if the standard Connection Server instance you are replicating is View 5.0 or earlier. If the Connection Server instance you are replicating is View 5.1 or later, you do not have to provide this property. The password must contain between 1 and 128 characters. Follow your organization's best practices for generating secure passwords.</td>
<td>None</td>
</tr>
<tr>
<td>VDM_SERVER_RECOVERYPWD_REMINDER</td>
<td>The data recovery password reminder. This property is optional.</td>
<td>None</td>
</tr>
<tr>
<td>VDM_IP_PROTOCOL_USAGE</td>
<td>Specifies the IP version that Horizon 7 components use for communication. The possible values are IPv4 and IPv6</td>
<td>IPv4</td>
</tr>
<tr>
<td>VDM_FIPS_ENABLED</td>
<td>Specifies whether to enable or disable FIPS mode. A value of 1 enables FIPS mode. A value of 0 disables FIPS mode. If this property is set to 1 and Windows is not in FIPS mode, the installer will abort.</td>
<td>0</td>
</tr>
</tbody>
</table>

### Configure a Security Server Pairing Password

Before you can install a security server, you must configure a security server pairing password. When you install a security server with the Connection Server installation program, the program prompts you for this password during the installation process.

The security server pairing password is a one-time password that permits a security server to be paired with a Connection Server instance. The password becomes invalid after you provide it to the Connection Server installation program.

**Note** You cannot pair an older version of security server with the current version of Connection Server. If you configure a pairing password on the current version of Connection Server and try to install an older version of security server, the pairing password will be invalid.

**Procedure**

1. In Horizon Administrator, select **View Configuration > Servers**.
2. In the Connection Servers tab, select the Connection Server instance to pair with the security server.
3. From the **More Commands** drop-down menu, select **Specify Security Server Pairing Password**.
4. Type the password in the Pairing password and Confirm password text boxes and specify a password timeout value.
   - You must use the password within the specified timeout period.
5. Click **OK** to configure the password.
What to do next

Install a security server. See Install a Security Server.

**Important** If you do not provide the security server pairing password to the Connection Server installation program within the password timeout period, the password becomes invalid and you must configure a new password.

### Install a Security Server

A security server is an instance of Connection Server that adds an additional layer of security between the Internet and your internal network. You can install one or more security servers to be connected to a Connection Server instance.

The security server software cannot coexist on the same virtual or physical machine with any other Horizon 7 software component, including a replica server, Connection Server, View Composer, Horizon Agent, or Horizon Client.

### Prerequisites

- Determine the type of topology to use. For example, determine which load balancing solution to use. Decide if the Connection Server instances that are paired with security servers will be dedicated to users of the external network. For information, see the [Horizon 7 Architecture Planning](#) document.

  **Important** If you use a load balancer, it must have an IP address that does not change. In an IPv4 environment, configure a static IP address. In an IPv6 environment, machines automatically get IP addresses that do not change.

- Verify that your installation satisfies the requirements described in [Horizon Connection Server Requirements](#).

- Prepare your environment for the installation. See [Installation Prerequisites for Horizon Connection Server](#).

- Verify that the Connection Server instance to be paired with the security server is installed and configured and is running a Connection Server version that is compatible with the security server version. See "Horizon 7 Component Compatibility Matrix" in the [Horizon 7 Upgrades](#) document.

- Verify that the Connection Server instance to be paired with the security server is accessible to the computer on which you plan to install the security server.

  **Note** After a Connection Server upgrade to Horizon 7 version 7.5, security servers with IPsec disabled must be reinstalled. If the IP address of a security server changes it must be reinstalled. Security server pairing does not work correctly if the security server is behind Dynamic NAT.

- Configure a security server pairing password. See [Configure a Security Server Pairing Password](#).

- Familiarize yourself with the format of external URLs. See [Configuring External URLs for Secure Gateway and Tunnel Connections](#).
- Verify that Windows Firewall with Advanced Security is set to **on** in the active profiles. It is recommended that you turn this setting to **on** for all profiles. By default, IPsec rules govern connections between security server and View Connection Server and require Windows Firewall with Advanced Security to be enabled.

- Familiarize yourself with the network ports that must be opened on the Windows Firewall for a security server. See Firewall Rules for Horizon Connection Server.

- If your network topology includes a back-end firewall between the security server and Connection Server, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

- If you are upgrading or reinstalling the security server, verify that the existing IPsec rules for the security server were removed. See Remove IPsec Rules for the Security Server.

- If you are installing Horizon 7 in FIPS mode, you must deselect the global setting **Use IPSec for Security Server Connections** in Horizon Administrator, because in FIPS mode, you must configure IPsec manually after installing a security server.

**Procedure**

   - Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.
   - The installer filename is `VMware-viewconnectionserver-x86_64-y.y-y-xxxxxx.exe`, where `xxxxxx` is the build number and `y.y.y` is the version number.

2. To start the Connection Server installation program, double-click the installer file.

3. Accept the VMware license terms.

4. Accept or change the destination folder.

5. Select the **View Security Server** installation option.

6. Select the Internet Protocol (IP) version, **IPv4** or **IPv6**.
   - You must install all Horizon 7 components with the same IP version.

7. Select whether to enable or disable FIPS mode.
   - This option is available only if FIPS mode is enabled in Windows.

8. Type the fully qualified domain name or IP address of the Connection Server instance to pair with the security server in the **Server** text box.
   - The security server forwards network traffic to this Connection Server instance.

9. Type the security server pairing password in the **Password** text box.
   - If the password has expired, you can use Horizon Administrator to configure a new password and type the new password in the installation program.
In the **External URL** text box, type the external URL of the security server for client endpoints that use the RDP or PCoIP display protocols.

The URL must contain the protocol, client-resolvable security server name, and port number. Tunnel clients that run outside of your network use this URL to connect to the security server.

For example: `https://view.example.com:443`

In the **PCoIP External URL** text box, type the external URL of the security server for client endpoints that use the PCoIP display protocol.

In an IPv4 environment, specify the PCoIP external URL as an IP address with the port number 4172. In an IPv6 environment, you can specify an IP address or a fully qualified domain name, and the port number 4172. In either case, do not include a protocol name.

For example, in an IPv4 environment: `10.20.30.40:4172`

Clients must be able to use the URL to reach the security server.

In the **Blast External URL** text box, type the external URL of the security server for users who use HTML Access to connect to remote desktops.

The URL must contain the HTTPS protocol, client-resolvable host name, and port number.

For example: `https://myserver.example.com:8443`

By default, the URL includes the FQDN of the secure tunnel external URL and the default port number, 8443. The URL must contain the FQDN and port number that a client system can use to reach this security server.

Choose how to configure the Windows Firewall service.

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Windows Firewall</td>
<td>Let the installer configure Windows Firewall to allow the required network connections.</td>
</tr>
<tr>
<td>automatically</td>
<td></td>
</tr>
<tr>
<td>Do not configure Windows Firewall</td>
<td>Configure the Windows firewall rules manually.</td>
</tr>
<tr>
<td></td>
<td>Select this option only if your organization uses its own predefined rules for configuring Windows Firewall.</td>
</tr>
</tbody>
</table>

Complete the installation wizard to finish installing the security server.

The security server services are installed on the Windows Server computer:

- VMware Horizon View Security Server
- VMware Horizon View Framework Component
- VMware Horizon View Security Gateway Component
- VMware Horizon View PCoIP Secure Gateway
- VMware Blast Secure Gateway

For information about these services, see the *Horizon 7 Administration* document.

The security server appears in the Security Servers pane in Horizon Administrator.
The **VMware Horizon View Connection Server (Blast-In)** rule is enabled in the Windows Firewall on the security server. This firewall rule allows Web browsers on client devices to use HTML Access to connect to the security server on TCP port 8443.

**Note** If the installation is cancelled or aborted, you might have to remove IPsec rules for the security server before you can begin the installation again. Take this step even if you already removed IPsec rules prior to reinstalling or upgrading security server. For instructions on removing IPsec rules, see Remove IPsec Rules for the Security Server.

**What to do next**

Configure an SSL server certificate for the security server. See **Chapter 8 Configuring TLS Certificates for Horizon 7 Servers**.

You might have to configure client connection settings for the security server, and you can tune Windows Server settings to support a large deployment. See Configuring Horizon Client Connections and Sizing Windows Server Settings to Support Your Deployment.

If you are reinstalling the security server and you have a data collector set configured to monitor performance data, stop the data collector set and start it again.

**Install a Security Server Silently**

You can use the silent installation feature of the Microsoft Windows Installer (MSI) to install a security server on several Windows computers. In a silent installation, you use the command line and do not have to respond to wizard prompts.

With silent installation, you can efficiently deploy Horizon 7 components in a large enterprise.

**Prerequisites**

- Determine the type of topology to use. For example, determine which load balancing solution to use. Decide if the Connection Server instances that are paired with security servers will be dedicated to users of the external network. For information, see the **Horizon 7 Architecture Planning** document.

**Important** If you use a load balancer, it must have an IP address that does not change. In an IPv4 environment, configure a static IP address. In an IPv6 environment, machines automatically get IP addresses that do not change.

- Verify that your installation satisfies the requirements described in **Horizon Connection Server Requirements**.

- Prepare your environment for the installation. See **Installation Prerequisites for Horizon Connection Server**.

- Verify that the Connection Server instance to be paired with the security server is installed and configured and is running a Connection Server version that is compatible with the security server version. See "Horizon 7 Component Compatibility Matrix" in the **Horizon 7 Upgrades** document.
Verify that the Connection Server instance to be paired with the security server is accessible to the computer on which you plan to install the security server.

**Note** After a Connection Server upgrade to Horizon 7 version 7.5, security servers with IPsec disabled must be reinstalled. If the IP address of a security server changes it must be reinstalled. Security server pairing does not work correctly if the security server is behind Dynamic NAT.

Configure a security server pairing password. See Configure a Security Server Pairing Password.

Familiarize yourself with the format of external URLs. See Configuring External URLs for Secure Gateway and Tunnel Connections.

Verify that Windows Firewall with Advanced Security is set to on in the active profiles. It is recommended that you turn this setting to on for all profiles. By default, IPsec rules govern connections between security server and Connection Server and require Windows Firewall with Advanced Security to be enabled.

Familiarize yourself with the network ports that must be opened on the Windows Firewall for a security server. See Firewall Rules for Horizon Connection Server.

If your network topology includes a back-end firewall between the security server and Connection Server, you must configure the firewall to support IPsec. See Configuring a Back-End Firewall to Support IPsec.

If you are upgrading or reinstalling the security server, verify that the existing IPsec rules for the security server were removed. See Remove IPsec Rules for the Security Server.

Familiarize yourself with the MSI installer command-line options. See Microsoft Windows Installer Command-Line Options.

Familiarize yourself with the silent installation properties available with a security server. See Silent Installation Properties for a Security Server.

If you are installing Horizon 7 in FIPS mode, you must deselect the global setting **Use IPSec for Security Server Connections** in Horizon Administrator, because in FIPS mode, you must configure IPsec manually after installing a security server.

**Procedure**


   Under Desktop & End-User Computing, select the VMware Horizon 7 download, which includes Connection Server.

   The installer filename is `VMware-viewconnectionserver-x86_64-y.y.y-xxxxxx.exe`, where `xxxxxx` is the build number and `y.y.y` is the version number.

2. Open a command prompt on the Windows Server computer.
3 Type the installation command on one line.

For example:
```
VMware-viewconnectionserver-y.y-yyyyy.exe /s /v"/qn
VDM_SERVER_INSTANCE_TYPE=3 VDM_SERVER_NAME=cs1.internaldomain.com
VDM_SERVER_SS_EXTURL=https://view.companydomain.com:443
VDM_SERVER_SS_PCOIP_IPADDR=10.20.30.40 VDM_SERVER_SS_PCOIP_TCP_PORT=4172
VDM_SERVER_SS_PCOIP_UDP_PORT=4172
VDM_SERVER_SS_BSG_EXTURL=https://view.companydomain.com:8443
VDM_SERVER_SS_PWD=secret"
```

The security server services are installed on the Windows Server computer:

- VMware Horizon View Security Server
- VMware Horizon View Framework Component
- VMware Horizon View Security Gateway Component
- VMware Horizon View PCoIP Secure Gateway
- VMware Blast Secure Gateway

For information about these services, see the *Horizon 7 Administration* document.

The security server appears in the Security Servers pane in Horizon Administrator.

The **VMware Horizon View Connection Server (Blast-In)** rule is enabled in the Windows Firewall on the security server. This firewall rule allows Web browsers on client devices to use HTML Access to connect to the security server on TCP port 8443.

**Note** If the installation is cancelled or aborted, you might have to remove IPsec rules for the security server before you can begin the installation again. Take this step even if you already removed IPsec rules prior to reinstalling or upgrading security server. For instructions on removing IPsec rules, see Remove IPsec Rules for the Security Server.

**What to do next**

Configure an SSL server certificate for the security server. See Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

You might have to configure client connection settings for the security server, and you can tune Windows Server settings to support a large deployment. See Configuring Horizon Client Connections and Sizing Windows Server Settings to Support Your Deployment.

**Silent Installation Properties for a Security Server**

You can include specific properties when you silently install a security server from the command line. You must use a `PROPERTY=value` format so that Microsoft Windows Installer (MSI) can interpret the properties and values.
<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INSTALLDIR</td>
<td>The path and folder in which the Connection Server software is installed.</td>
<td>%ProgramFiles%\VMware\VMware View\Server</td>
</tr>
<tr>
<td></td>
<td>For example: INSTALLDIR=&quot;D:\abc\my folder&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>The sets of two double quotes that enclose the path permit the MSI</td>
<td></td>
</tr>
<tr>
<td></td>
<td>installer to interpret the space as a valid part of the path.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is optional.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_INSTANCE_TYPE</td>
<td>The type of Connection Server installation:</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1. Standard installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Replica installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Security server installation</td>
<td></td>
</tr>
<tr>
<td></td>
<td>To install a security server, define VDM_SERVER_INSTANCE_TYPE=3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required when installing a security server.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_NAME</td>
<td>The host name or IP address of the existing Connection Server instance</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>to pair with the security server.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: VDM_SERVER_NAME=cs1.internaldomain.com</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_SS_EXTURL</td>
<td>The external URL of the security server. The URL must contain the protocol,</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>externally resolvable security server name, and port number</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: VDM_SERVER_SS_EXTURL=<a href="https://view.companydomain.com:443">https://view.companydomain.com:443</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_SS_PWD</td>
<td>The security server pairing password.</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>For example: VDM_SERVER_SS_PWD=secret</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is required.</td>
<td></td>
</tr>
<tr>
<td>FWCHOICE</td>
<td>The MSI property that determines whether to configure a firewall for the</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>Connection Server instance.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>A value of 1 configures a firewall. A value of 2 does not configure a</td>
<td></td>
</tr>
<tr>
<td></td>
<td>firewall.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: FwCHOICE=1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>This MSI property is optional.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_SS_PCOIP_IPADDR</td>
<td>The PCoIP Secure Gateway external IP address. In an IPv6 environment, this</td>
<td>None</td>
</tr>
<tr>
<td></td>
<td>property can also be set to the FQDN of the PCoIP Secure Gateway. This property is supported only when the security server is installed on Windows Server 2008 R2 or later. For example: VDM_SERVER_SS_PCOIP_IPADDR=10.20.30.40 This property is required if you plan to use the PCoIP Secure Gateway component.</td>
<td></td>
</tr>
<tr>
<td>VDM_SERVER_SS_PCOIP_TCP_PORT</td>
<td>The PCoIP Secure Gateway external TCP port number. This property is supported only when the security server is installed on Windows Server 2008 R2 or later. For example: VDM_SERVER_SS_PCOIP_TCP_PORT=4172 This property is required if you plan to use the PCoIP Secure Gateway component.</td>
<td>None</td>
</tr>
</tbody>
</table>
### Table 7-3. MSI Properties for Silently Installing a Security Server (Continued)

<table>
<thead>
<tr>
<th>MSI Property</th>
<th>Description</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>VDM_SERVER_SS_PCOIP_UDPPORT</code></td>
<td>The PCoIP Secure Gateway external UDP port number. This property is supported only when the security server is installed on Windows Server 2008 R2 or later. For example: <code>VDM_SERVER_SS_PCOIP_UDPPORT=4172</code> This property is required if you plan to use the PCoIP Secure Gateway component.</td>
<td>None</td>
</tr>
<tr>
<td><code>VDM_SERVER_SS_BSG_EXTURL</code></td>
<td>The Blast Secure Gateway external URL. The URL must contain the HTTPS protocol, an externally resolvable security server name, and port number. For example: <code>VDM_SERVER_SS_BSG_EXTURL=https://view.companydomain.com:8443</code> The default port number is 8443. A Blast Secure Gateway must be installed on the security server to allow users to make Web connections to Horizon 7 desktops.</td>
<td>None</td>
</tr>
<tr>
<td><code>VDM_SERVER_SS_FORCE_IPSEC</code></td>
<td>Forces IPsec to be used between the security server and its paired Connection Server instance. By default, an unattended installation and pairing of security server to a Connection Server instance with IPsec disabled causes the pairing to fail. The default value of 1 forces IPsec pairing. Set this value to 0 to allow pairing without IPsec.</td>
<td>1</td>
</tr>
<tr>
<td><code>VDM_IP_PROTOCOL_USAGE</code></td>
<td>Specifies the IP version that Horizon 7 components use for communication. The possible values are IPv4 and IPv6.</td>
<td>IPv4</td>
</tr>
<tr>
<td><code>VDM_FIPS_ENABLED</code></td>
<td>Specifies whether to enable or disable FIPS mode. A value of 1 enables FIPS mode. A value of 0 disables FIPS mode. If this property is set to 1 and Windows is not in FIPS mode, the installer will abort.</td>
<td>0</td>
</tr>
</tbody>
</table>

### Remove IPsec Rules for the Security Server

Before you can upgrade or reinstall a security server instance, you must remove the current IPsec rules that govern communication between the security server and its paired Connection Server instance. If you do not take this step, the upgrade or reinstallation fails.

By default, communication between a security server and its paired Connection Server instance is governed by IPsec rules. When you upgrade or reinstall the security server and pair it again with the Connection Server instance, a new set of IPsec rules must be established. If the existing IPsec rules are not removed before you upgrade or reinstall, the pairing fails.

You must take this step when you upgrade or reinstall a security server and are using IPsec to protect communication between the security server and Connection Server.
You can configure an initial security server pairing without using IPsec rules. Before you install the security server, you can open Horizon Administrator and deselect the global setting **Use IPSec for Security Server Connections**, which is enabled by default. If IPsec rules are not in effect, you do not have to remove them before you upgrade or reinstall.

**Note** You do not have to remove a security server from Horizon Administrator before you upgrade or reinstall the security server. Remove a security server from Horizon Administrator only if you intend to remove the security server permanently from the Horizon 7 environment.

With View 5.0.x and earlier releases, you could remove a security server either from within the Horizon Administrator user interface or by using the `vdmadmin -S` command-line command. In View 5.1 and later releases, you must use `vdmadmin -S`. See "Removing the Entry for a Horizon Connection Server Instance or Security Server Using the -S Option" in the *Horizon 7 Administration* document.

**Caution** If you remove the IPsec rules for an active security server, all communication with the security server is lost until you upgrade or reinstall the security server. Therefore, if you use a load balancer to manage a group of security servers, perform this procedure on one server and then upgrade that server before removing IPsec rules for the next server. You can remove servers from production and add them back one-by-one in this manner to avoid requiring any downtime for your end users.

### Procedure

1. In Horizon Administrator, click **View Configuration > Servers**.

2. In the **Security Servers** tab, select a security server and click **More Commands > Prepare for Upgrade or Reinstallation**.

   If you disabled IPsec rules before you installed the security server, this setting is inactive. In this case, you do not have to remove IPsec rules before you reinstall or upgrade.

3. Click **OK**.

   The IPsec rules are removed and the **Prepare for Upgrade or Reinstallation** setting becomes inactive, indicating that you can reinstall or upgrade the security server.

**What to do next**

Upgrade or reinstall security server.

### Unified Access Gateway Appliance Advantages over VPN

A Unified Access Gateway appliance is a default gateway for secure access to remote desktops and applications from outside the corporate firewall.

A Unified Access Gateway appliance resides within a network demilitarized zone (DMZ) and acts as a proxy host for connections inside a trusted network, providing an additional layer of security by shielding virtual desktops, application hosts, and servers from the public-facing Internet.

**Configure a Unified Access Gateway Appliance**

Unified Access Gateway and generic VPN solutions are similar as they both ensure that traffic is forwarded to an internal network only on behalf of strongly authenticated users.

Unified Access Gateway advantages over generic VPN include the following.

- **Access Control Manager.** Unified Access Gateway applies access rules automatically. Unified Access Gateway recognizes the entitlements of the users and the addressing required to connect internally. A VPN does the same, because most VPNs allow an administrator to configure network connection rules for every user or group of users individually. At first, this works well with a VPN, but requires significant administrative effort to maintain the required rules.

- **User Interface.** Unified Access Gateway does not alter the straightforward Horizon Client user interface. With Unified Access Gateway, when the Horizon Client is launched, authenticated users are in their View environment and have controlled access to their desktops and applications. A VPN requires that you must set up the VPN software first and authenticate separately before launching the Horizon Client.

- **Performance.** Unified Access Gateway is designed to maximize security and performance. With Unified Access Gateway, PCoIP, HTML access, and WebSocket protocols are secured without requiring additional encapsulation. VPNs are implemented as SSL VPNs. This implementation meets security requirements and, with Transport Layer Security (TLS) enabled, is considered secure, but the underlying protocol with SSL/TLS is just TCP-based. With modern video remoting protocols exploiting connectionless UDP-based transports, the performance benefits can be significantly eroded when forced over a TCP-based transport. This does not apply to all VPN technologies, as those that can also operate with DTLS or IPsec instead of SSL/TLS can work well with View, a component of Horizon 7 desktop protocols.

**Enhance Horizon Security with Unified Access Gateway**

A Unified Access Gateway appliance enhances security by layering device certification authentication on top of user authentication so access can be restricted only from known good devices and adding another layer of security on virtual desktop infrastructure.

**Note** This feature is supported in Windows Horizon Client only.

The Endpoint Compliance Checks feature provides an extra layer of security for accessing Horizon desktops in addition to the other user authentication services that are available on Unified Access Gateway. See Endpoint Compliance Checks for Horizon in the Deploying and Configuring VMware Unified Access Gateway document in https://docs.vmware.com/en/Unified-Access-Gateway/index.html.

Double-hop DMZ

For cases where a double-hop DMZ between the Internet and the internal network is required, you can deploy a Unified Access Gateway appliance in the outer DMZ as a Web Reverse Proxy with Unified Access gateway in the inner DMZ to create a double-hop DMZ configuration. Traffic passes through a specific reverse proxy in each DMZ layer and cannot bypass a DMZ layer. For configuration details, see the Deploying and Configuring VMware Unified Access Gateway document.

Firewall Rules for Horizon Connection Server

Certain ports must be opened for Connection Server instances and security servers. When you install Connection Server, the installation program can optionally configure the required Windows Firewall rules for you. These rules open the ports that are used by default. If you change the default ports after installation, you must manually configure Windows Firewall to allow Horizon Client devices to connect to Horizon 7 through the updated ports.

The following table lists the default ports that can be opened automatically during installation. Ports are incoming unless otherwise noted.

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Ports</th>
<th>Horizon Connection Server Instance Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>JMS</td>
<td>TCP 4001</td>
<td>Standard and replica</td>
</tr>
<tr>
<td>JMS</td>
<td>TCP 4002</td>
<td>Standard and replica</td>
</tr>
<tr>
<td>JMSIR</td>
<td>TCP 4100</td>
<td>Standard and replica</td>
</tr>
<tr>
<td>JMSIR</td>
<td>TCP 4101</td>
<td>Standard and replica</td>
</tr>
<tr>
<td>AJP13</td>
<td>TCP 8009</td>
<td>Standard and replica</td>
</tr>
<tr>
<td>HTTP</td>
<td>TCP 80</td>
<td>Standard, replica, and security server</td>
</tr>
<tr>
<td>HTTPS</td>
<td>TCP 443</td>
<td>Standard, replica, and security server</td>
</tr>
<tr>
<td>PCoIP</td>
<td>TCP 4172 in; TCP 4172 both directions</td>
<td>Standard, replica, and security server. After the initial connection to Horizon 7 is made, the Web browser or client device connects to the Blast Secure Gateway on TCP port 8443. The Blast Secure Gateway must be enabled on a security server or View Connection Server instance to allow this second connection to take place.</td>
</tr>
<tr>
<td>HTTPS</td>
<td>TCP 8443; UDP 8443</td>
<td>Standard, replica, and security server. After the initial connection to Horizon 7 is made, the Web browser or client device connects to the Blast Secure Gateway on TCP port 8443. The Blast Secure Gateway must be enabled on a security server or View Connection Server instance to allow this second connection to take place.</td>
</tr>
<tr>
<td>HTTPS</td>
<td>TCP 8472</td>
<td>Standard and replica</td>
</tr>
</tbody>
</table>

For the Cloud Pod Architecture feature: used for interpod communication.
Table 7-4. Ports Opened During Horizon Connection Server Installation (Continued)

<table>
<thead>
<tr>
<th>Protocol</th>
<th>Ports</th>
<th>Horizon Connection Server Instance Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP</td>
<td>TCP 22389</td>
<td>Standard and replica</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the Cloud Pod Architecture feature: used for global LDAP replication.</td>
</tr>
<tr>
<td>HTTPS</td>
<td>TCP 22636</td>
<td>Standard and replica</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For the Cloud Pod Architecture feature: used for secure global LDAP replication.</td>
</tr>
</tbody>
</table>

Configuring a Back-End Firewall to Support IPsec

If your network topology includes a back-end firewall between security servers and Connection Server instances, you must configure certain protocols and ports on the firewall to support IPsec. Without proper configuration, data sent between a security server and Connection Server instance will fail to pass through the firewall.

By default, IPsec rules govern the connections between security servers and Connection Server instances. To support IPsec, the Connection Server installer can configure Windows firewall rules on the Windows Server hosts where Horizon 7 servers are installed. For a back-end firewall, you must configure the rules yourself.

Note  It is highly recommended that you use IPsec. As an alternative, you can disable the Horizon Administrator global setting, Use IPsec for Security Server Connections.

The following rules must allow bidirectional traffic. You might have to specify separate rules for inbound and outbound traffic on your firewall.

Different rules apply to firewalls that use network address translation (NAT) and those that do not use NAT.

Table 7-5. Non-NAT Firewall Requirements to Support IPsec Rules

<table>
<thead>
<tr>
<th>Source</th>
<th>Protocol</th>
<th>Port</th>
<th>Destination</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security server</td>
<td>ISAKMP</td>
<td>UDP 500</td>
<td>Horizon Connection Server</td>
<td>Security servers use UDP port 500 to negotiate IPsec security.</td>
</tr>
<tr>
<td>Security server</td>
<td>ESP</td>
<td>N/A</td>
<td>Horizon Connection Server</td>
<td>ESP protocol encapsulates IPsec encrypted traffic. You do not have to specify a port for ESP as part of the rule. If necessary, you can specify source and destination IP addresses to reduce the scope of the rule.</td>
</tr>
</tbody>
</table>

The following rules apply to firewalls that use NAT.
Table 7-6. NAT Firewall Requirements to Support IPsec Rules

<table>
<thead>
<tr>
<th>Source</th>
<th>Protocol</th>
<th>Port</th>
<th>Destination</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security server</td>
<td>ISAKMP</td>
<td>UDP 500</td>
<td>Horizon Connection Server</td>
<td>Security servers use UDP port 500 to initiate IPsec security negotiation.</td>
</tr>
<tr>
<td>Security server</td>
<td>NAT-T ISAKMP</td>
<td>UDP 4500</td>
<td>Horizon Connection Server</td>
<td>Security servers use UDP port 4500 to traverse NATs and negotiate IPsec security.</td>
</tr>
</tbody>
</table>

Reinstall Horizon Connection Server with a Backup Configuration

In certain situations, you might have to reinstall the current version of a Connection Server instance and restore the existing Horizon 7 configuration by importing a backup LDIF file that contains the View LDAP configuration data.

For example, as part of a business continuity and disaster recovery (BC/DR) plan, you might want to have a procedure ready to implement in case a datacenter stops functioning. The first step in such a plan is to ensure that the View LDAP configuration is backed up in another location. A second step is to install Connection Server in the new location and import the backup configuration, as described in this procedure.

You might also use this procedure when you set up a second datacenter with the existing Horizon 7 configuration. Or you might use it if your Horizon 7 deployment contains only a single Connection Server instance, and a problem occurs with that server.

You do not have to follow this procedure if you have multiple Connection Server instances in a replicated group, and a single instance goes down. You can simply reinstall Connection Server as a replicated instance. During the installation, you provide connection information to another Connection Server instance, and Horizon 7 restores the View LDAP configuration from the other instance.

Prerequisites

- Verify that the View LDAP configuration was backed up to an encrypted LDIF file.
- Familiarize yourself with restoring a View LDAP configuration from an LDIF backup file by using the `vdmimport` command.
  
  See "Backing Up and Restoring Horizon 7 Configuration Data" in the Horizon 7 Administration document.

- Familiarize yourself with the steps for installing a new Connection Server instance. See Install Horizon Connection Server with a New Configuration.

Procedure

1. Install Connection Server with a new configuration.
2 Decrypt the encrypted LDIF file.

   For example:

   ```bash
   vdmimport -d -p mypassword -f MyEncryptedexport.LDF > MyDecryptedexport.LDF
   ```

3 Import the decrypted LDIF file to restore the View LDAP configuration.

   For example:

   ```bash
   vdmimport -f MyDecryptedexport.LDF
   ```

   **Note** At this stage, the Horizon 7 configuration is not yet accessible. Clients cannot access Connection Server or connect to their desktops.

4 Uninstall the Connection Server from the computer by using the Windows **Add/Remove Programs** utility.

   Do not uninstall the View LDAP configuration, called the AD LDS Instance VMwareVDMDS instance. You can use the **Add/Remove Programs** utility to verify that the AD LDS Instance VMwareVDMDS instance was not removed from the Windows Server computer.

5 Reinstall Connection Server.

   At the installer prompt, accept the existing View LDAP directory.

**What to do next**

Configure Connection Server and your Horizon 7 environment as you would after you install a Connection Server instance with a new configuration.

**Microsoft Windows Installer Command-Line Options**

To install Horizon 7 components silently, you must use Microsoft Windows Installer (MSI) command-line options and properties. The Horizon 7 component installers are MSI programs and use standard MSI features.

For details about MSI, see the Microsoft Web site. For MSI command-line options, see the Microsoft Developer Network (MSDN) Library Web site and search for MSI command-line options. To see MSI command-line usage, you can open a command prompt on the Horizon 7 component computer and type `msiexec /?`.

To run a Horizon 7 component installer silently, you begin by silencing the bootstrap program that extracts the installer into a temporary directory and starts an interactive installation.

At the command line, you must enter command-line options that control the installer’s bootstrap program.
Table 7-7. Command-Line Options for a Horizon 7 Component’s Bootstrap Program

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| /s     | Disables the bootstrap splash screen and extraction dialog, which prevents the display of interactive dialogs.  
For example: `VMware-viewconnectionserver-y.y.y-yyyyyy.exe /s`  
The /s option is required to run a silent installation. |
| /v"*MSI_command_line_options*" | Instructs the installer to pass the double-quote-enclosed string that you enter at the command line as a set of options for MSI to interpret. You must enclose your command-line entries between double quotes. Place a double quote after the /v and at the end of the command line.  
For example: `VMware-viewagent-y.y.y-yyyyyy.exe /s /v"command_line_options"`  
To instruct the MSI installer to interpret a string that contains spaces, enclose the string in two sets of double quotes. For example, you might want to install the Horizon 7 component in an installation path name that contains spaces.  
For example: `VMware-viewconnectionserver-y.y.y-yyyyyy.exe /s /v"command_line_options" INSTALLDIR="d:abc\my folder""`  
In this example, the MSI installer passes on the installation-directory path and does not attempt to interpret the string as two command-line options. Note the final double quote that encloses the entire command line.  
The /v"command_line_options" option is required to run a silent installation. |

You control the remainder of a silent installation by passing command-line options and MSI property values to the MSI installer, `msi.exe`. The MSI installer includes the Horizon 7 component's installation code. The installer uses the values and options that you enter in the command line to interpret installation choices and setup options that are specific to the Horizon 7 component.

Table 7-8. MSI Command-Line Options and MSI Properties

<table>
<thead>
<tr>
<th>MSI Option or Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| /qn                    | Instructs the MSI installer not to display the installer wizard pages.  
For example, you might want to install Horizon Agent silently and use only default setup options and features:  
`VMware-viewagent-y.y.y-yyyyyy.exe /s /v"/qn"`  
Alternatively, you can use the /qb option to display a basic progress dialog box in a noninteractive, automated installation.  
The /qn or /qb option is required to run a silent installation.  
For information about additional /q parameters, see the Microsoft Dev Center website. |
| INSTALLDIR             | Specifies an alternative installation path for the Horizon 7 component.  
Use the format `INSTALLDIR=path` to specify an installation path. You can ignore this MSI property if you want to install the Horizon 7 component in the default path.  
This MSI property is optional. |
<table>
<thead>
<tr>
<th>MSI Option or Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADDLOCAL</td>
<td>Determines the component-specific options to install. In an interactive installation, the Horizon 7 installer displays custom setup options that you can select or deselect. In a silent installation, you can use the ADDLOCAL property to selectively install individual setup options by specifying the options on the command line. Options that you do not explicitly specify are not installed. In both interactive and silent installations, the Horizon 7 installer automatically installs certain features. You cannot use ADDLOCAL to control whether or not to install these non-optional features. Type ADDLOCAL=ALL to install all custom setup options that can be installed during an interactive installation, including those that are installed by default and those that you must select to install, except NGVC. NGVC and SVIAgent are mutually exclusive. The following example installs Core, BlastProtocol, PCoIP, UnityTouch, VmVideo, PSG, and all features that are supported on the guest operating system: <code>VMware-viewagent-y.y.y-xxxxxx.exe /s /v&quot;/qn ADDLOCAL=ALL&quot;</code> If you do not use the ADDLOCAL property, the custom setup options that are installed by default and the automatically installed features are installed. Custom setup options that are off (unselected) by default are not installed. The following example installs Core, BlastProtocol, PCoIP, UnityTouch, VmVideo, PSG, and the on-by-default custom setup options that are supported on the guest operating system: <code>VMware-viewagent-y.y.y-xxxxxx.exe /s /v=&quot;/qn&quot;</code> To specify individual setup options, type a comma-separated list of setup option names. Do not use spaces between names. Use the format ADDLOCAL=value,value,value... You must include Core when you use the ADDLOCAL=value,value,value... property. The following example installs Horizon Agent with the Core, BlastProtocol, PCoIP, UnityTouch, VmVideo, PSG, Instant Clone Agent, and Virtual Printing features: <code>VMware-viewagent-y.y.y-xxxxxx.exe /s /v=&quot;/qn ADDLOCAL=Core,NGVC,ThinPrint&quot;</code> The preceding example does not install other components, even those that are installed by default interactively. The ADDLOCAL MSI property is optional.</td>
</tr>
<tr>
<td>REBOOT</td>
<td>You can use the REBOOT=ReallySuppress option to allow system configuration tasks to complete before the system reboots. This MSI property is optional.</td>
</tr>
<tr>
<td>/l*v log_file</td>
<td>Writes logging information into the specified log file with verbose output. For example: <code>/l*v &quot;\%TEMP\%\vmmsi.log&quot;</code> This example generates a detailed log file that is similar to the log generated during an interactive installation. You can use this option to record custom features that might apply uniquely to your installation. You can use the recorded information to specify installation features in future silent installations. The /l*v option is optional.</td>
</tr>
</tbody>
</table>

**Uninstalling Horizon 7 Components Silently by Using MSI Command-Line Options**

You can uninstall Horizon 7 components by using Microsoft Windows Installer (MSI) command-line options.
Syntax

```
msiexec.exe
/qb
/x
product_code
```

Options

The `/qb` option displays the uninstall progress bar. To suppress displaying the uninstall progress bar, replace the `/qb` option with the `/qn` option.

The `/x` option uninstalls the Horizon 7 component.

The `product_code` string identifies the Horizon 7 component product files to the MSI uninstaller. You can find the `product_code` string by searching for `ProductCode` in the `%TEMP%\vmmsi.log` file that is created during the installation. To find the `product_code` string that applies to older versions of Horizon 7 components, see the VMware Knowledge Base (KB) article at http://kb.vmware.com/kb/2064845.

For information about MSI command-line options, see Microsoft Windows Installer Command-Line Options.

Uninstall a Horizon Agent Example

To uninstall a 32-bit Horizon Agent version 7.0.2, enter the following command:

```
msiexec.exe /qb /x {B23352D8-AD44-4379-A56E-0E337F9C4036}
```

To uninstall a 64-bit Horizon Agent version 7.0.2, enter the following command:

```
msiexec.exe /qb /x {53D6EE37-6B10-4963-81B1-8E2972A1DA4D}
```

Add a verbose log to the command.

```
/l*v "%TEMP%\vmmsi_uninstall.log"
```

If you do not explicitly pass the `/l` option, the default verbose log file is `%TEMP%\MSInnnn.log`, where `nnnn` is a four-character GUID.

The Horizon Agent uninstallation process retains some registry keys. These keys are required for retaining the Connection Server configuration information that enables the remote desktop to continue being paired with the Connection Server even if the agent is uninstalled and then reinstalled. Removing these registry keys will break that pairing.

The following registry keys are retained:

- `HKLM\SOFTWARE\Microsoft\SystemCertificates\VMware Horizon View Certificates`
- HKLM\SOFTWARE\Microsoft\SystemCertificates\VMwareView\Certificates\*
- HKLM\SOFTWARE\Microsoft\SystemCertificates\VMwareView\CRLs
- HKLM\SOFTWARE\Microsoft\SystemCertificates\VMwareView\CTLs
- HKLM\SOFTWARE\Policies\VMware, Inc.\VMware VDM\*
- HKLM\SOFTWARE\Policies\VMware, Inc.\vRealize Operations for Horizon\*
- HKLM\SOFTWARE\VMware, Inc.\VMware VDM\*
- HKLM\SOFTWARE\Wow6432Node\Microsoft\SystemCertificates\VMware Horizon View\ Certificates\*
- HKLM\SOFTWARE\Wow6432Node\Microsoft\SystemCertificates\VMwareView\*
- HKLM\SOFTWARE\Wow6432Node\Policies\VMware, Inc.\VMware VDM\*
- HKLM\SOFTWARE\Wow6432Node\Policies\VMware, Inc.\vRealize Operations for Horizon\*
- HKLM\SOFTWARE\Wow6432Node\VMware, Inc.
- HKLM\SOFTWARE\Wow6432Node\VMware, Inc.\VMware VDM
Configuring TLS Certificates for Horizon 7 Servers

VMware strongly recommends that you configure TLS certificates for authentication of Connection Server instances, security servers, and View Composer service instances.

A default TLS server certificate is generated when you install Connection Server instances, security servers, or View Composer instances. You can use the default certificate for testing purposes.

Certificates used for communication between Connection Servers and also between Horizon Agents and Connection Server instances, are replaced using an automatic mechanism, and cannot be replaced manually. For more details, see the Horizon 7 Security document.

**Important** Replace the default certificate as soon as possible. The default certificate is not signed by a Certificate Authority (CA). Use of certificates that are not signed by a CA can allow untrusted parties to intercept traffic by masquerading as your server.

This chapter includes the following topics:

- Understanding TLS Certificates for Horizon 7 Servers
- Overview of Tasks for Setting Up TLS Certificates
- Obtaining a Signed TLS Certificate from a CA
- Configure Horizon Connection Server, Security Server, or View Composer to Use a New TLS Certificate
- Configure Client Endpoints to Trust Root and Intermediate Certificates
- Configuring Certificate Revocation Checking on Server Certificates
- Configure the PCoIP Secure Gateway to Use a New TLS Certificate
- Setting Horizon Administrator to Trust a vCenter Server or View Composer Certificate
- Benefits of Using TLS Certificates Signed by a CA
- Troubleshooting Certificate Issues on Horizon Connection Server and Security Server

**Understanding TLS Certificates for Horizon 7 Servers**

You must follow certain guidelines for configuring TLS certificates for Horizon 7 servers and related components.
Horizon Connection Server and Security Server

TLS is required for client connections to a server. Client-facing Connection Server instances, security servers, and intermediate servers that terminate TLS connections require TLS server certificates.

By default, when you install Connection Server or security server, the installation generates a self-signed certificate for the server. However, the installation uses an existing certificate in the following cases:

- If a valid certificate with a Friendly name of vdm already exists in the Windows Certificate Store
- If you upgrade to Horizon 7 from an earlier release, and a valid keystore file is configured on the Windows Server computer, the installation extracts the keys and certificates and imports them into the Windows Certificate Store.

vCenter Server and View Composer

Before you add vCenter Server and View Composer to Horizon 7 in a production environment, make sure that vCenter Server and View Composer use certificates that are signed by a CA.

For information about replacing the default certificate for vCenter Server, see "Replacing vCenter Server Certificates" on the VMware Technical Papers site at http://www.vmware.com/resources/techresources/.

If you install vCenter Server and View Composer on the same Windows Server host, they can use the same TLS certificate, but you must configure the certificate separately for each component.

PCoIP Secure Gateway

To comply with industry or jurisdiction security regulations, you can replace the default TLS certificate that is generated by the PCoIP Secure Gateway (PSG) service with a certificate that is signed by a CA. Configuring the PSG service to use a CA-signed certificate is highly recommended, particularly for deployments that require you to use security scanners to pass compliance testing. See Configure the PCoIP Secure Gateway to Use a New TLS Certificate.

Blast Secure Gateway

By default, the Blast Secure Gateway (BSG) uses the TLS certificate that is configured for the Connection Server instance or security server on which the BSG is running. If you replace the default, self-signed certificate for a server with a CA-signed certificate, the BSG also uses the CA-signed certificate.

SAML 2.0 Authenticator

VMware Identity Manager uses SAML 2.0 authenticators to provide Web-based authentication and authorization across security domains. If you want Horizon 7 to delegate authentication to VMware Identity Manager, you can configure Horizon 7 to accept SAML 2.0 authenticated sessions from VMware Identity Manager. When VMware Identity Manager is configured to support Horizon 7, VMware Identity Manager users can connect to remote desktops by selecting desktop icons on the Horizon User Portal.
In Horizon Administrator, you can configure SAML 2.0 authenticators for use with Connection Server instances.

Before you add a SAML 2.0 authenticator in Horizon Administrator, make sure that the SAML 2.0 authenticator uses a certificate that is signed by a CA.

**Additional Guidelines**

For general information about requesting and using TLS certificates that are signed by a CA, see [Benefits of Using TLS Certificates Signed by a CA](#).

When client endpoints connect to a Connection Server instance or security server, they are presented with the server's TLS server certificate and any intermediate certificates in the trust chain. To trust the server certificate, the client systems must have installed the root certificate of the signing CA.

When Connection Server communicates with vCenter Server and View Composer, Connection Server is presented with TLS server certificates and intermediate certificates from these servers. To trust the vCenter Server and View Composer servers, the Connection Server computer must have installed the root certificate of the signing CA.

Similarly, if a SAML 2.0 authenticator is configured for Connection Server, the Connection Server computer must have installed the root certificate of the signing CA for the SAML 2.0 server certificate.

**Overview of Tasks for Setting Up TLS Certificates**

To set up TLS server certificates for Horizon 7 servers, you must perform several high-level tasks.

In a pod of replicated Connection Server instances, you must perform these tasks on all instances in the pod.

The procedures for carrying out these tasks are described in the topics that follow this overview.

1. **Determine if you need to obtain a new signed TLS certificate from a CA.**

   If your organization already has a valid TLS server certificate, you can use that certificate to replace the default TLS server certificate provided with Connection Server, security server, or View Composer. To use an existing certificate, you also need the accompanying private key.

   **Starting Place** | **Action**
   --- | ---
   Your organization provided you with a valid TLS server certificate. | Go directly to step 2.
   You do not have an TLS server certificate. | Obtain a signed TLS server certificate from a CA.

2. **Import the TLS certificate into the Windows local computer certificate store on the Horizon 7 server host.**

3. **For Connection Server instances and security servers, modify the certificate Friendly name to vdm.**

   Assign the Friendly name `vdm` to only one certificate on each Horizon 7 server host.

4. **On Connection Server computers, if the root certificate is not trusted by the Windows Server host, import the root certificate into the Windows local computer certificate store.**
In addition, if the Connection Server instances do not trust the root certificates of the TLS server certificates configured for security server, View Composer, and vCenter Server hosts, you also must import those root certificates. Take these steps for Connection Server instances only. You do not have to import the root certificate to View Composer, vCenter Server, or security server hosts.

5 If your server certificate was signed by an intermediate CA, import the intermediate certificates into the Windows local computer certificate store.

To simplify client configuration, import the entire certificate chain into the Windows local computer certificate store. If intermediate certificates are missing from the Horizon 7 server, they must be configured for clients and computers that launch Horizon Administrator.

6 For View Composer instances, take one of these steps:

- If you import the certificate into the Windows local computer certificate store before you install View Composer, you can select your certificate during the View Composer installation.
- If you intend to replace an existing certificate or the default, self-signed certificate with a new certificate after you install View Composer, run the SviConfig ReplaceCertificate utility to bind the new certificate to the port used by View Composer.

7 If your CA is not well known, configure clients to trust the root and intermediate certificates.

Also ensure that the computers on which you launch Horizon Administrator trust the root and intermediate certificates.

8 Determine whether to reconfigure certificate revocation checking.

Connection Server performs certificate revocation checking on Horizon 7 servers, View Composer, and vCenter Server. Most certificates signed by a CA include certificate revocation information. If your CA does not include this information, you can configure the server not to check certificates for revocation.

If a SAML authenticator is configured for use with a Connection Server instance, Connection Server also performs certificate revocation checking on the SAML server certificate.

**Obtaining a Signed TLS Certificate from a CA**

If your organization does not provide you with an TLS server certificate, you must request a new certificate that is signed by a CA.

You can use several methods to obtain a new signed certificate. For example, you can use the Microsoft certreq utility to generate a Certificate Signing Request (CSR) and submit a certificate request to a CA.

See the *Scenarios for Setting Up TLS Certificates for Horizon 7* document for an example that shows you how to use certreq to accomplish this task.
For testing purposes, you can obtain a free temporary certificate based on an untrusted root from many CAs.

**Important** You must follow certain rules and guidelines when you obtain signed TLS certificates from a CA.

- When you generate a certificate request on a computer, make sure that a private key is generated also. When you obtain the TLS server certificate and import it into the Windows local computer certificate store, there must be an accompanying private key that corresponds to the certificate.

- To comply with VMware security recommendations, use the fully qualified domain name (FQDN) that client devices use to connect to the host. Do not use a simple server name or IP address, even for communications within your internal domain.

- Do not create certificates for servers using a certificate template that is compatible only with a Windows Server 2008 enterprise CA or later.

- Do not generate certificates for servers using a `KeyLength` value under 1024. Client endpoints will not validate a certificate on a server that was generated with a `KeyLength` under 1024, and the clients will fail to connect to the server. Certificate validations that are performed by Connection Server will also fail, resulting in the affected servers showing as red in the Horizon Administrator dashboard.

For general information about obtaining certificates, consult the Microsoft online help available with the Certificate Snap-in to MMC. If the Certificate Snap-in is not yet installed on your computer, see [Add the Certificate Snap-In to MMC](#).

**Obtain a Signed Certificate from a Windows Domain or Enterprise CA**

To obtain a signed certificate from a Windows Domain or Enterprise CA, you can use the Windows Certificate Enrollment wizard in the Windows Certificate Store.

This method of requesting a certificate is appropriate if communications between computers remain within your internal domain. For example, obtaining a signed certificate from a Windows Domain CA might be appropriate for server-to-server communications.

If your clients connect to Horizon 7 servers from an external network, request TLS server certificates that are signed by a trusted, third-party CA.

**Prerequisites**

- Determine the fully qualified domain name (FQDN) that client devices use to connect to the host. To comply with VMware security recommendations, use the FQDN, not a simple server name or IP address, even for communications within your internal domain.

- Verify that the Certificate snap-in was added to MMC. See [Add the Certificate Snap-In to MMC](#).

- Verify that you have the appropriate credentials to request a certificate that can be issued to a computer or service.
Procedure

1. In the **MMC** window on the Windows Server host, expand the **Certificates (local computer)** node and select the **Personal** folder.

2. From the **Action** menu, go to **All Tasks > Request New Certificate** to display the **Certificate Enrollment** wizard.


4. Select the types of certificates that you want to request, select the **Make private key exportable** option, and click **Enroll**.

5. Click **Finish**.

The new signed certificate is added to the **Personal > Certificates** folder in the Windows Certificate Store.

**What to do next**

- Verify that the server certificate and certificate chain were imported into the Windows Certificate Store.
- For a Connection Server instance or security server, modify the certificate friendly name to **vdm**. See **Modify the Certificate Friendly Name**.
- For a View Composer server, bind the new certificate to the port that used by View Composer. See **Bind a New TLS Certificate to the Port Used by View Composer**.

**Configure Horizon Connection Server, Security Server, or View Composer to Use a New TLS Certificate**

To configure a Connection Server instance, security server, or View Composer instance to use a TLS certificate, you must import the server certificate and the entire certificate chain into the Windows local computer certificate store on the Connection Server, security server, or View Composer host.

In a pod of replicated Connection Server instances, you must import the server certificate and certificate chain on all instances in the pod.

By default, the Blast Secure Gateway (BSG) uses the TLS certificate that is configured for the Connection Server instance or security server on which the BSG is running. If you replace the default, self-signed certificate for a View server with a CA-signed certificate, the BSG also uses the CA-signed certificate.

**Important** To configure Connection Server or security server to use a certificate, you must change the certificate Friendly name to **vdm**. Also, the certificate must have an accompanying private key.

If you intend to replace an existing certificate or the default, self-signed certificate with a new certificate after you install View Composer, you must run the **SviConfig ReplaceCertificate** utility to bind the new certificate to the port used by View Composer.
Procedure

1. **Add the Certificate Snap-In to MMC**
   Before you can add certificates to the Windows Certificate Store, you must add the Certificate snap-in to the Microsoft Management Console (MMC) on the Windows Server host on which the Horizon 7 server is installed.

2. **Import a Signed Server Certificate into a Windows Certificate Store**
   You must import the TLS server certificate into the Windows local computer certificate store on the Windows Server host on which the Connection Server instance or security server service is installed.

3. **Modify the Certificate Friendly Name**
   To configure a Connection Server instance or security server to recognize and use an TLS certificate, you must modify the certificate Friendly name to vdm.

4. **Import a Root Certificate and Intermediate Certificates into a Windows Certificate Store**
   If the Windows Server host on which Connection Server is installed does not trust the root certificate for the signed TLS server certificate, you must import the root certificate into the Windows local computer certificate store. In addition, if the Connection Server host does not trust the root certificates of the TLS server certificates configured for security server, View Composer, and vCenter Server hosts, you also must import those root certificates.

5. **Bind a New TLS Certificate to the Port Used by View Composer**
   If you configure a new TLS certificate after you install View Composer, you must run the SviConfig ReplaceCertificate utility to replace the certificate that is bound to the port used by View Composer. This utility unbinds the existing certificate and binds the new certificate to the port.

### Add the Certificate Snap-In to MMC

Before you can add certificates to the Windows Certificate Store, you must add the Certificate snap-in to the Microsoft Management Console (MMC) on the Windows Server host on which the Horizon 7 server is installed.

**Prerequisites**

Verify that the MMC and Certificate snap-in are available on the Windows Server computer on which the Horizon 7 server is installed.

**Procedure**

1. On the Windows Server computer, click **Start** and type **mmc.exe**.

2. In the **MMC** window, go to **File > Add/Remove Snap-in**.

3. In the **Add or Remove Snap-ins** window, select **Certificates** and click **Add**.

4. In the **Certificates snap-in** window, select **Computer account**, click **Next**, select **Local computer**, and click **Finish**.

5. In the **Add or Remove snap-in** window, click **OK**.
What to do next

Import the TLS server certificate into the Windows Certificate Store.

**Import a Signed Server Certificate into a Windows Certificate Store**

You must import the TLS server certificate into the Windows local computer certificate store on the Windows Server host on which the Connection Server instance or security server service is installed.

You also must perform this task on the Windows Server host where the View Composer service is installed.

Depending on your certificate file format, the entire certificate chain that is contained in the keystore file might be imported into the Windows local computer certificate store. For example, the server certificate, intermediate certificate, and root certificate might be imported.

For other types of certificate files, only the server certificate is imported into the Windows local computer certificate store. In this case, you must take separate steps to import the root certificate and any intermediate certificates in the certificate chain.

For more information about certificates, consult the Microsoft online help available with the Certificate snap-in to MMC.

**Note**  If you off-load TLS connections to an intermediate server, you must import the same TLS server certificate onto both the intermediate server and the off-loaded Horizon 7 server. For details, see "Off-load TLS Connections to Intermediate Servers" in the Horizon 7 Administration document.

**Prerequisites**

Verify that the Certificate snap-in was added to MMC. See Add the Certificate Snap-In to MMC.

**Procedure**

1. In the MMC window on the Windows Server host, expand the Certificates (Local Computer) node and select the Personal folder.
2. In the Actions pane, go to More Actions > All Tasks > Import.
3. In the Certificate Import wizard, click Next and browse to the location where the certificate is stored.
4. Select the certificate file and click Open.
   
   To display your certificate file type, you can select its file format from the File name drop-down menu.
5. Type the password for the private key that is included in the certificate file.
6. Select Mark this key as exportable.
7. Select Include all extended properties.
8. Click Next and click Finish.
   
   The new certificate appears in the Certificates (Local Computer) > Personal > Certificates folder.
9 Verify that the new certificate contains a private key.
   a In the Certificates (Local Computer) > Personal > Certificates folder, double-click the new certificate.
   b In the General tab of the Certificate Information dialog box, verify that the following statement appears: You have a private key that corresponds to this certificate.

What to do next
Modify the certificate Friendly name to *vdm*.

**Modify the Certificate Friendly Name**

To configure a Connection Server instance or security server to recognize and use an TLS certificate, you must modify the certificate Friendly name to *vdm*.

You do not have to modify the Friendly name of TLS certificates that are used by View Composer.

**Prerequisites**

Verify that the server certificate is imported into the Certificates (Local Computer) > Personal > Certificates folder in the Windows Certificate Store. See Import a Signed Server Certificate into a Windows Certificate Store.

**Procedure**

1 In the MMC window on the Windows Server host, expand the Certificates (Local Computer) node and select the Personal > Certificates folder.
2 Right-click the certificate that is issued to the Horizon 7 server host and click Properties.
3 On the General tab, delete the Friendly name text and type *vdm*.
4 Click Apply and click OK.
5 Verify that no other server certificates in the Personal > Certificates folder have a Friendly name of *vdm*.
   a Locate any other server certificate, right-click the certificate, and click Properties.
   b If the certificate has a Friendly name of *vdm*, delete the name, click Apply, and click OK.

What to do next

Import the root certificate and intermediate certificates into the Windows local computer certificate store.

After all certificates in the chain are imported, you must restart the Connection Server service or Security Server service to make your changes take effect.
Import a Root Certificate and Intermediate Certificates into a Windows Certificate Store

If the Windows Server host on which Connection Server is installed does not trust the root certificate for the signed TLS server certificate, you must import the root certificate into the Windows local computer certificate store. In addition, if the Connection Server host does not trust the root certificates of the TLS server certificates configured for security server, View Composer, and vCenter Server hosts, you also must import those root certificates.

If the Connection Server, security server, View Composer, and vCenter Server certificates are signed by a root CA that is known and trusted by the Connection Server host, and there are no intermediate certificates in your certificate chains, you can skip this task. Commonly used Certificate Authorities are likely to be trusted by the host.

You must import untrusted root certificates on all replicated Connection Server instances in a pod.

**Note**  You do not have to import the root certificate into View Composer, vCenter Server, or security server hosts.

If a server certificate is signed by an intermediate CA, you also must import each intermediate certificate in the certificate chain. To simplify client configuration, import the entire intermediate chain to security server, View Composer, and vCenter Server hosts as well as Connection Server hosts. If intermediate certificates are missing from a Connection Server or security server host, they must be configured for clients and computers that launch Horizon Administrator. If intermediate certificates are missing from a View Composer or vCenter Server host, they must be configured for each Connection Server instance.

If you already verified that the entire certificate chain is imported into the Windows local computer certificate store, you can skip this task.

**Note**  If a SAML authenticator is configured for use by a Connection Server instance, the same guidelines apply to the SAML 2.0 authenticator. If the Connection Server host does not trust the root certificate configured for a SAML authenticator, or if the SAML server certificate is signed by an intermediate CA, you must ensure that the certificate chain is imported into the Windows local computer certificate store.

**Procedure**

1. In the MMC console on the Windows Server host, expand the **Certificates (Local Computer)** node and go to the **Trusted Root Certification Authorities > Certificates** folder.
   - If your root certificate is in this folder, and there are no intermediate certificates in your certificate chain, skip to step 7.
   - If your root certificate is not in this folder, proceed to step 2.

2. Right-click the **Trusted Root Certification Authorities > Certificates** folder and click **All Tasks > Import**.
3 In the **Certificate Import** wizard, click **Next** and browse to the location where the root CA certificate is stored.

4 Select the root CA certificate file and click **Open**.

5 Click **Next**, click **Next**, and click **Finish**.

6 If your server certificate was signed by an intermediate CA, import all intermediate certificates in the certificate chain into the Windows local computer certificate store.
   a Go to the **Certificates (Local Computer) > Intermediate Certification Authorities > Certificates** folder.
   b Repeat steps 3 through 6 for each intermediate certificate that must be imported.

7 Restart the Connection Server service, Security Server service, View Composer service, or vCenter Server service to make your changes take effect.

### Bind a New TLS Certificate to the Port Used by View Composer

If you configure a new TLS certificate after you install View Composer, you must run the `SviConfig ReplaceCertificate` utility to replace the certificate that is bound to the port used by View Composer. This utility unbinds the existing certificate and binds the new certificate to the port.

If you install the new certificate on the Windows Server computer before you install View Composer, you do not have to run the `SviConfig ReplaceCertificate` utility. When you run the View Composer installer, you can select a certificate signed by a CA instead of the default, self-signed certificate. During the installation, the selected certificate is bound to the port used by View Composer.

If you intend to replace an existing certificate or the default, self-signed certificate with a new certificate, you must use the `SviConfig ReplaceCertificate` utility.

**Prerequisites**

Verify that the new certificate was imported into the Windows local computer certificate store on the Windows Server computer on which View Composer is installed.

**Procedure**

1 Stop the View Composer service.

2 Open a command prompt on the Windows Server host where View Composer is installed.

3 Navigate to the `SviConfig` executable file.

   The file is located with the View Composer application. The default path is `C:\Program Files (x86)\VMware\VMware View Composer\sviconfig.exe`. 
4 Type the SviConfig ReplaceCertificate command.
   For example:
   ```
   sviconfig -operation=ReplaceCertificate
             -delete=false
   ```
   where -delete is a required parameter that operates on the certificate that is being replaced. You
   must specify either -delete=true to delete the old certificate from the Windows local computer
certificate store or -delete=false to keep the old certificate in the Windows certificate store.

   The utility displays a numbered list of TLS certificates that are available in the Windows local
   computer certificate store.

5 To select a certificate, type the number of a certificate and press Enter.

6 Restart the View Composer service to make your changes take effect.

**Example: SviConfig ReplaceCertificate**

The following example replaces the certificate that is bound to the View Composer port:
   ```
   sviconfig -operation=ReplaceCertificate
             -delete=false
   ```

**Configure Client Endpoints to Trust Root and Intermediate Certificates**

If a Horizon 7 server certificate is signed by a CA that is not trusted by client computers and client
computers that access Horizon Administrator, you can configure all Windows client systems in a domain
to trust the root and intermediate certificates. To do so, you must add the public key for the root certificate
to the Trusted Root Certification Authorities group policy in Active Directory and add the root certificate to
the Enterprise NTAuth store.

For example, you might have to take these steps if your organization uses an internal certificate service.

You do not have to take these steps if the Windows domain controller acts as the root CA, or if your
certificates are signed by a well known CA. For well known CAs, the operating system vendors preinstall
the root certificate on client systems.

If your server certificates are signed by a little-known intermediate CA, you must add the intermediate
certificate to the Intermediate Certification Authorities group policy in Active Directory.

For client devices that use other operating systems than Windows, see the following instructions for
distributing root and intermediate certificates that users can install:

- For Horizon Client for Mac, see Configure Horizon Client for Mac to Trust Root and Intermediate
  Certificates.

- For Horizon Client for iOS, see Configure Horizon Client for iOS to Trust Root and Intermediate
  Certificates.
For Horizon Client for Android, see documentation on the Google Web site, such as the Android 3.0 User's Guide

For Horizon Client for Linux, see the Ubuntu documentation

Prerequisites

Verify that the server certificate was generated with a KeyLength value of 1024 or larger. Client endpoints will not validate a certificate on a server that was generated with a KeyLength under 1024, and the clients will fail to connect to the server.

Procedure

1. On your Active Directory server, use the certutil command to publish the certificate to the Enterprise NTAuth store.

   For example: `certutil -ds publish -f path_to_root_CA_cert NTAuthCA`

2. On the Active Directory server, navigate to the Group Policy Management plug-in.


4. Import the certificate.

   **Option** | **Description** |
   --- | --- |
   **Root certificate** | a Right-click Trusted Root Certification Authorities and select Import.  
                           b Follow the prompts in the wizard to import the root certificate (for example, rootCA.cer) and click OK. |
   **Intermediate certificate** | a Right-click Intermediate Certification Authorities and select Import.  
                                  b Follow the prompts in the wizard to import the intermediate certificate (for example, intermediateCA.cer) and click OK. |

5. Close the Group Policy window.
All systems in the domain now have certificate information in their trusted root certificate stores and intermediate certificate stores that allows them to trust the root and intermediate certificates.

**Configure Horizon Client for Mac to Trust Root and Intermediate Certificates**

If a server certificate is signed by a CA that is not trusted by computers that run Horizon Client for Mac, you can configure these computers to trust the root and intermediate certificates. You must distribute the root certificate and all intermediate certificates in the trust chain to the client computers.

**Procedure**

1. Deliver the root certificate and intermediate certificates to the computer that is running Horizon Client for Mac.
2. Open the root certificate on the Mac computer.
   
   The certificate displays the following message: Do you want your computer to trust certificates signed by CA name from now on?
3. Click **Always Trust**
4. Type the user password.
5. Repeat steps 2 through 4 for all intermediate certificates in the trust chain.

**Configure Horizon Client for iOS to Trust Root and Intermediate Certificates**

If a server certificate is signed by a CA that is not trusted by iPads and iPhones that run Horizon Client for iOS, you can configure the device to trust the root and intermediate certificates. You must distribute the root certificate and all intermediate certificates in the trust chain to the devices.

**Procedure**

1. Send the root certificate and intermediate certificates as email attachments to the iPad.
2. Open the email attachment for the root certificate and select **Install**.
   
   The certificate displays the following message:

   Unverifiable Profile. The authenticity of Certificate name cannot be verified. Installing this profile will change settings on your iPad.

   Root Certificate. Installing the certificate Certificate name will add it to the list of trusted certificates on your iPad.

3. Select **Install** again.
4. Repeat steps 2 and 3 for all intermediate certificates in the trust chain.
Configuring Certificate Revocation Checking on Server Certificates

Each Connection Server instance performs certificate revocation checking on its own certificate and on those of the security servers paired to it. Each instance also checks the certificates of vCenter and View Composer servers whenever it establishes a connection to them. By default, all certificates in the chain are checked except the root certificate. You can, however, change this default.

If a SAML 2.0 authenticator is configured for use by a Connection Server instance, Connection Server also performs certificate revocation checking on the SAML 2.0 server certificate.

Horizon 7 supports various means of certificate revocation checking, such as certificate revocation lists (CRLs) and the Online Certificate Status Protocol (OCSP). A CRL is a list of revoked certificates published by the CA that issued the certificates. OCSP is a certificate validation protocol that is used to get the revocation status of an X.509 certificate.

With CRLs, the list of revoked certificates is downloaded from a certificate distribution point (DP) that is often specified in the certificate. The server periodically goes to the CRL DP URL specified in the certificate, downloads the list, and checks it to determine whether the server certificate has been revoked. With OCSP, the server sends a request to an OCSP responder to determine the revocation status of the certificate.

When you obtain a server certificate from a third-party certificate authority (CA), the certificate includes one or more means by which its revocation status can be determined, including, for example, a CRL DP URL or the URL for an OCSP responder. If you have your own CA and generate a certificate but do not include revocation information in the certificate, the certificate revocation check fails. An example of revocation information for such a certificate could include, for example, a URL to a Web-based CRL DP on a server where you host a CRL.

If you have your own CA but do not or cannot include certificate revocation information in your certificate, you can choose not to check certificates for revocation or to check only certain certificates in a chain. On the server, with the Windows Registry Editor, you can create the string (REG_SZ) value CertificateRevocationCheckType, under HKLM\Software\VMware, Inc.\VMware VDM\Security, and set this value to one of the following data values.

<table>
<thead>
<tr>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Do not perform certificate revocation checking.</td>
</tr>
<tr>
<td>2</td>
<td>Check only the server certificate. Do not check any other certificates in the chain.</td>
</tr>
<tr>
<td>3</td>
<td>Check all certificates in the chain.</td>
</tr>
<tr>
<td>4</td>
<td>(Default) Check all certificates except the root certificate.</td>
</tr>
</tbody>
</table>
If this registry value is not set, or if the value set is not valid (that is, if the value is not 1, 2, 3, or 4), all certificates are checked except the root certificate. Set this registry value on each server on which you intend to modify revocation checking. You do not have to restart the system after you set this value.

**Note** If your organization uses proxy settings for Internet access, you might have to configure your Connection Server computers to use the proxy settings to ensure that certificate revocation checking can be performed for security servers or Connection Server instances that are used for secure client connections. If a Connection Server instance cannot access the Internet, certificate revocation checking might fail, and the Connection Server instance or paired security servers might show up as red on the Horizon Administrator dashboard. To resolve this issue, see “Troubleshooting Security Server Certificate Revocation Checking” in the *Horizon 7 Administration* document.

---

**Configure the PCoIP Secure Gateway to Use a New TLS Certificate**

To comply with industry or jurisdiction security regulations, you can replace the default TLS certificate that is generated by the PCoIP Secure Gateway (PSG) service with a certificate that is signed by a CA.

In Horizon 7, the PSG service creates a default, self-signed TLS certificate when the service starts up. The PSG service presents the self-signed certificate to clients running Horizon Client 2.0 (or Horizon Client 5.2 for Windows) or later releases that connect to the PSG.

The PSG also provides a default legacy TLS certificate that is presented to clients running older clients or earlier releases that connect to the PSG.

The default certificates provide secure connections from client endpoints to the PSG and do not require further configuration in Horizon Administrator. However, configuring the PSG service to use a CA-signed certificate is highly recommended, particularly for deployments that require you to use security scanners to pass compliance testing.

Although it is not required, you are most likely to configure new CA-signed TLS certificates for your servers before you replace the default PSG certificate with a CA-signed certificate. The procedures that follow assume that you already imported a CA-signed certificate into the Windows certificate store for the server on which the PSG is running.

**Note** If you are using a security scanner for compliance testing, you might want to start by setting the PSG to use the same certificate as the server and scan the View port before the PSG port. You can resolve trust or validation issues that occur during the scan of the View port to ensure that these issues do not invalidate your test of the PSG port and certificate. Next, you can configure a unique certificate for the PSG and do another scan.
Procedure

1  **Verify That the Server Name Matches the PSG Certificate Subject Name**
   When a Connection Server instance or security server is installed, the installer creates a registry setting with a value that contains the FQDN of the computer. You must verify that this value matches the server name part of the URL that security scanners use to reach the PSG port. The server name also must match the subject name or a subject alternate name (SAN) of the TLS certificate that you intend to use for the PSG.

2  **Configure a PSG Certificate in the Windows Certificate Store**
   To replace the default PSG certificate with a CA-signed certificate, you must configure the certificate and its private key in the Windows local computer certificate store on the Connection Server or security server computer on which the PSG is running.

3  **Set the PSG Certificate Friendly Name in the Windows Registry**
   The PSG identifies the TLS certificate to use by means of the server name and certificate Friendly name. You must set the Friendly name value in the Windows registry on the Connection Server or security server computer on which the PSG is running.

4  **(Optional) Force a CA-Signed Certificate to Be Used for Connections to the PSG**
   You can ensure that all client connections to the PSG use the CA-signed certificate for the PSG instead of the default legacy certificate. This procedure is not required to configure a CA-signed certificate for the PSG. Take these steps only if it makes sense to force the use of a CA-signed certificate in your Horizon 7 deployment.

**Verify That the Server Name Matches the PSG Certificate Subject Name**

When a Connection Server instance or security server is installed, the installer creates a registry setting with a value that contains the FQDN of the computer. You must verify that this value matches the server name part of the URL that security scanners use to reach the PSG port. The server name also must match the subject name or a subject alternate name (SAN) of the TLS certificate that you intend to use for the PSG.

For example, if a scanner connects to the PSG with the URL `https://view.customer.com:4172`, the registry setting must have the value `view.customer.com`. Note that the FQDN of the Connection Server or security server computer that is set during installation might not be the same as this external server name.

**Procedure**

1  Start the Windows Registry Editor on the Connection Server or security server host where the PCoIP Secure Gateway is running.

2  Navigate to the `HKEY_LOCAL_MACHINE\SOFTWARE\Teradici\SecurityGateway\SSLCertPsgSni` registry setting.
3 Verify that the value of the **SSLCertPsgSni** setting matches the server name in the URL that scanners will use to connect to the PSG and matches the subject name or a subject alternate name of the TLS certificate that you intend to install for the PSG.

   If the value does not match, replace it with the correct value.

4 Restart the VMware Horizon View PCoIP Secure Gateway service to make your changes take effect.

**What to do next**

Import the CA-signed certificate into the Windows local computer certificate store and configure the certificate Friendly name.

**Configure a PSG Certificate in the Windows Certificate Store**

To replace the default PSG certificate with a CA-signed certificate, you must configure the certificate and its private key in the Windows local computer certificate store on the Connection Server or security server computer on which the PSG is running.

If you intend the PSG to use a unique certificate, you must import the certificate into the Windows local computer certificate store with an exportable private key and set the appropriate Friendly name.

If you intend the PSG to use the same certificate as the server, you do not have to follow this procedure. However, in the Windows registry you must set the server name to match the server certificate subject name and set the Friendly name to **vdm**.

**Prerequisites**

- Verify that the key length is at least 1024 bits.
- Verify that the TLS certificate is valid. The current time on the server computer must be within the certificate start and end dates.
- Verify that the certificate subject name or a subject alternate name matches the **SSLCertPsgSni** setting in the Windows registry. See Verify That the Server Name Matches the PSG Certificate Subject Name.
- Verify that the Certificate snap-in was added to MMC. See Add the Certificate Snap-In to MMC.
- Familiarize yourself with importing a certificate into the Windows certificate store. See Import a Signed Server Certificate into a Windows Certificate Store.
- Familiarize yourself with modifying the certificate Friendly name. See Modify the Certificate Friendly Name.

**Procedure**

1 In the MMC window on the Windows Server host, open the **Certificates (Local Computer) > Personal** folder.
2 Import the TLS certificate that is issued to the PSG by selecting **More Actions > All Tasks > Import**.

Select the following settings in the **Certificate Import** wizard:

a  **Mark this key as exportable**
b  **Include all extendable properties**

Complete the wizard to finish importing the certificate into the **Personal** folder.

3 Verify that the new certificate contains a private key by taking one of these steps:

- Verify that a yellow key appears on the certificate icon.
- Double-click the certificate and verify that the following statement appears in the Certificate Information dialog box: You have a private key that corresponds to this certificate.

4 Right-click the new certificate and click **Properties**.

5 On the General tab, delete the **Friendly name** text and type the Friendly name that you have chosen.

Make sure that you enter exactly the same name in the SSLCertWinCertFriendlyName setting in the Windows registry, as described in the next procedure.

6 Click **Apply** and click **OK**.

The PSG presents the CA-signed certificate to client devices that connect to the server over PCoIP.

**Note**  This procedure does not affect legacy client devices. The PSG continues to present the default legacy certificate to legacy client devices that connect the this server over PCoIP.

**What to do next**

Configure the certificate Friendly name in the Windows registry.

**Set the PSG Certificate Friendly Name in the Windows Registry**

The PSG identifies the TLS certificate to use by means of the server name and certificate Friendly name. You must set the Friendly name value in the Windows registry on the Connection Server or security server computer on which the PSG is running.

The certificate Friendly name *vdm* is used by all Connection Server instances and security servers. By contrast, you can configure your own certificate Friendly name for the PSG certificate. You must configure a Windows registry setting to enable the PSG to match the correct name with the Friendly name that you will set in the Windows certificate store.

The PSG can use the same TLS certificate as the server on which the PSG is running. If you configure the PSG to use the same certificate as the server, the Friendly name must be *vdm*.

The Friendly name value, in both the registry and the Windows certificate store, is case sensitive.
Prerequisites

- Verify that the Window registry contains the correct subject name that is used to reach the PSG port and that matches the PSG certificate subject name or subject alternate name. See Verify That the Server Name Matches the PSG Certificate Subject Name.
- Verify that the certificate Friendly name is configured in the Windows local computer certificate store. See Configure a PSG Certificate in the Windows Certificate Store.

Procedure

1. Start the Windows Registry Editor on the Connection Server or security server computer where the PCoIP Secure Gateway is running.
2. Navigate to the HKEY_LOCAL_MACHINE\SOFTWARE\Teradici\SecurityGateway registry key.
3. Add a new String (REG_SZ) value, SSLCertWinCertFriendlyName, to this registry key.
4. Modify the SSLCertWinCertFriendlyName value and type the certificate Friendly name to be used by the PSG.
   For example: pcoip
   If you use the same certificate as the server, the value must be vdm.
5. Restart the VMware Horizon View PCoIP Secure Gateway service to make your changes take effect.

What to do next

Verify that client devices continue to connect to the PSG.
If you are using a security scanner for compliance testing, scan the PSG port.

(Optional) Force a CA-Signed Certificate to Be Used for Connections to the PSG

You can ensure that all client connections to the PSG use the CA-signed certificate for the PSG instead of the default legacy certificate. This procedure is not required to configure a CA-signed certificate for the PSG. Take these steps only if it makes sense to force the use of a CA-signed certificate in your Horizon 7 deployment.

In some cases, the PSG might present the default legacy certificate instead of the CA-signed certificate to a security scanner, invalidating the compliance test on the PSG port. To resolve this issue, you can configure the PSG not to present the default legacy certificate to any device that attempts to connect.

**Important** Performing this procedure prevents all legacy clients from connecting to this server over PCoIP.

Prerequisites

Verify that all client devices that connect to this server, including thin clients, run Horizon Client 5.2 for Windows or Horizon Client 2.0 or later releases. You must upgrade the legacy clients.
Procedure

1. Start the Windows Registry Editor on the Connection Server or security server computer where the PCoIP Secure Gateway is running.
2. Navigate to the `HKEY_LOCAL_MACHINE\SOFTWARE\Teradici\SecurityGateway` registry key.
3. Add a new String (REG_SZ) value, `SSLCertPresentLegacyCertificate`, to this registry key.
4. Set the `SSLCertPresentLegacyCertificate` value to 0.
5. Restart the VMware Horizon View PCoIP Secure Gateway service to make your changes take effect.

Setting Horizon Administrator to Trust a vCenter Server or View Composer Certificate

In the Horizon Administrator dashboard, you can configure Horizon 7 to trust a vCenter Server or View Composer certificate that is untrusted.

VMware strongly recommends that you configure vCenter Server and View Composer to use TLS certificates that are signed by a CA. Alternatively, you can accept the thumbprint of the default certificate for vCenter Server or View Composer.

Similarly, VMware recommends that you configure SAML 2.0 authenticators to use TLS certificates that are signed by a CA. Alternatively, in the Horizon Administrator dashboard you can configure Horizon 7 to trust an untrusted SAML 2.0 server certificate by accepting the thumbprint of the default certificate.

Benefits of Using TLS Certificates Signed by a CA

A CA is a trusted entity that guarantees the identity of the certificate and its creator. When a certificate is signed by a trusted CA, users no longer receive messages asking them to verify the certificate, and thin client devices can connect without requiring additional configuration.

You can request an TLS server certificate that is specific to a Web domain such as `www.mycorp.com`, or you can request a wildcard TLS server certificate that can be used throughout a domain such as `*.mycorp.com`. To simplify administration, you might choose to request a wildcard certificate if you need to install the certificate on multiple servers or in different subdomains.

Typically, domain-specific certificates are used in secure installations, and CAs usually guarantee more protection against losses for domain-specific certificates than for wildcard certificates. If you use a wildcard certificate that is shared with other services, the security of the Horizon 7 product also depends on the security of those other services. If you use a wildcard certificate, you must ensure that the private key is transferrable between servers.

When you replace the default certificate with your own certificate, clients use your certificate to authenticate the server. If your certificate is signed by a CA, the certificate for the CA itself is typically embedded in the browser or is located in a trusted database that the client can access. After a client accepts the certificate, it responds by sending a secret key, which is encrypted with the public key contained in the certificate. The secret key is used to encrypt traffic between the client and the server.
Troubleshooting Certificate Issues on Horizon Connection Server and Security Server

Certificate issues on a Horizon 7 server prevent you from connecting to Horizon Administrator or cause a red health indicator to be displayed for a server.

Problem

You cannot connect to Horizon Administrator on the Connection Server instance with the problem. When you connect to Horizon Administrator on another Connection Server instance in the same pod, you see that the dashboard health indicator is red for the problem Connection Server instance.

From the other Connection Server instance, clicking the red health indicator displays SSL Certificate: Invalid and Status: (blank), indicating that a valid certificate could not be found. The Horizon 7 log file contains a log entry of type ERROR with the following error text:

```
No qualifying certificates in keystore.
```

The Horizon 7 log data is located in `C:\ProgramData\VMware\VDM\logs\log-*.txt` on the Connection Server instance.

Cause

A certificate might not be installed successfully on a Horizon 7 server for any of the following reasons:

- The certificate is not in the Personal folder in the Windows local computer certificate store.
- The certificate store does not have a private key for the certificate.
- The certificate does not have a friendly name of `vdm`.
- The certificate was generated from a v3 certificate template, for a Windows Server 2008 or later server. Horizon 7 cannot detect a private key, but if you use the Certificate snap-in to examine the Windows certificate store, the store indicates that there is a private key.

Solution

- Verify that the certificate is imported into the Personal folder in the Windows local computer certificate store.
  
  See Import a Signed Server Certificate into a Windows Certificate Store.

- Verify that the certificate contains a private key.
  
  See Import a Signed Server Certificate into a Windows Certificate Store.

- Verify that the certificate has a friendly name of `vdm`.
  
  See Modify the Certificate Friendly Name.

- If the certificate was generated from a v3 certificate template, obtain a valid, signed certificate from a CA that does not use a v3 template.
  
  See Obtaining a Signed TLS Certificate from a CA.
Enabling Horizon 7 for Subscription Licenses

You can deploy Horizon 7 subscription licenses for use with your Horizon 7 deployment on-premises or on VMware Cloud on AWS.

The Horizon 7 subscription license provides the same product with better deployment flexibility. Horizon 7 subscription licenses enable Horizon 7 deployment in the datacenter, private cloud, and on VMware Horizon Cloud Service.

This chapter includes the following topics:

- VMware Horizon 7 Cloud Connector
- Deploy the Horizon 7 Cloud Connector Virtual Appliance with Horizon 7
- Configure a CA-Signed Certificate for the Horizon 7 Cloud Connector Virtual Appliance

VMware Horizon 7 Cloud Connector

The Horizon 7 Cloud Connector is a virtual appliance that connects a Horizon 7 pod with VMware Horizon Cloud Service. Horizon 7 Cloud Connector is a required component that bridges your Horizon 7 pods with VMware Horizon Cloud Service. The Horizon 7 Cloud Connector is required for cloud-hosted services including Horizon 7 subscription licenses, health status dashboard, and Horizon Help Desk Tool.

You must have an active My VMware account to purchase a Horizon 7 license from https://my.vmware.com. You then receive a subscription email with the link to download the Horizon 7 Cloud Connector as an OVA file.

When you deploy the Horizon 7 Cloud Connector virtual appliance from vSphere Web Client, you pair the Cloud Connector with the Connection Server pod you want to connect to Horizon Cloud Service. As part of the pairing process, the Horizon 7 Cloud Connector virtual appliance connects the Connection Server to Horizon Cloud Service to manage the Horizon 7 subscription license and other services. With a Horizon 7 subscription license, you do not need to manually enter a Horizon 7 license key for the VMware Horizon 7 product activation. However, you do need to use the license keys to activate supporting components such as vSphere, App Volumes, and others.

Note The Horizon 7 Cloud Connector virtual appliance does not support an IPv6 environment.
Deploy the Horizon 7 Cloud Connector Virtual Appliance with Horizon 7

After you purchase a subscription license, you will receive a license subscription email, which includes the link to download the Horizon 7 Cloud Connector virtual appliance. You can install and pair the Horizon 7 Cloud Connector virtual appliance with a Connection Server in a pod.

Prerequisites

- Horizon 7 version 7.6 or later.
- You must have a My VMware account on https://my.vmware.com to purchase a Horizon 7 subscription license.
- Download the Horizon 7 Cloud Connector virtual appliance from the subscription license email that you received from my.vmware.com.
- Verify the Connection Server that you want to pair the Horizon 7 Cloud Connector virtual appliance with. You can pair the Horizon 7 Cloud Connector virtual appliance with only one Connection Server that is installed in an on-premises pod at a time.
- If the Horizon 7 Cloud Connector virtual appliance is not part of the Active Directory domain to which Connection Server is joined, add the FQDN of the Connection Server that you want to pair with Horizon 7 Cloud Connector to the /etc/hosts file on the Horizon 7 Cloud Connector virtual appliance.
- If you use the Microsoft Internet Explorer Web browser, verify that the compatibility mode is off to view the Horizon 7 Cloud Connector appliance user interface.
- Deploy and join the Horizon 7 Cloud Connector virtual appliance with Static IP to Active Directory. Add the forward and reverse lookup entry of the Horizon 7 Cloud Connector virtual appliance in the DNS of your Active Directory before you begin the deployment.

Procedure

1. Download the Horizon 7 Cloud Connector appliance from the link provided in the subscription email for your account. The Horizon 7 Cloud Connector appliance is available to download as an OVA file.
2. Use vSphere Web Client to deploy the Horizon 7 Cloud Connector appliance as an OVF template. For more information about deploying OVF templates, see the vSphere Virtual Machine Administration documentation.

   **Note**  When you enter a root password for the OVF template, you must verify that the password contains a minimum of eight characters with one capital, one numeric, and one special character.

3. In vSphere Web Client, power on the Horizon 7 Cloud Connector appliance.
   
   The Horizon 7 Cloud Connector appliance user interface IP address appears.
4 In a Web browser, enter the Horizon 7 Cloud Connector appliance IP address to log in to the Horizon 7 Cloud Connector user interface.

Use your My VMware account credentials to log in.

5 Connect the Horizon 7 Cloud Connector appliance with the Connection Server instance on-premises. In the Connect to Horizon 7 Connection Server box, enter the FQDN of the Connection Server that is hosted on-premises, and click Connect.

6 Click the check box to verify the thumbprint certificate for the Connection Server.

   Note  This verification is skipped if the Connection Server has a valid Root CA certificate.

7 Enter the domain name, user name, and password for the Connection Server and click Connect.

   Note  For better auditing of Horizon 7 Cloud Connector actions, use a unique user name and password for the Connection Server.

8 Optionally, if the Connection Server is already paired with another Horizon 7 Cloud Connector appliance, click Accept to delete the existing pairing and pair it with the Horizon 7 Cloud Connector appliance you downloaded.

9 To set up the Horizon 7 pod on the Horizon Cloud Service enter a name for the node, select data center location, and enter an optional description.

   The Horizon 7 pod is successfully paired with the VMware Horizon Cloud Service.

10 Optionally, to reconfigure the Connection Server details in the same pod, click Reconfigure and follow the steps to complete the wizard.

11 Optionally, to remove the connection between the Connection Server on-premises and the Horizon Cloud Service, click Unplug.

   Note  Do not delete the Horizon 7 Cloud Connector virtual appliance from vCenter Server before you click Unplug.

What to do next

- View the subscription license details in Horizon Administrator. For more information, see the Horizon 7 Administration document.

- If you need to upgrade to the latest version of the Horizon 7 Cloud Connector virtual appliance, see the Horizon 7 Upgrades document.

- To login to the Horizon Cloud Administration Console, see the VMware Horizon Cloud Service on Microsoft Azure Administration Guide available at https://docs.vmware.com/en/VMware-Horizon-Cloud-Service/index.html.
Configure a CA-Signed Certificate for the Horizon 7 Cloud Connector Virtual Appliance

For enhanced security, you can configure a custom CA-signed certificate for the Horizon 7 Cloud Connector virtual appliance.

**Prerequisites**

- Verify that the full certificate chain is available in the PEM format.
- Verify that the private key is available in the PEM format.
- Verify that the FQDN and Subject Alt Name is included in the issued certificate.

**Procedure**

1. Open an SSH session to the Horizon 7 Cloud Connector virtual appliance.
2. Copy the CA-signed certificate in the directory `/root/server.crt`.
3. Copy the CA-signed key in the directory `/root/server.key`.
4. Back up the existing certificate.
   Use the following command:
   ```bash
   cp /etc/nginx/ssl/server.crt /etc/nginx/ssl/server.crt.orig
   ```
5. Back up the existing key.
   Use the following command:
   ```bash
   cp /etc/nginx/ssl/server.key /etc/nginx/ssl/server.key.orig
   ```
6. Copy the existing `nginx.conf` file.
   Use the following command:
   ```bash
   cp /etc/nginx/nginx.conf /etc/nginx/nginx.conf.orig
   ```
7. Copy the CA certificate in the `/etc/nginx/ssl` directory.
   Use the following command:
   ```bash
   cp /root/server.crt /etc/nginx/ssl/server.crt
   ```
8. Copy the CA certificate key file in the `/etc/nginx/ssl` directory.
   Use the following command:
   ```bash
   cp /root/server.key /etc/nginx/ssl/server.key
   ```
9 Verify the owner and permission for the certificate and key file.

Use the following commands:

```bash
chown -R root:root /etc/nginx/ssl
chmod -R 600 /etc/nginx/ssl
```

10 Verify that the issued FQDN in the certificate matches the server name directive in the server listen 443 block in the nginx configuration file at /etc/nginx/nginx.conf.

11 Check and restart nginx.

Use the following commands:

```bash
nginx -t
systemctl restart nginx
```

12 Test the new certificate by reloading the Horizon 7 Cloud Connector user interface URL in a Web browser.

13 (Optional) If the certificate works correctly, remove the backed up files.

Use the following commands:

```bash
rm /etc/nginx/ssl/server.crt.orig
rm /etc/nginx/ssl/server.key.orig
rm /etc/nginx/nginx.conf.orig
```

14 Remove the copied CA certificates and key files in the root directory.

Use the following commands:

```bash
rm /root/server.crt
rm /root/server.key
```
Configuring Horizon 7 for the First Time

After you install the Horizon 7 server software and configure SSL certificates for the servers, you must take a few additional steps to set up a working Horizon 7 environment.

You configure user accounts for vCenter Server and View Composer, install a Horizon 7 license key, add vCenter Server and View Composer to your Horizon 7 environment, configure the PCoIP Secure Gateway and secure tunnel, and, optionally, size Windows Server settings to support your Horizon 7 environment.

This chapter includes the following topics:

- Configuring User Accounts for vCenter Server, View Composer, and Instant Clones
- Configuring Horizon Connection Server for the First Time
- Configuring Horizon Client Connections
- Replacing Default Ports for Horizon 7 Services
- Sizing Windows Server Settings to Support Your Deployment

Configuring User Accounts for vCenter Server, View Composer, and Instant Clones

To use vCenter Server with Horizon 7, you must configure a user account with appropriate vCenter Server privileges. You can create a vCenter Server role with the appropriate privileges and assign that role to the vCenter Server user account.

If you install View Composer on a different machine than vCenter Server, you also must create a user account in Active Directory that Horizon 7 can use to authenticate to the View Composer service on the standalone machine.

If you use View Composer, you must create a third user account in Active Directory that allows View Composer to perform certain operations in Active Directory. View Composer requires this account to join linked-clone virtual machines to your Active Directory domain. See Create a User Account for View Composer AD Operations.

If you use instant clones, you must create a user account in Active Directory that allows Connection Server to perform certain operations in Active Directory. Connection Server requires this account to join instant-clone virtual machines to your Active Directory domain. See Create a User Account for Instant-Clone Operations.
To summarize, when you configure Horizon 7 for the first time, you provide these user accounts in Horizon Administrator:

- The vCenter Server user allows Horizon 7 and View Composer to perform operations in vCenter Server.
- The standalone View Composer Server user allows Horizon 7 to authenticate to the View Composer service on a standalone machine.

If you install View Composer on the same machine as vCenter Server, the vCenter Server user performs both of the preceding functions, and you do not use a standalone View Composer Server user.

- The View Composer user for AD operations allows View Composer to perform certain operations in Active Directory.
- The instant clone user for AD operations allows Connection Server to perform certain operations in Active Directory.

**Where to Use the vCenter Server User and View Composer Users**

After you create and configure these user accounts, you specify the user names in Horizon Administrator.

- You specify a vCenter Server user when you add vCenter Server to Horizon 7.
- You specify a standalone View Composer Server user when you configure View Composer settings and select **Standalone View Composer Server**.
- You specify a View Composer user for AD operations when you configure View Composer domains.
- You specify the View Composer user for AD operations when you create linked-clone pools.

**Configure a vCenter Server User for Horizon 7 and View Composer**

To configure a user account that allows Horizon 7 to perform operations in vCenter Server, you must assign a vCenter Server role with appropriate privileges to that user.

The list of privileges that you must add to the vCenter Server role varies, depending on whether you use Horizon 7 with or without View Composer. The View Composer service performs operations in vCenter Server that require privileges in addition to the base privileges.

If you install View Composer on the same machine as vCenter Server, you must make the vCenter Server user a local system administrator on the vCenter Server machine. This requirement allows Horizon 7 to authenticate to the View Composer service.

If you install View Composer on a different machine than vCenter Server, you do not have to make the vCenter Server user a local administrator on the vCenter Server machine. However, you do have to create a standalone View Composer Server user account that must be a local administrator on the View Composer machine.
Prerequisites

- In Active Directory, create a user in the Connection Server domain or a trusted domain. See Creating a User Account for vCenter Server.
- Familiarize yourself with the vCenter Server privileges that are required for the user account. See Privileges Required for the vCenter Server User.
- If you use View Composer, familiarize yourself with the additional required privileges. See View Composer and Instant Clone Privileges Required for the vCenter Server User.

Procedure

1. In vCenter Server, prepare a role with the required privileges for the user.
   - You can use the predefined Administrator role in vCenter Server. This role can perform all operations in vCenter Server.
   - If you use View Composer, you can create a limited role with the minimum privileges needed by Connection Server and View Composer to perform vCenter Server operations.
     In vSphere Client, click Home > Roles > Add Role, enter a role name such as View Composer Administrator, and select privileges for the role.
     This role must have all the privileges that both Connection Server and View Composer need to operate in vCenter Server.
   - If you use Horizon 7 without View Composer, you can create an even more limited role with the minimum privileges needed by Connection Server to perform vCenter Server operations.
     In vSphere Client, click Home > Roles > Add Role, enter a role name such as View Manager Administrator, and select privileges for the role.
   - If you use instant clones, you can create a limited role with the minimum privileges needed by Connection Server to perform vCenter Server operations.
     In vSphere Client, click Home > Roles > Add Role, enter a role name such as View Manager Instant Clone Administrator, and select privileges for the role. For instant-clone privileges, see View Composer and Instant Clone Privileges Required for the vCenter Server User.

2. In vSphere Client, right-click the vCenter Server at the top level of the inventory, click Add Permission, and add the vCenter Server user.

   **Note** You must define the vCenter Server user at the vCenter Server level.

3. From the drop-down menu, select the Administrator role, or the View Composer or View Manager role that you created, and assign it to the vCenter Server user.

4. If you install View Composer on the same machine as vCenter Server, add the vCenter Server user account as a member of the local system Administrators group on the vCenter Server machine.
   This step is not required if you install View Composer on a different machine than vCenter Server.
What to do next

In Horizon Administrator, when you add vCenter Server to Horizon 7, specify the vCenter Server user. See Add vCenter Server Instances to Horizon 7.

Privileges Required for the vCenter Server User

The vCenter Server user must have sufficient vCenter Server privileges to enable Horizon 7 to perform operations in vCenter Server. Create a View Manager role for the vCenter Server user with the required privileges.

Table 10-1. Privileges Required for the View Manager Role

<table>
<thead>
<tr>
<th>Privilege Group</th>
<th>Privileges to Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Create Folder</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
</tr>
<tr>
<td>Datastore</td>
<td>Allocate space</td>
</tr>
<tr>
<td>Virtual Machine</td>
<td>In Configuration:</td>
</tr>
<tr>
<td></td>
<td>▪ Add or remove device</td>
</tr>
<tr>
<td></td>
<td>▪ Advanced</td>
</tr>
<tr>
<td></td>
<td>▪ Modify device settings</td>
</tr>
<tr>
<td></td>
<td>In Interaction:</td>
</tr>
<tr>
<td></td>
<td>▪ Power Off</td>
</tr>
<tr>
<td></td>
<td>▪ Power On</td>
</tr>
<tr>
<td></td>
<td>▪ Reset</td>
</tr>
<tr>
<td></td>
<td>▪ Suspend</td>
</tr>
<tr>
<td></td>
<td>▪ Perform wipe or shrink operations</td>
</tr>
<tr>
<td></td>
<td>In Inventory:</td>
</tr>
<tr>
<td></td>
<td>▪ Create new</td>
</tr>
<tr>
<td></td>
<td>▪ Create from existing</td>
</tr>
<tr>
<td></td>
<td>▪ Remove</td>
</tr>
<tr>
<td></td>
<td>In Provisioning:</td>
</tr>
<tr>
<td></td>
<td>▪ Customize</td>
</tr>
<tr>
<td></td>
<td>▪ Deploy template</td>
</tr>
<tr>
<td></td>
<td>▪ Read customization specifications</td>
</tr>
<tr>
<td></td>
<td>▪ Clone Template</td>
</tr>
<tr>
<td></td>
<td>▪ Clone Virtual Machine</td>
</tr>
<tr>
<td>Resource</td>
<td>Assign virtual machine to resource pool</td>
</tr>
<tr>
<td>Global</td>
<td>Act as vCenter Server</td>
</tr>
</tbody>
</table>
|                   | The vCenter Server user requires this privilege even if you do not use View Storage Accelerator.
### Table 10-1. Privileges Required for the View Manager Role (Continued)

<table>
<thead>
<tr>
<th>Privilege Group</th>
<th>Privileges to Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The following <strong>Host</strong> privilege is required to implement View Storage Accelerator, which enables ESXi host caching. If you do not use View Storage Accelerator, the vCenter Server user does not need this privilege.</td>
</tr>
<tr>
<td><strong>Profile Driven Storage</strong> (If you are using vSAN datastores or Virtual Volumes)</td>
<td>(all)</td>
</tr>
</tbody>
</table>

### View Composer and Instant Clone Privileges Required for the vCenter Server User

To support View Composer or instant clones, the vCenter Server user must have privileges in addition to those required to support Horizon 7.

View Composer and Instant Clone Privileges lists the superset of privileges needed for View Manager, View Composer, and instant clones.

### Table 10-2. View Composer and Instant Clone Privileges

<table>
<thead>
<tr>
<th>Privilege Group on vCenter Server</th>
<th>Privileges to Enable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folder</td>
<td>Create folder</td>
</tr>
<tr>
<td></td>
<td>Delete folder</td>
</tr>
<tr>
<td><strong>Datastore</strong> Table 10-2</td>
<td>Allocate space</td>
</tr>
<tr>
<td></td>
<td>Browse datastore</td>
</tr>
<tr>
<td></td>
<td>Low level file operations</td>
</tr>
<tr>
<td>Host</td>
<td>In Inventory</td>
</tr>
<tr>
<td></td>
<td>Modify Cluster</td>
</tr>
</tbody>
</table>
### Table 10.2. View Composer and Instant Clone Privileges (Continued)

<table>
<thead>
<tr>
<th>Privilege Group on vCenter Server</th>
<th>Privileges to Enable</th>
</tr>
</thead>
</table>
| **Virtual machine**              | **In Configuration (all)**<br>**In Interaction:**<br>  
  - Power Off  
  - Power On  
  - Reset  
  - Suspend  
  - Perform wipe or shrink operations  
  - Device connection  
  **In Inventory (all)**<br>**In Snapshot management (all)**<br>**In Provisioning:**<br>  
  - Customize  
  - Deploy template  
  - Read customization specifications  
  - Clone template  
  - Clone Virtual Machine  
  - Allow disk access |
| **Resource**                      | **Assign virtual machine to resource pool**<br>The following privilege is required to perform View Composer rebalance operations.<br>Migrate powered off virtual machine |
| **Global**                        | **Enable methods**<br>**Disable methods**<br>**System tag**<br>**Manage custom attributes**<br>**Set custom attribute**<br>The following privilege is required to implement View Storage Accelerator, which enables ESXi host caching. The vCenter Server user requires this privilege even if you do not use View Storage Accelerator.<br>**Act as vCenter Server** |
| **Network**                       | (all)                                                                                 |
| **Profile Driven Storage**        | (all--If you are using vSAN datastores or Virtual Volumes)                             |
| **Storage views**                 | **View**                                                                              |
| **Cryptographic operations**      | The following privileges are required if you use instant clones VMs with a Trusted Platform Module (vTPM) device.<br>  
  - Clone  
  - Decrypt  
  - Direct Access  
  - Encrypt  
  - Manage KMS  
  - Migrate |
Configuring Horizon Connection Server for the First Time

After you install Connection Server, you must install a product license, add vCenter Servers and View Composer services to Horizon 7. You can also allow ESXi hosts to reclaim disk space on linked-clone virtual machines and configure ESXi hosts to cache virtual machine disk data.

If you install security servers, they are added to Horizon 7 and appear in Horizon Administrator automatically.

Horizon Administrator and Horizon Connection Server

Horizon Administrator provides a Web-based management interface for Horizon 7.

Horizon Connection Server can have multiple instances that serve as replica servers or security servers. Depending on your Horizon 7 deployment, you can get a Horizon Administrator interface with each instance of a Connection Server.

Use the following best practices to use Horizon Administrator with a Connection Server:

- Use the host name and IP address of the Connection Server to log in to Horizon Administrator. Use the Horizon Administrator interface to manage the Connection Server, and any associated security server or replica server.
- In a pod environment, verify that all administrators use the host name and IP address of the same Connection Server to log in to Horizon Administrator. Do not use the host name and IP address of the load balancer to access a Horizon Administrator web page.
- To identify the Connection Server pod you are working with, you can view the pod name in the Horizon Administrator header and in the Web browser tab.

**Note**  If you use Unified Access Gateway appliances rather than security servers, you must use the Unified Access Gateway REST API to manage the Unified Access Gateway appliances. Earlier versions of Unified Access Gateway are named Access Point. For more information, see *Deploying and Configuring Unified Access Gateway*.

Log In to Horizon Administrator

To perform initial configuration tasks, you must log in to Horizon Administrator.

**Prerequisites**

Verify that you are using a Web browser supported by Horizon Administrator. See *Horizon Administrator Requirements*. 
Procedure

1. Open your Web browser and enter the following URL, where server is the host name of the Connection Server instance.

   https://server/admin

   **Note**  You can use the IP address if you have to access a Connection Server instance when the host name is not resolvable. However, the host that you contact will not match the TLS certificate that is configured for the Connection Server instance, resulting in blocked access or access with reduced security.

   Your access to Horizon Administrator depends on the type of certificate that is configured on the Connection Server computer.

   If you open your Web browser on the Connection Server host, use `https://127.0.0.1` to connect, not `https://localhost`. This method improves security by avoiding potential DNS attacks on the localhost resolution.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>You configured a certificate signed by a CA for View Connection Server.</td>
<td>When you first connect, your Web browser displays Horizon Administrator.</td>
</tr>
<tr>
<td>The default, self-signed certificate supplied with View Connection Server is configured.</td>
<td>When you first connect, your Web browser might display a page warning that the security certificate associated with the address is not issued by a trusted certificate authority. Click <strong>Ignore</strong> to continue using the current TLS certificate.</td>
</tr>
</tbody>
</table>

2. Log in using an account that has the Administrators role.

   You make an initial assignment to the Administrators role when you install a standalone Connection Server instance or the first Connection Server instance in a replicated group. By default, the account that you use to install Connection Server is selected, but you can change this account to the Administrators local group or to a domain global group.

   If you chose the Administrators local group, then you can use any domain user added to this group directly or through global group membership. You cannot use local users added to this group.

   After you log in to Horizon Administrator, you can use **View Configuration > Administrators** to change the list of users and groups that have the Administrators role.

**Install the Product License Key**

Before you can use Connection Server, you must enter a product license key.

**Note**  The product license key is not required if you have a Horizon 7 subscription license. For more information about subscription licenses, see Chapter 9 Enabling Horizon 7 for Subscription Licenses.

The first time you log in, Horizon Administrator displays the Product Licensing and Usage page.

After you install the license key, Horizon Administrator displays the dashboard page when you log in.
You do not have to configure a license key when you install a replicated Connection Server instance or a security server. Replicated instances and security servers use the common license key stored in the View LDAP configuration.

**Note** Connection Server requires a valid license key. The product license key is a 25-character key.

**Procedure**

1. In Horizon Administrator, select View Configuration > Product Licensing and Usage.
2. In the Licensing panel, click Edit License.
3. Enter the license serial number and click OK.
4. Verify the license expiration date.
5. Verify that the Desktop, Application Remoting, and View Composer licenses are enabled or disabled, based on the edition of VMware Horizon 7 that your product license entitles you to use.


**Add vCenter Server Instances to Horizon 7**

You must configure Horizon 7 to connect to the vCenter Server instances in your Horizon 7 deployment. vCenter Server creates and manages the virtual machines that Horizon 7 uses in desktop pools.

If you run vCenter Server instances in a Linked Mode group, you must add each vCenter Server instance to Horizon 7 separately.

Horizon 7 connects to the vCenter Server instance using a secure channel (SSL).

**Prerequisites**

- Install the Connection Server product license key.
- Prepare a vCenter Server user with permission to perform the operations in vCenter Server that are necessary to support Horizon 7. To use View Composer, you must give the user additional privileges. See [Configure a vCenter Server User for Horizon 7 and View Composer](#).
- Verify that a TLS/SSL server certificate is installed on the vCenter Server host. In a production environment, install a valid certificate that is signed by a trusted Certificate Authority (CA).

In a testing environment, you can use the default certificate that is installed with vCenter Server, but you must accept the certificate thumbprint when you add vCenter Server to Horizon 7.
- Verify that all Connection Server instances in the replicated group trust the root CA certificate for the server certificate that is installed on the vCenter Server host. Check if the root CA certificate is in the Trusted Root Certification Authorities > Certificates folder in the Windows local computer certificate stores on the Connection Server hosts. If it is not, import the root CA certificate into the Windows local computer certificate stores.

See Import a Root Certificate and Intermediate Certificates into a Windows Certificate Store.

- Verify that the vCenter Server instance contains ESXi hosts. If no hosts are configured in the vCenter Server instance, you cannot add the instance to Horizon 7.

- If you upgrade to vSphere 5.5 or a later release, verify that the domain administrator account that you use as the vCenter Server user was explicitly assigned permissions to log in to vCenter Server by a vCenter Server local user.

- If you plan to use Horizon 7 in FIPS mode, verify that you have vCenter Server 6.0 or later and ESXi 6.0 or later hosts.

For more information, see Chapter 4 Installing Horizon 7 in FIPS Mode.

- Familiarize yourself with the settings that determine the maximum operations limits for vCenter Server and View Composer. See Concurrent Operations Limits for vCenter Server and View Composer and Setting a Concurrent Power Operations Rate to Support Remote Desktop Logon Storms.

Procedure

1. In Horizon Administrator, select View Configuration > Servers.

2. On the vCenter Servers tab, click Add.

3. In the vCenter Server Settings Server address text box, type the fully qualified domain name (FQDN) of the vCenter Server instance.

   The FQDN includes the host name and domain name. For example, in the FQDN myserverhost.companydomain.com, myserverhost is the host name and companydomain.com is the domain.

   **Note** If you enter a server by using a DNS name or URL, Horizon 7 does not perform a DNS lookup to verify whether an administrator previously added this server to Horizon 7 by using its IP address. A conflict arises if you add a vCenter Server with both its DNS name and its IP address.

4. Type the name of the vCenter Server user.

   For example: domain\user or user@domain.com

5. Type the vCenter Server user password.

6. (Optional) Type a description for this vCenter Server instance.

7. Type the TCP port number.

   The default port is 443.
8 Under Advanced Settings, set the concurrent operations limits for vCenter Server and View Composer operations.

9 Click **Next** to display the View Composer Settings page.

**What to do next**

Configure View Composer settings.

- If the vCenter Server instance is configured with a signed SSL certificate, and Connection Server trusts the root certificate, the Add vCenter Server wizard displays the View Composer Settings page.
- If the vCenter Server instance is configured with a default certificate, you must first determine whether to accept the thumbprint of the existing certificate. See [Accept the Thumbprint of a Default TLS Certificate](#).

If Horizon 7 uses multiple vCenter Server instances, repeat this procedure to add the other vCenter Server instances.

**Configure View Composer Settings**

To use View Composer, you must configure settings that allow Connection Server to connect to the View Composer service. View Composer can be installed on its own standalone machine or on the same machine as vCenter Server.

VMware recommends having a one-to-one mapping between each View Composer service and vCenter Server instance.

**Prerequisites**

- Verify that you configured Connection Server to connect to vCenter Server. To do so, you must complete the vCenter Server Information page in the Add vCenter Server wizard. See [Add vCenter Server Instances to Horizon 7](#).
- Verify that this View Composer service is not already configured to connect to a different vCenter Server instance.
- If you installed View Composer on a standalone machine, verify that you created a standalone View Composer Server user account. This domain user account must be a member of the local Administrators group on the View Composer machine.

**Procedure**

1 In Horizon Administrator, complete the vCenter Server Information page in the Add vCenter Server wizard.
   
   a Click **View Configuration > Servers**.
   
   b In the vCenter Servers tab, click **Add** and provide the vCenter Server settings.
On the View Composer Settings page, if you are not using View Composer, select **Do not use View Composer**.

If you select **Do not use View Composer**, the other View Composer settings become inactive. When you click **Next**, the Add vCenter Server wizard displays the Storage Settings page. The View Composer Domains page is not displayed.

If you are using View Composer, select the location of the View Composer machine.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| View Composer is installed on the same machine as vCenter Server. | a Select **View Composer co-installed with the vCenter Server**.  
  b Make sure that the port number is the same as the port that you specified when you installed the View Composer service on vCenter Server. The default port number is 18443. |
| View Composer is installed on its own separate machine. | a Select **Standalone View Composer Server**.  
  b In the View Composer server address text box, type the fully qualified domain name (FQDN) of the View Composer machine.  
  c Type the name of a domain user account that can authenticate to the View Composer service.  
    The account must be a member of the local Administrators group on the standalone View Composer machine.  
    For example: `domain.com\user` or `user@domain.com`  
  d Type the password of this domain user account.  
  e Make sure that the port number is the same as the port that you specified when you installed the View Composer service. The default port number is 18443. |

Click **Next** to display the View Composer Domains page.

**What to do next**

Configure View Composer domains.

- If the View Composer instance is configured with a signed SSL certificate, and Connection Server trusts the root certificate, the Add vCenter Server wizard displays the View Composer Domains page.

- If the View Composer instance is configured with a default certificate, you must first determine whether to accept the thumbprint of the existing certificate. See [Accept the Thumbprint of a Default TLS Certificate](#).

**Configure View Composer Domains**

You must configure an Active Directory domain in which View Composer deploys linked-clone desktops. You can configure multiple domains for View Composer. After you first add vCenter Server and View Composer settings to View, you can add more View Composer domains by editing the vCenter Server instance in Horizon Administrator.
Prerequisites

- Your Active Directory administrator must create a View Composer user for AD operations. This domain user must have permission to add and remove virtual machines from the Active Directory domain that contains your linked clones. For information about the required permissions for this user, see Create a User Account for View Composer AD Operations.

- In Horizon Administrator, verify that you completed the vCenter Server Information and View Composer Settings pages in the Add vCenter Server wizard.

Procedure

1. On the View Composer Domains page, click **Add** to add the View Composer user for AD operations account information.
2. Type the domain name of the Active Directory domain.
   
   For example: `domain.com`
3. Type the domain user name, including the domain name, of the View Composer user.
   
   For example: `domain.com\admin`
4. Type the account password.
5. Click **OK**.
6. To add domain user accounts with privileges in other Active Directory domains in which you deploy linked-clone pools, repeat the preceding steps.
7. Click **Next** to display the Storage Settings page.

What to do next

Enable virtual machine disk space reclamation and configure View Storage Accelerator for Horizon 7.

Add an Instant-Clone Domain Administrator

Before you create an instant-clone desktop pool, you must add an instant-clone domain administrator to Horizon 7.

The instant-clone domain administrator must have certain Active Directory domain privileges.

Procedure

1. In Horizon Administrator, select **View Configuration > Instant Clone Domain Admins**.
2. Click **Add**.
3. Enter the login name and password for of the instant-clone domain administrator.
Allow vSphere to Reclaim Disk Space in Linked-Clone Virtual Machines

In vSphere 5.1 and later, you can enable the disk space reclamation feature for Horizon 7. Starting in vSphere 5.1, Horizon 7 creates linked-clone virtual machines in an efficient disk format that allows ESXi hosts to reclaim unused disk space in the linked clones, reducing the total storage space required for linked clones.

As users interact with linked-clone desktops, the clones’ OS disks grow and can eventually use almost as much disk space as full-clone desktops. Disk space reclamation reduces the size of the OS disks without requiring you to refresh or recompose the linked clones. Space can be reclaimed while the virtual machines are powered on and users are interacting with their remote desktops.

Disk space reclamation is especially useful for deployments that cannot take advantage of storage-saving strategies such as refresh on logoff. For example, knowledge workers who install user applications on dedicated remote desktops might lose their personal applications if the remote desktops were refreshed or recomposed. With disk space reclamation, Horizon 7 can maintain linked clones at close to the reduced size they start out with when they are first provisioned.

This feature has two components: space-efficient disk format and space reclamation operations.

In a vSphere 5.1 or later environment, when a parent virtual machine is virtual hardware version 9 or later, Horizon 7 creates linked clones with space-efficient OS disks, whether or not space reclamation operations are enabled.

To enable space reclamation operations, you must use Horizon Administrator to enable space reclamation for vCenter Server and reclaim VM disk space for individual desktop pools. The space reclamation setting for vCenter Server gives you the option to disable this feature on all desktop pools that are managed by the vCenter Server instance. Disabling the feature for vCenter Server overrides the setting at the desktop pool level.

The following guidelines apply to the space reclamation feature:

- It operates only on space-efficient OS disks in linked clones.
- It does not affect View Composer persistent disks.
- It works only with vSphere 5.1 or later and only on virtual machines that are virtual hardware version 9 or later.
- It does not operate on full-clone desktops.
- It operates on virtual machines with SCSI controllers. IDE controllers are not supported.

View Composer Array Integration (VCAI) is not supported in pools that contain virtual machines with space-efficient disks. VCAI uses vStorage APIs for Array Integration (VAAI) native NFS snapshot technology to clone virtual machines.
Prerequisites

- Verify that your vCenter Server and ESXi hosts, including all ESXi hosts in a cluster, are version 5.1 with ESXi 5.1 download patch ESXi510-201212001 or later.

Procedure

1. In Horizon Administrator, complete the Add vCenter Server wizard pages that precede the Storage Settings page.
   a. Select View Configuration > Servers.
   b. On the vCenter Servers tab, click Add.
   c. Complete the vCenter Server Information, View Composer Settings, and View Composer Domains pages.

2. On the Storage Settings page, make sure that Enable space reclamation is selected.

   Space reclamation is selected by default if you are performing a fresh installation of Horizon 7 5.2 or later. You must select Enable space reclamation if you are upgrading to Horizon 7 5.2 or later from Horizon 7 5.1 or an earlier release.

What to do next

On the Storage Settings page, configure View Storage Accelerator.

To finish configuring disk space reclamation in Horizon 7, set up space reclamation for desktop pools.

Configure View Storage Accelerator for vCenter Server

In vSphere 5.1 and later, you can configure ESXi hosts to cache virtual machine disk data. This feature, called View Storage Accelerator, uses the Content Based Read Cache (CBRC) feature in ESXi hosts. View Storage Accelerator improves Horizon 7 performance during I/O storms, which can take place when many virtual machines start up or run anti-virus scans at once. The feature is also beneficial when administrators or users load applications or data frequently. Instead of reading the entire OS or application from the storage system over and over, a host can read common data blocks from cache.

By reducing the number of IOPS during boot storms, View Storage Accelerator lowers the demand on the storage array, which lets you use less storage I/O bandwidth to support your Horizon 7 deployment.

You enable caching on your ESXi hosts by selecting the View Storage Accelerator setting in the vCenter Server wizard in Horizon Administrator, as described in this procedure.

Make sure that View Storage Accelerator is also configured for individual desktop pools. To operate on a desktop pool, View Storage Accelerator must be enabled for vCenter Server and for the individual desktop pool.
View Storage Accelerator is enabled for desktop pools by default. The feature can be disabled or enabled when you create or edit a pool. The best approach is to enable this feature when you first create a desktop pool. If you enable the feature by editing an existing pool, you must ensure that a new replica and its digest disks are created before linked clones are provisioned. You can create a new replica by recomposing the pool to a new snapshot or rebalancing the pool to a new datastore. Digest files can only be configured for the virtual machines in a desktop pool when they are powered off.

You can enable View Storage Accelerator on desktop pools that contain linked clones and pools that contain full virtual machines.

Native NFS snapshot technology (VAAI) is not supported in pools that are enabled for View Storage Accelerator.

View Storage Accelerator is now qualified to work in configurations that use Horizon 7 replica tiering, in which replicas are stored on a separate datastore than linked clones. Although the performance benefits of using View Storage Accelerator with Horizon 7 replica tiering are not materially significant, certain capacity-related benefits might be realized by storing the replicas on a separate datastore. Hence, this combination is tested and supported.

**Important** If you plan to use this feature and you are using multiple View pods that share some ESXi hosts, you must enable the View Storage Accelerator feature for all pools that are on the shared ESXi hosts. Having inconsistent settings in multiple pods can cause instability of the virtual machines on the shared ESXi hosts.

**Prerequisites**

- Verify that your vCenter Server and ESXi hosts are version 5.1 or later.
  - In an ESXi cluster, verify that all the hosts are version 5.1 or later.
- Verify that the vCenter Server user was assigned the **Host > Configuration > Advanced settings** privilege in vCenter Server.
  - See Configuring User Accounts for vCenter Server, View Composer, and Instant Clones.

**Procedure**

1. In Horizon Administrator, complete the Add vCenter Server wizard pages that precede the Storage Settings page.
   a. Select **View Configuration > Servers**.
   b. On the **vCenter Servers** tab, click **Add**.
   c. Complete the vCenter Server Information, View Composer Settings, and View Composer Domains pages.

2. On the Storage Settings page, make sure that the **Enable View Storage Accelerator** check box is selected.
   - This check box is selected by default.
3 Specify a default host cache size.

The default cache size applies to all ESXi hosts that are managed by this vCenter Server instance.

The default value is 1,024MB. The cache size must be between 100MB and 2,048MB.

4 To specify a different cache size for an individual ESXi host, select an ESXi host and click **Edit cache size**.

   a In the Host cache dialog box, check **Override default host cache size**.

   b Type a **Host cache size** value between 100MB and 2,048MB and click **OK**.

5 On the Storage Settings page, click **Next**.

6 Click **Finish** to add vCenter Server, View Composer, and Storage Settings to Horizon 7.

**What to do next**

To configure the PCoIP Secure Gateway, secure tunnel, and external URLs for client connections, see [Configuring Horizon Client Connections](#).

To complete View Storage Accelerator settings in Horizon 7, configure View Storage Accelerator for desktop pools. See "Configure View Storage Accelerator for Desktop Pools" in the [Setting Up Virtual Desktops in Horizon 7](#) document.

---

**Concurrent Operations Limits for vCenter Server and View Composer**

When you add vCenter Server to Horizon 7 or edit the vCenter Server settings, you can configure several options that set the maximum number of concurrent operations that are performed by vCenter Server and View Composer.

You configure these options in the Advanced Settings panel on the vCenter Server Information page.

**Table 10-3. Concurrent Operations Limits for vCenter Server and View Composer**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Max concurrent vCenter provisioning operations</strong></td>
<td>Determines the maximum number of concurrent requests that Connection Server can make to provision and delete full virtual machines in this vCenter Server instance. The default value is 20. This setting applies to full virtual machines only.</td>
</tr>
<tr>
<td><strong>Max concurrent power operations</strong></td>
<td>Determines the maximum number of concurrent power operations (startup, shutdown, suspend, and so on) that can take place on virtual machines managed by Connection Server in this vCenter Server instance. The default value is 50. For guidelines for calculating a value for this setting, see <a href="#">Setting a Concurrent Power Operations Rate to Support Remote Desktop Logon Storms</a>. This setting applies to full virtual machines and linked clones.</td>
</tr>
</tbody>
</table>
Table 10-3. Concurrent Operations Limits for vCenter Server and View Composer (Continued)

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max concurrent View Composer maintenance operations</td>
<td>Determines the maximum number of concurrent View Composer refresh, recompose, and rebalance operations that can take place on linked clones managed by this View Composer instance. The default value is 12. Remote desktops that have active sessions must be logged off before a maintenance operation can begin. If you force users to log off as soon as a maintenance operation begins, the maximum number of concurrent operations on remote desktops that require logoffs is half the configured value. For example, if you configure this setting as 24 and force users to log off, the maximum number of concurrent operations on remote desktops that require logoffs is 12. This setting applies to linked clones only.</td>
</tr>
<tr>
<td>Max concurrent View Composer provisioning operations</td>
<td>Determines the maximum number of concurrent creation and deletion operations that can take place on linked clones managed by this View Composer instance. The default value is 8. This setting applies to linked clones only.</td>
</tr>
</tbody>
</table>

Setting a Concurrent Power Operations Rate to Support Remote Desktop Logon Storms

The Max concurrent power operations setting governs the maximum number of concurrent power operations that can occur on remote desktop virtual machines in a vCenter Server instance. This limit is set to 50 by default. You can change this value to support peak power-on rates when many users log on to their desktops at the same time.

As a best practice, you can conduct a pilot phase to determine the correct value for this setting. For planning guidelines, see "Architecture Design Elements and Planning Guidelines" in the Horizon 7 Architecture Planning document.

The required number of concurrent power operations is based on the peak rate at which desktops are powered on and the amount of time it takes for the desktop to power on, boot, and become available for connection. In general, the recommended power operations limit is the total time it takes for the desktop to start multiplied by the peak power-on rate.

For example, the average desktop takes two to three minutes to start. Therefore, the concurrent power operations limit should be 3 times the peak power-on rate. The default setting of 50 is expected to support a peak power-on rate of 16 desktops per minute.

The system waits a maximum of five minutes for a desktop to start. If the start time takes longer, other errors are likely to occur. To be conservative, you can set a concurrent power operations limit of 5 times the peak power-on rate. With a conservative approach, the default setting of 50 supports a peak power-on rate of 10 desktops per minute.
Logons, and therefore desktop power on operations, typically occur in a normally distributed manner over a certain time window. You can approximate the peak power-on rate by assuming that it occurs in the middle of the time window, during which about 40% of the power-on operations occur in 1/6th of the time window. For example, if users log on between 8:00 AM and 9:00 AM, the time window is one hour, and 40% of the logons occur in the 10 minutes between 8:25 AM and 8:35 AM. If there are 2,000 users, 20% of whom have their desktops powered off, then 40% of the 400 desktop power-on operations occur in those 10 minutes. The peak power-on rate is 16 desktops per minute.

Accept the Thumbprint of a Default TLS Certificate

When you add vCenter Server and View Composer instances to Horizon 7, you must ensure that the TLS certificates that are used for the vCenter Server and View Composer instances are valid and trusted by Connection Server. If the default certificates that are installed with vCenter Server and View Composer are still in place, you must determine whether to accept these certificates' thumbprints.

If a vCenter Server or View Composer instance is configured with a certificate that is signed by a CA, and the root certificate is trusted by Connection Server, you do not have to accept the certificate thumbprint. No action is required.

If you replace a default certificate with a certificate that is signed by a CA, but Connection Server does not trust the root certificate, you must determine whether to accept the certificate thumbprint. A thumbprint is a cryptographic hash of a certificate. The thumbprint is used to quickly determine if a presented certificate is the same as another certificate, such as the certificate that was accepted previously.

**Note** If you install vCenter Server and View Composer on the same Windows Server host, they can use the same TLS certificate, but you must configure the certificate separately for each component.

For details about configuring TLS certificates, see Chapter 8 Configuring TLS Certificates for Horizon 7 Servers.

You first add vCenter Server and View Composer in Horizon Administrator by using the Add vCenter Server wizard. If a certificate is untrusted and you do not accept the thumbprint, you cannot add vCenter Server and View Composer.

After these servers are added, you can reconfigure them in the Edit vCenter Server dialog box.

**Note** You also must accept a certificate thumbprint when you upgrade from an earlier release and a vCenter Server or View Composer certificate is untrusted, or if you replace a trusted certificate with an untrusted certificate.

On the Horizon Administrator dashboard, the vCenter Server or View Composer icon turns red and an Invalid Certificate Detected dialog box appears. In Horizon Administrator, click View Configuration > Servers and edit the vCenter Server entry associated with the View Composer Service. Then, click Edit in the vCenter Server settings and follow the prompts to verify the and accept the self-signed certificate.
Similarly, in Horizon Administrator you can configure a SAML authenticator for use by a Connection Server instance. If the SAML server certificate is not trusted by Connection Server, you must determine whether to accept the certificate thumbprint. If you do not accept the thumbprint, you cannot configure the SAML authenticator in Horizon 7. After a SAML authenticator is configured, you can reconfigure it in the Edit Connection Server dialog box.

Procedure

1. When Horizon Administrator displays an Invalid Certificate Detected dialog box, click **View Certificate**.
2. Examine the certificate thumbprint in the Certificate Information window.
3. Examine the certificate thumbprint that was configured for the vCenter Server or View Composer instance.
   a. On the vCenter Server or View Composer host, start the MMC snap-in and open the Windows Certificate Store.
   b. Navigate to the vCenter Server or View Composer certificate.
   c. Click the Certificate Details tab to display the certificate thumbprint.
   Similarly, examine the certificate thumbprint for a SAML authenticator. If appropriate, take the preceding steps on the SAML authenticator host.
4. Verify that the thumbprint in the Certificate Information window matches the thumbprint for the vCenter Server or View Composer instance.
   Similarly, verify that the thumbprints match for a SAML authenticator.
5. Determine whether to accept the certificate thumbprint.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The thumbprints match.</td>
<td>Click <strong>Accept</strong> to use the default certificate.</td>
</tr>
<tr>
<td>The thumbprints do not match.</td>
<td>Click <strong>Reject</strong>. Troubleshoot the mismatched certificates. For example, you might have provided an incorrect IP address for vCenter Server or View Composer.</td>
</tr>
</tbody>
</table>

Configuring Horizon Client Connections

Client endpoints communicate with a Connection Server or security server host over secure connections.

The initial client connection, which is used for user authentication and remote desktop and application selection, is created over HTTPS when a user provides a domain name to Horizon Client. If firewall and load balancing software are configured correctly in your network environment, this request reaches the Connection Server or security server host. With this connection, users are authenticated and a desktop or application is selected, but users have not yet connected to the remote desktop or application.

When users connect to remote desktops and applications, by default the client makes a second connection to the Connection Server or security server host. This connection is called the tunnel connection because it provides a secure tunnel for carrying RDP and other data over HTTPS.
When users connect to remote desktops and applications with the PCoIP display protocol, the client can make a further connection to the PCoIP Secure Gateway on the Connection Server or security server host. The PCoIP Secure Gateway ensures that only authenticated users can communicate with remote desktops and applications over PCoIP.

You can also provide secure connections to users connect to remote desktops and applications with the VMware Blast display protocol and to external users who use HTML Access to connect to remote desktops. The Blast Secure Gateway ensures that only authenticated users can communicate with remote desktops.

Depending on the type of client device being used, additional channels are established to carry other traffic such as USB redirection data to the client device. These data channels route traffic through the secure tunnel if it is enabled.

When the secure tunnel and secure gateways are disabled, desktop and application sessions are established directly between the client device and the remote machine, bypassing the Connection Server or security server host. This type of connection is called a direct connection.

Desktop and application sessions that use direct connections remain connected even if Connection Server is no longer running.

Typically, to provide secure connections for external clients that connect to a security server or Connection Server host over a WAN, you enable the secure tunnel, the PCoIP Secure Gateway, and the Blast Secure Gateway. You can disable the secure tunnel and the secure gateways to allow internal, LAN-connected clients to establish direct connections to remote desktops and applications.

If you enable only the secure tunnel or only one secure gateway, a session might use a direct connection for some traffic but send other traffic through the Connection Server or security server host, depending on the type of client being used.

SSL is required for all client connections to Connection Server and security server hosts.

**Configure the PCoIP Secure Gateway and Secure Tunnel Connections**

You use Horizon Administrator to configure the use of the secure tunnel and PCoIP Secure Gateway. These components ensure that only authenticated users can communicate with remote desktops and applications.

Clients that use the PCoIP display protocol can use the PCoIP Secure Gateway. Clients that use the RDP display protocol can use the secure tunnel.
For information about configuring the Blast Secure Gateway, see Configure the Blast Secure Gateway.

**Important**  A typical network configuration that provides secure connections for external clients includes a security server. To enable or disable the secure tunnel and PCoIP Secure Gateway on a security server, you must edit the Connection Server instance that is paired with the security server.

In a network configuration in which external clients connect directly to a Connection Server host, you enable or disable the secure tunnel and PCoIP Secure Gateway by editing that Connection Server instance in Horizon Administrator.

**Prerequisites**

- If you intend to enable the PCoIP Secure Gateway, verify that the Connection Server instance and paired security server are View 4.6 or later.
- If you pair a security server to a Connection Server instance on which you already enabled the PCoIP Secure Gateway, verify that the security server is View 4.6 or later.

**Procedure**

1. In Horizon Administrator, select **View Configuration > Servers**.
2. In the Connection Servers panel, select a Connection Server instance and click **Edit**.
3. Configure use of the secure tunnel.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable the secure tunnel</td>
<td>Deselect Use secure tunnel connection to machine.</td>
</tr>
<tr>
<td>Enable the secure tunnel</td>
<td>Select Use secure tunnel connection to machine.</td>
</tr>
</tbody>
</table>

The secure tunnel is enabled by default.

4. Configure use of the PCoIP Secure Gateway.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the PCoIP Secure Gateway</td>
<td>Select Use PCoIP Secure Gateway for PCoIP connections to machine.</td>
</tr>
<tr>
<td>Disable the PCoIP secure Gateway</td>
<td>Deselect Use PCoIP Secure Gateway for PCoIP connections to machine.</td>
</tr>
</tbody>
</table>

The PCoIP Secure Gateway is disabled by default.

5. Click **OK** to save your changes.

**Configure the Blast Secure Gateway**

In Horizon Administrator, you can configure the use of the Blast Secure Gateway to provide secure access to remote desktops and applications, either through HTML Access or through client connections that use the VMware Blast display protocol.
The Blast Secure Gateway includes Blast Extreme Adaptive Transport (BEAT) networking, which dynamically adjusts to network conditions such as varying speeds and packet loss.

- Blast Secure Gateway supports BEAT networking only when running on a Unified Access Gateway appliance.
- Horizon Clients using IPv4 and Horizon Clients using IPv6 can be handled concurrently on TCP port 8443 and on UDP port 8443 (for BEAT) when connecting to a Unified Access Gateway appliance version 3.3 or later.
- Horizon Clients that use a typical network condition must connect to a Connection Server (BSG disabled), security server (BSG disabled), or versions later than 2.8 of an Unified Access Gateway appliance. If Horizon Client uses a typical network condition to connect to a Connection Server (BSG enabled), security server (BSG enabled), or versions earlier than 2.8 of an Unified Access Gateway appliance, the client automatically senses the network condition and falls back to TCP networking.
- Horizon Clients that use a poor network condition must connect to version 2.9 or later of an Unified Access Gateway appliance (with UDP Tunnel Server Enabled). If Horizon Client uses a poor network condition to connect to the Connection Server (BSG enabled), security server (BSG enabled), or versions earlier than 2.8 of an Unified Access Gateway appliance, the client automatically senses the network condition and falls back to TCP networking.
- Horizon Clients that use a poor network condition to connect to Connection Server (BSG disabled), security server (BSG disabled), or version 2.9 or later of Unified Access Gateway appliance (without UDP Tunnel Server Enabled), or version 2.8 of Unified Access Gateway appliance, the client automatically senses the network condition and falls back to the typical network condition.

For more information, see the Horizon Client documentation at https://docs.vmware.com/en/VMware-Horizon-Client/index.html.

**Note**  You can also use Unified Access Gateway appliances, rather than security servers, for secure external access to Horizon 7 servers and desktops. If you use Unified Access Gateway appliances, you must disable the secure gateways on Connection Server instances and enable these gateways on the Unified Access Gateway appliances. For more information, see *Deploying and Configuring Unified Access Gateway*.

When the Blast Secure Gateway is not enabled, client devices and client Web browsers use the VMware Blast Extreme protocol to establish direct connections to remote desktop virtual machines and applications, bypassing the Blast Secure Gateway.

**Important**  A typical network configuration that provides secure connections for external users includes a security server. To enable or disable the Blast Secure Gateway on a security server, you must edit the Connection Server instance that is paired with the security server. If external users connect directly to a Connection Server host, you enable or disable the Blast Secure Gateway by editing that Connection Server instance.
Prerequisites

If users select remote desktops by using VMware Identity Manager, verify that VMware Identity Manager is installed and configured for use with Connection Server and that Connection Server is paired with a SAML 2.0 Authentication server.

Procedure

1. In Horizon Administrator, select View Configuration > Servers.
2. On the Connection Servers tab, select a Connection Server instance and click Edit.
3. Configure use of the Blast Secure Gateway.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable the Blast Secure Gateway</td>
<td>Select Use Blast Secure Gateway for Blast connections to machine</td>
</tr>
<tr>
<td>Enable the Blast Secure Gateway for HTML Access</td>
<td>Select Use Blast Secure Gateway for only HTML Access Blast connections to machine</td>
</tr>
<tr>
<td>Disable the Blast Secure Gateway</td>
<td>Select Do not use Blast Secure Gateway</td>
</tr>
</tbody>
</table>

The Blast Secure Gateway is enabled by default.

4. Click OK to save your changes.

Configuring External URLs for Secure Gateway and Tunnel Connections

To use the secure tunnel, a client system must have access to an IP address, or a fully qualified domain name (FQDN) that it can resolve to an IP address, that allows the client to reach a Connection Server or security server host.

To use the PCoIP Secure Gateway, a client connects to a Connection Server or security server host using an URL. In an IPv4 environment, the URL must identify a host by its IP address. In an IPv6 environment, the URL can identify a host by either its IP address or its FQDN.

To use the Blast Secure Gateway, a user's endpoint device must have access to an FQDN that it can resolve to an IP address that allows the user's Web browser or computer to reach a Connection Server or security server host.

Using Tunnel Connections from External Locations

By default, a Connection Server or security server host can be contacted only by tunnel clients that reside within the same network and are therefore able to locate the requested host.

Many organizations require that users can connect from an external location by using a specific IP address or client-resolvable domain name, and a specific port. This information might or might not resemble the actual address and port number of the Connection Server or security server host. The information is provided to a client system in the form of a URL. For example:

- https://view-example.com:443
- https://view.example.com:443
To use addresses like these in Horizon 7, you must configure the Connection Server or security server host to return an external URL instead of the host's FQDN.

**Configuring External URLs**

You configure more than one external URL. The first URL allows client systems to make tunnel connections. A second URL allows clients that use PCoIP to make secure connections through the PCoIP Secure Gateway. In an IPv4 environment, the URL must identify a host by its IP address. In an IPv6 environment, the URL can identify a host by either its IP address or its FQDN. The URL allows clients to connect from an external location.

A third URL allows users to make secure connections from their client devices or Web browsers through the Blast Secure Gateway.

If your network configuration includes security servers, provide external URLs for the security servers. External URLs are not required on the Connection Server instances that are paired with the security servers.

The process of configuring the external URLs is different for Connection Server instances and security servers.

- For a Connection Server instance, you set the external URLs by editing Connection Server settings in Horizon Administrator.
- For a security server, you set the external URLs when you run the Connection Server installation program. You can use Horizon Administrator to modify an external URL for a security server.

**Set the External URLs for a Connection Server Instance**

You use Horizon Administrator to configure the external URLs for a Connection Server instance.

The secure tunnel external URL, PCoIP external URL, and Blast external URL must be the addresses that client systems use to reach this Connection Server instance.

**Prerequisites**

- Verify that the secure tunnel connections and the PCoIP Secure Gateway are enabled on the Connection Server instance. See Configure the PCoIP Secure Gateway and Secure Tunnel Connections.
- To set the Blast external URL, verify that the Blast Secure Gateway is enabled on the Connection Server instance. See Configure the Blast Secure Gateway.

**Procedure**

1. In Horizon Administrator, click **View Configuration > Servers**.
2. Select the Connection Servers tab, select a Connection Server instance, and click **Edit**.
3 Type the secure tunnel external URL in the External URL text box.

The URL must contain the protocol, client-resolvable host name and port number.

For example: https://myserver.example.com:443

**Note** You can use the IP address if you have to access a Connection Server instance when the host name is not resolvable. However, the host that you contact will not match the TLS certificate that is configured for the Connection Server instance, resulting in blocked access or access with reduced security.

4 Type the PCoIP Secure Gateway external URL in the PCoIP External URL text box.

In an IPv4 environment, specify the PCoIP external URL as an IP address with the port number 4172. In an IPv6 environment, you can specify an IP address or a fully qualified domain name, and the port number 4172. In either case, do not include a protocol name.

For example, in an IPv4 environment: 10.20.30.40:4172

Clients must be able to use the URL to reach the security server.

5 Type the Blast Secure Gateway external URL in the Blast External URL text box.

The URL must contain the HTTPS protocol, client-resolvable host name, and port number.

For example: https://myserver.example.com:8443

By default, the URL includes the FQDN of the secure tunnel external URL and the default port number, 8443. The URL must contain the FQDN and port number that a client system can use to reach this Connection Server host.

6 Verify that all addresses in this dialog allow client systems to reach this Connection Server instance.

7 Click OK.

**Modify the External URLs for a Security Server**

You use Horizon Administrator to modify the external URLs for a security server.

You initially configure these external URLs when you install a security server in the Connection Server installation program.

The secure tunnel external URL, PCoIP external URL, and Blast external URL must be the addresses that client systems use to reach this security server.

**Prerequisites**

- Verify that the secure tunnel connections and the PCoIP Secure Gateway are enabled on the Connection Server instance that is paired with this security server. See Configure the PCoIP Secure Gateway and Secure Tunnel Connections.

- To set the Blast external URL, verify that the Blast Secure Gateway is enabled on the Connection Server instance that is paired with this security server. See Configure the Blast Secure Gateway.
Procedure

1. In Horizon Administrator, select View Configuration > Servers.
2. Select the Security Servers tab, select the security server, and click Edit.
3. Type the Secure Tunnel external URL in the External URL text box.
   The URL must contain the protocol, client-resolvable security server host name and port number.
   For example: https://myserver.example.com:443
   **Note** You can use the IP address if you have to access a security server when the host name is not resolvable. However, the host that you contact will not match the TLS certificate that is configured for the security server, resulting in blocked access or access with reduced security.
4. Type the PCoIP Secure Gateway external URL in the PCoIP External URL text box.
   In an IPv4 environment, specify the PCoIP external URL as an IP address with the port number 4172.
   In an IPv6 environment, you can specify an IP address or a domain name, and the port number 4172.
   In either case, do not include a protocol name.
   For example, in an IPv4 environment: 10.20.30.40:4172
   Clients must be able to use the URL to reach the security server.
5. Type the Blast Secure Gateway external URL in the Blast External URL text box.
   The URL must contain the HTTPS protocol, client-resolvable host name, and port number.
   For example: https://myserver.example.com:8443
   By default, the URL includes the FQDN of the secure tunnel external URL and the default port number, 8443. The URL must contain the FQDN and port number that a client system can use to reach this security server.
6. Verify that all addresses in this dialog allow client systems to reach this security server host.
7. Click OK to save your changes.

Horizon Administrator sends the updated external URLs to the security server. You do not need to restart the security server service for the changes to take effect.
Give Preference to DNS Names When Horizon Connection Server Returns Address Information

By default, when sending the addresses of desktop machines and RDS hosts to clients and gateways, Horizon Connection Server gives preference to IP addresses. You can change this default behavior with a Horizon 7 LDAP attribute that tells Horizon Connection Server to give preference to DNS names. In certain environments, having Connection Server return DNS names to clients and gateways can provide additional flexibility in designing a network infrastructure.

Note This Horizon 7 LDAP attribute replaces the per-desktop functionality that was provided by the group policy setting, Connect using DNS Name, in Horizon 6.0.x and earlier releases.

The Horizon 7 LDAP attribute affects clients that run Horizon Client 3.3 for Windows or later, HTML Access 3.5 or later, and secure gateways on Connection Server instances (not security servers).

Prerequisites

See the Microsoft TechNet Web site for information on how to use the ADSI Edit utility on your Windows Server operating system version.

Procedure

1 Start the ADSI Edit utility on your Connection Server computer.

2 In the console tree, select Connect to.

3 In the Select or type a Distinguished Name or Naming Context text box, type the distinguished name DC=vdi, DC=vmware, DC=int.

4 In the Select or type a domain or server text box, select or type localhost:389 or the fully qualified domain name (FQDN) of the Connection Server computer followed by port 389.

   For example: localhost:389 or mycomputer.mydomain.com:389

5 On the object CN=Common, OU=Global, OU=Properties, set the pae-PreferDNS attribute value to 1.

   When this attribute is set to 1, Connection Server returns a DNS name, if a DNS name is available and the recipient supports name resolution. Otherwise, Connection Server returns an IP address, if an IP address of the correct type for your environment (IPv4 or IPv6) is available.

   When this attribute is not set or is set to 0, Connection Server returns an IP address, if an IP address of the correct type is available. Otherwise, an IP address compatibility error is returned.

Allow HTML Access Through a Load Balancer

Connection Server instances and security servers that are directly behind a load balancer or load-balanced gateway must know the address by which browsers will connect to the load balancer when users use HTML Access.
For Connection Server instances and security servers that are directly behind a gateway, perform the procedure described in Allow HTML Access Through a Gateway.

You must perform this procedure for each Horizon 7 server that is behind the load balancer or load-balanced gateway.

**Procedure**

1. Create or edit the `locked.properties` file in the SSL gateway configuration folder on the Connection Server or security server host.
   
   For example: `install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties`

2. Add the `balancedHost` property and set it to the address of the load balancer.
   
   For example, if users type `https://view.example.com` in a browser to reach any of the load-balanced Horizon 7 servers, add `balancedHost=view.example.com` to the `locked.properties` file.

3. Save the `locked.properties` file.

4. Restart the Connection Server service or security server service to make your changes take effect.

### Allow HTML Access Through a Gateway

Connection Server instances and security servers that are directly behind a gateway, such as Access Point, must know the address by which browsers will connect to the gateway when users use HTML Access.

For Connection Server instances and security servers that are behind a load-balancer or load-balanced gateway, perform the procedure described in Allow HTML Access Through a Load Balancer.

You must perform this procedure for each Horizon 7 server that is behind the gateway.

**Procedure**

1. Create or edit the `locked.properties` file in the SSL gateway configuration folder on the Connection Server or security server host.

   For example: `install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties`
2 Add the portalHost property and set it to the address of the gateway.

For example, if https://view-gateway.example.com is the address that browsers use to access Horizon 7 through the gateway, add portalHost=view-gateway.example.com to the locked.properties file.

If the Connection Server instance or security server is behind multiple gateways, you can specify each gateway by adding a number to the portalHost property, for example:

```
portalHost.1=view-gateway-1.example.com
portalHost.2=view-gateway-2.example.com
```

You must also specify multiple portalHost properties if a single gateway machine is known by more than one name.

3 Save the locked.properties file.

4 Restart the Connection Server service or security server service to make your changes take effect.

**Replacing Default Ports for Horizon 7 Services**

During installation, View services are set up to listen on certain network ports by default. In certain organizations, these ports must be changed to comply with organization policies or to avoid contention. You can change the default ports that are used by Connection Server, security server, PCoIP Secure Gateway, and View Composer services.

Changing ports is an optional setup task. Use the default ports if your deployment does not require you to change them.

For a list of the default TCP and UDP ports that are used by Horizon 7 servers, see the Horizon 7 Security document.

**Replace the Default HTTP Ports or NICs for Horizon Connection Server Instances and Security Servers**

You can replace the default HTTP ports or NICs for a Connection Server instance or security server by editing the locked.properties file on the server computer. Your organization might require you to perform these tasks to comply with organization policies or to avoid contention.

The default SSL port is 443. The default non-SSL port is 80.

The port that is specified in the secure tunnel External URL does not change as a result of changes that you make to ports in this procedure. Depending on your network configuration, you might have to change the secure tunnel External URL port as well.

If the server computer has multiple NICs, the computer listens on all NICs by default. You can select one NIC to listen on the configured port by specifying the IP address that is bound to that NIC.

During installation, Horizon 7 configures the Windows firewall to open the required default ports. If you change a port number or the NIC on which it listens, you must manually reconfigure your Windows firewall to open the updated ports so that client devices can connect to the server.
If you change the SSL port number and you need HTTP redirection to continue working, you must also change the port number for HTTP redirection. See Change the Port Number for HTTP Redirection to Connection Server.

Prerequisites

Verify that the port that is specified in the External URL for this Connection Server instance or security server will continue to be valid after you change ports in this procedure.

Procedure

1. Create or edit the locked.properties file in the SSL gateway configuration folder on the Connection Server or security server computer. For example:
   
   install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties
   
   The properties in the locked.properties file are case sensitive.

2. Add the serverPort or serverPortNonSsl property, or both properties, to the locked.properties file.
   
   For example:

   ```
   serverPort=4443
   serverPortNonSsl=8080
   ```

3. (Optional) If the server computer has multiple NICs, select one NIC to listen on the configured ports.

   Add the serverHost and serverHostNonSsl properties to specify the IP address that is bound to the designated NIC.
   
   For example:

   ```
   serverHost=10.20.30.40
   serverHostNonSsl=10.20.30.40
   ```

   Typically, both the SSL and non-SSL listeners are configured to use the same NIC. However, if you use the serverProtocol=http property to off-load SSL for client connections, you can set the serverHost property to a separate NIC to provide SSL connections to systems that are used to launch Horizon Administrator.

   If you configure SSL and non-SSL connections to use the same NIC, the SSL and non-SSL ports must not be the same.

4. Restart the Connection Server service or security server service to make your changes take effect.

What to do next

If necessary, manually configure your Windows firewall to open the updated ports.
Replace the Default Ports or NICs for the PCoIP Secure Gateway on Horizon Connection Server Instances and on Security Servers

You can replace the default ports or NICs that are used by a PCoIP Secure Gateway service that runs on a Connection Server instance or security server. Your organization might require you to perform these tasks to comply with organization policies or to avoid contention.

For client-facing TCP and UDP connections, the PCoIP Secure Gateway listens on port 4172 by default. For UDP connections to remote desktops, the PCoIP Secure Gateway listens on port 55000 by default.

The port that is specified in the PCoIP External URL does not change as a result of changes that you make to ports in this procedure. Depending on your network configuration, you might have to change the PCoIP External URL port as well.

If the computer on which the PCoIP Secure Gateway is running has multiple NICs, the computer listens on all NICs by default. You can select one NIC to listen on the configured ports by specifying the IP address that is bound to that NIC.

Prerequisites

Verify that the port that is specified in the PCoIP External URL on the Connection Server instance or security server will continue to be valid after you change ports in this procedure.

Procedure

1. Start the Windows Registry Editor on the Connection Server or security server computer where the PCoIP Secure Gateway is running.
2. Navigate to the HKEY_LOCAL_MACHINE\SOFTWARE\Teradici\SecurityGateway registry key.
3. Under this registry key, add one or more of the following String (REG_SZ) values with your updated port numbers.

   For example:

   ```
   ExternalTCPPort "44172"
   ExternalUDPPort "44172"
   InternalUDPPort "55111"
   ```
(Optional) If the computer on which the PCoIP Secure Gateway is running has multiple NICs, select one NIC to listen on the configured ports.

Under the same registry key, add the following String (REG_SZ) values to specify the IP address that is bound to the designated NIC.

For example:

```
ExternalBindIP "10.20.30.40"
InternalBindIP "172.16.17.18"
```

If you configure external and internal connections to use the same NIC, the external and internal UDP ports must not be the same.

5 Restart the VMware Horizon View PCoIP Secure Gateway service to make your changes take effect.

Replace the Default Control Port for PCoIP Secure Gateway on Connection Server Instances and on Security Servers

You can replace the default port that controls the PCoIP Secure Gateway (PSG) service that runs on a Connection Server instance or security server. You might need to perform this task to avoid port contention.

The PCoIP Secure Gateway listens for control connections on the local TCP port 50060 by default.

**Procedure**

1 Create or edit the `locked.properties` file in the SSL gateway configuration folder on the Connection Server or security server computer where the PCoIP Secure Gateway is running.

   For example: `install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties`

   The properties in the `locked.properties` file are case sensitive.

2 Add the `psgControlPort` property to the `locked.properties` file.

   For example:

   ```
   psgControlPort=52060
   ```

3 Start the Windows Registry Editor on the same machine.

4 Navigate to the `HKEY_LOCAL_MACHINE\SOFTWARE\Teradici\SecurityGateway` registry key.

5 Under this registry key, add the following String (REG_SZ) value with your updated port number.

   For example:

   ```
   TCPControlPort "$2060"
   ```

**Note** The port number for TCPControlPort is the same as the port number for `psgControlPort`. 
6 Restart the Connection Server service or security server service to make your changes take effect.

**Replace the Default Port for View Composer**

The SSL certificate that is used by the View Composer service is bound to a certain port by default. You can replace the default port by using the `SviConfig ChangeCertificateBindingPort` utility.

When you specify a new port with the `SviConfig ChangeCertificateBindingPort` utility, the utility unbinds the View Composer certificate from the current port and binds it to the new port.

During installation, View Composer configures the Windows firewall to open the required default port. If you change the port, you must manually reconfigure your Windows firewall to open the updated port and ensure connectivity to the View Composer service.

**Prerequisites**

Verify that the port you specify is available.

**Procedure**

1 Stop the View Composer service.

2 Open a command prompt on the Windows Server host where View Composer is installed.

3 Navigate to the `SviConfig` executable file.

   The file is located with the View Composer application. The default path is `C:\Program Files (x86)\VMware\VMware View Composer\sviconfig.exe`.

4 Type the `SviConfig ChangeCertificateBindingPort` command.

   For example:

   ```bash
   sviconfig -operation=ChangeCertificateBindingPort
   -Port=port number
   ```

   where `-port=port number` is the new port to which View Composer binds the certificate. The `-port=port number` parameter is required.

5 Restart the View Composer service to make your changes take effect.

**What to do next**

If necessary, manually reconfigure the Windows firewall on the View Composer server to open the updated port.
Change the Port Number for HTTP Redirection to Connection Server

If you replace the default port 443 on a Horizon 7 server, and you want to allow HTTP redirection for Horizon Clients that attempt to connect to port 80, you must configure the `locked.properties` file on the Horizon 7 server.

**Note** This procedure has no effect if you off-load SSL to an intermediate device. With SSL off-loading in place, the HTTP port on the Horizon 7 server provides service to clients.

**Prerequisites**

Verify that you changed the default port number from 443. If you use the default values that are configured during installation, you do not have to perform this procedure to preserve the HTTP redirection rule.

**Procedure**

1. Create or edit the `locked.properties` file in the SSL gateway configuration folder on the Connection Server or security server computer.

   For example: `install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties`

   The properties in the `locked.properties` file are case sensitive.

2. Add the following lines to the `locked.properties` file:

   ```
   frontMappingHttpDisabled.1=5:*:moved:https::port
   frontMappingHttpDisabled.2=3:/error/*:file:docroot
   frontMappingHttpDisabled.3=1:/admin*:missing
   frontMappingHttpDisabled.4=1:/view-vlsi*:missing
   ```

   In the preceding lines, the variable `port` is the port number to which the client should connect.

   If you do not add the preceding lines, the `port` remains 443.

3. Restart the Connection Server service or security server service to make your changes take effect.

Prevent HTTP Redirection for Client Connections to Connection Server

Attempts by Horizon Clients to connect to Horizon 7 servers over HTTP are silently redirected to HTTPS. In some deployments, you might want to prevent users from entering `http://` in their Web browsers and force them to use HTTPS. To prevent HTTP redirection for Horizon Clients, you must configure the `locked.properties` file on the Horizon 7 server.

**Note** This procedure has no effect if you off-load SSL to an intermediate device. With SSL off-loading in place, the HTTP port on the Horizon 7 server provides service to clients.
Procedure

1. Create or edit the `locked.properties` file in the SSL gateway configuration folder on the Connection Server or security server computer.

   For example: `install_directory\VMware\VMware View\Server\sslgateway\conf\locked.properties`

   The properties in the `locked.properties` file are case sensitive.

2. Add the following lines to the `locked.properties` file:

   ```
   frontMappingHttpDisabled.1=5:*:missing
   frontMappingHttpDisabled.2=3:/error/*:file:docroot
   ```

3. Restart the Connection Server service or security server service to make your changes take effect.

Enable Remote Access to Horizon 7 Performance Counters on Connection Servers

Horizon 7 performance counters are available locally on a Connection Server but return 0 when accessed from another computer. To enable remote access to Horizon 7 performance counters on Connection Servers, you must configure Connection Server’s framework port in the registry.

Procedure

1. Start the Windows Registry Editor.

2. Navigate to the `HKEY_LOCAL_MACHINE\SOFTWARE\VMware, Inc.\VMware VDM\Node Manager` registry key.

3. Add a new String (REG_SZ) value, Management Port.

4. Set the Management Port value to `32111`.

Sizing Windows Server Settings to Support Your Deployment

To support a large deployment of remote desktops, you can configure the Windows Server computers on which you install Connection Server. On each computer, you can size the Windows page-file.

On Windows Server 2008 R2 and Windows Server 2012 R2 computers, the ephemeral ports, TCB hash table, and Java Virtual Machine settings are sized by default. These adjustments ensure that the computers have adequate resources to run correctly with the expected user load.

Sizing Memory for Horizon Connection Server

On a Connection Server computer, 10GB of memory is required for deployments of 50 or more remote desktops. A Windows Server computer with at least 10GB of memory is automatically configured to support approximately 2,000 concurrent tunnel sessions, the maximum number that Connection Server can support.
Configure less than 10GB of memory for small, proof-of-concept deployments only. With the required minimum of 4GB of memory, a configuration can support approximately 500 concurrent tunnel sessions, which is more than adequate to support small, proof-of-concept deployments.

However, because your deployment might grow larger as more users are added to the environment, VMware recommends that you always configure at least 10GB of memory. Make an exception only when you know that the environment will not grow, and memory is not available.

If you install Connection Server with less than 10GB of memory, Horizon 7 provides memory recommendations by generating warning messages after the installation is complete. An event triggered every 12 hours states that the Connection Server instance is configured with a small amount of physical memory.

If you increase a computer's memory to 10GB to support a larger deployment, restart Connection Server to ensure that the JVM heap size is automatically increased to the recommended value. You do not have to reinstall Connection Server.

**Important** Do not change the JVM heap size on 64-bit Windows Server computers. Changing this value might make Connection Server behavior unstable. On 64-bit computers, the Connection Server service sets the JVM heap size to accord with the physical memory.

For additional hardware and memory requirements for Connection Server, see Hardware Requirements for Horizon Connection Server.

For hardware and memory recommendations for using Connection Server in a large deployment, see "Connection Server Maximums and Virtual Machine Configuration" in Horizon 7 Architecture Planning.

**Configure the System Page-File Settings**

You can optimize the virtual memory on the Windows Server computers on which your Connection Server instances are installed by changing the system page-file settings.

When Windows Server is installed, Windows calculates an initial and maximum page-file size based on the physical memory installed on the computer. These default settings remain fixed even after you restart the computer.

If the Windows Server computer is a virtual machine, you can change the memory size through vCenter Server. However, if Windows uses the default setting, the system page-file size does not adjust to the new memory size.

**Procedure**

1. On the Windows Server computer on which Connection Server is installed, navigate to the Virtual Memory dialog box.

   By default, **Custom size** is selected. An initial and maximum page-file size appear.

2. Click **System managed size**.

Windows continually recalculates the system page-file size based on current memory use and available memory.
Configuring Event Reporting

You can create an event database to record information about Horizon 7 events. In addition, if you use a Syslog server, you can configure Connection Server to send events to a Syslog server or create a flat file of events written in Syslog format.

This chapter includes the following topics:

- Add a Database and Database User for Horizon 7 Events
- Prepare an SQL Server Database for Event Reporting
- Configure the Event Database
- Configure Event Logging for Syslog Servers

Add a Database and Database User for Horizon 7 Events

You create an event database by adding it to an existing database server. You can then use enterprise reporting software to analyze the events in the database.

Deploy the database server for the event database on a dedicated server, so that event logging activity does not affect provisioning and other activities that are critical for Horizon 7 deployments.

**Note** You do not need to create an ODBC data source for this database.

Prerequisites

- Verify that you have a supported Microsoft SQL Server or Oracle database server on a system that a Connection Server instance has access to. For a list of supported database versions, see Database Requirements for View Composer and the Events Database.
- Verify that you have the required database privileges to create a database and user on the database server.
- If you are not familiar with the procedure to create databases on Microsoft SQL Server database servers, review the steps in Add a View Composer Database to SQL Server.
- If you are not familiar with the procedure to create databases on Oracle database servers, review the steps in Add a View Composer Database to Oracle 12c or 11g.
**Procedure**

1. Add a new database to the server and give it a descriptive name such as HorizonEvents.
   
   For an Oracle 12c or 11g database, also provide an Oracle System Identifier (SID), which you will use when you configure the event database in Horizon Administrator.

2. Add a user for this database that has permission to create tables, views, and, in the case of Oracle, triggers and sequences, as well as permission to read from and write to these objects.
   
   For a Microsoft SQL Server database, do not use the Integrated Windows Authentication security model method of authentication. Be sure to use the SQL Server Authentication method of authentication.

The database is created, but the schema is not installed until you configure the database in Horizon Administrator.

**What to do next**

Follow the instructions in Configure the Event Database.

---

**Prepare an SQL Server Database for Event Reporting**

Before you can use Horizon Administrator to configure an event database on Microsoft SQL Server, you must configure the correct TCP/IP properties and verify that the server uses SQL Server Authentication.

**Prerequisites**

- Create an SQL Server database for event reporting. See Add a Database and Database User for Horizon 7 Events.

- Verify that you have the required database privileges to configure the database.

- Verify that the database server uses the SQL Server Authentication method of authentication. Do not use Windows Authentication.

**Procedure**

1. Open SQL Server Configuration Manager and expand SQL Server YYYY Network Configuration.

2. Select Protocols for server_name.

3. In the list of protocols, right-click TCP/IP and select Properties.

4. Set the Enabled property to Yes.

5. Verify that a port is assigned or, if necessary, assign one.
   
   For information on the static and dynamic ports and how to assign them, see the online help for the SQL Server Configuration manager.

6. Verify that this port is not blocked by a firewall.
What to do next

Use Horizon Administrator to connect the database to Connection Server. Follow the instructions in Configure the Event Database.

Configure the Event Database

The event database stores information about Horizon 7 events as records in a database rather than in a log file.

You configure an event database after installing a Connection Server instance. You need to configure only one host in a Connection Server group. The remaining hosts in the group are configured automatically.

**Note** The security of the database connection between the Connection Server instance and an external database is the responsibility of the administrator, although event traffic is limited to information about the health of the Horizon 7 environment. If you want to take extra precautions, you can secure this channel through IPSec or other means, or you can deploy the database locally on the Connection Server computer.

You can use Microsoft SQL Server or Oracle database reporting tools to examine events in the database tables. For more information, see the *Horizon 7 Integration* document.

You can also generate Horizon 7 events in Syslog format so that the event data can be accessible to third-party analytics software. You use the `vdmadmin` command with the `-I` option to record Horizon 7 event messages in Syslog format in event log files. See "Generating Horizon 7 Event Log Messages in Syslog Format Using the -I Option" in the *Horizon 7 Administration* document.

**Prerequisites**

You need the following information to configure an event database:

- The DNS name or IP address of the database server.
- The type of database server: Microsoft SQL Server or Oracle.
- The port number that is used to access the database server. The default is 1521 for Oracle and 1433 for SQL Server. For SQL Server, if the database server is a named instance or if you use SQL Server Express, you might need to determine the port number. See the Microsoft KB article about connecting to a named instance of SQL Server, at [http://support.microsoft.com/kb/265808](http://support.microsoft.com/kb/265808).
- The name of the event database that you created on the database server. See Add a Database and Database User for Horizon 7 Events.
  
  For an Oracle 12c or 11g database, you must use the Oracle System Identifier (SID) as the database name when you configure the event database in Horizon Administrator.
- The username and password of the user you created for this database. See Add a Database and Database User for Horizon 7 Events.

Use SQL Server Authentication for this user. Do not use the Integrated Windows Authentication security model method of authentication.
A prefix for the tables in the event database, for example, VE_. The prefix enables the database to be shared among Horizon 7 installations.

**Note** You must enter characters that are valid for the database software you are using. The syntax of the prefix is not checked when you complete the dialog box. If you enter characters that are not valid for the database software you are using, an error occurs when Connection Server attempts to connect to the database server. The log file indicates all errors, including this error and any others returned from the database server if the database name is invalid.

**Procedure**

1. In Horizon Administrator, select **View Configuration > Event Configuration**.

2. In the **Event Database** section, click **Edit**, enter the information in the fields provided, and click **OK**.

3. (Optional) In the Event Settings window, click **Edit**, change the length of time to show events and the number of days to classify events as new, and click **OK**.

   These settings pertain to the length of time the events are listed in the Horizon Administrator interface. After this time, the events are only available in the historical database tables.

   The Database Configuration window displays the current configuration of the event database.

4. Select **Monitoring > Events** to verify that the connection to the event database is successful.

   If the connection is unsuccessful, an error message appears. If you are using SQL Express or if you are using a named instance of SQL Server, you might need to determine the correct port number, as mentioned in the prerequisites.

In the Horizon Administrator Dashboard, the System Component Status displays the event database server under the Reporting Database heading.

**Configure Event Logging for Syslog Servers**

You can generate Horizon 7 events in **Syslog** format so that the event data can be accessible to analytics software.

You need to configure only one host in a Connection Server group. The remaining hosts in the group are configured automatically.

If you enable file-based logging of events, events are accumulated in a local log file. If you specify a file share, these log files are moved to that share.

- Use a local file only for quick troubleshooting during configuration, perhaps before the Events database is configured, so that you have some way to see events.

  The maximum size of the local directory for event logs, including closed log files, before the oldest files are deleted, is 300MB. The default destination of the Syslog output is `%PROGRAMDATA%\VMware\VDM\events\`.

- Use a UNC path to save log files for a long-term record of events, or if you do not have a Syslog server, or if your current Syslog server does not meet your needs.
You can alternatively use a `vdmadmin` command to configure file-based logging of events in Syslog format. See the topic about generating Horizon 7 event log messages in Syslog format using the `-I` option of the `vdmadmin` command, in the *Horizon 7 Administration* document.

**Important** Syslog data is sent across the network without software-based encryption, and might contain sensitive data, such as user names. VMware recommends using link-layer security, such as IPSEC, to avoid the possibility of this data being monitored on the network.

**Prerequisites**

You need the following information to configure Connection Server so that events can be recorded in Syslog format or sent to a Syslog server, or both:

- If you plan to use a Syslog server to listen for the Horizon 7 events on a UDP port, you must have the DNS name or IP address of the Syslog server and the UDP port number. The default UDP port number is 514.
- If you plan to collect logs in a flat-file format, you must have the UNC path to the file share and folder in which to store the log files, and you must have the user name, domain name, and password of an account that has permission to write to the file share.

**Procedure**

1. In Horizon Administrator, select **View Configuration > Event Configuration**.
2. (Optional) In the **Syslog** area, to configure Connection Server to send events to a Syslog server, click **Add next to Send to syslog servers**, and supply the server name or IP address and the UDP port number.
3. (Optional) To enable Horizon 7 event log messages to be generated and stored in Syslog format, in log files, select the **Log to file: Enable** check box.
   The log files are retained locally unless you specify a UNC path to a file share.
4. (Optional) To store the Horizon 7 event log messages on a file share, click **Add next to Copy to location**, and supply the UNC path to the file share and folder in which to store the log files, along with the user name, domain name, and password of an account that has permission to write to the file share.

An example of a UNC path is:

```
\syslog-server\folder\file
```